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1. Overview 

CrystalClear is a program for collecting and processing crystallographic data for Rigaku single crystal 
detectors and goniometers. CrystalClear has been used for over a decade by more than 500 
crystallographers worldwide to successfully collect and process data. Version 2.0 of CrystalClear adds 
new features and fixes earlier problems. 

 

Supported Hardware  

Supported Detectors for Data Collection 
Support is provided for all current and many former single crystal instruments produced by Rigaku. These 
include: 

• R-AXIS IV, IV++,  and HTC (R-AXIS VII) 

• RAPID, RAPID II (SPIDER) 

• Mercury, Saturn, Jupiter, and A200 CCDs 

• SCXmini and XtalLABmini 

CrystalClear supports any of the Rigaku goniometers for these detectors. It also supports any of the 
Rigaku X-ray generators that are provided with these detectors. The huge number of permutations of 
detector, goniometers, and X-ray generators supported by CrystalClear is made possible by a flexible 
Instrument Server and Frame Grabber architecture and a set of carefully designed configuration files. 

Image Format Support 
In addition to Rigaku detectors, CrystalClear processes data from a large number of 3rd party vendors. 
These include 

• Bruker 

• MAR CCD 

• MAR IP 

• ADSC CCD 

• MACScience 

• Brandeis CCD 

• Pilatus 

This allows you to use CrystalClear not only for your home lab data collection and processing, but also 
for processing data from most beam lines. 

Computer Requirements 
CrystalClear is installed on a Control computer which interfaces either with the instrument directly, or 
through a Frame Grabber computer. The Control and Frame Grabber computers must both use 
Windows® XP. These computers are normally supplied by Rigaku with the instrument. Using this 
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computer for other purposes, especially those involving heavy computations or high network traffic is not 
recommended since timing for instrument control can be critical. 

CrystalClear can also be installed on additional computers that are not connected to any instruments for 
the purpose of processing data that has already been collected. These must also be Windows computers, 
but both XP and Vista can be used for a processing computer. 

CrystalClear comes with a dongle that is used for installing licenses. The number of licenses for your site 
is determined by your purchase agreement. You have a dongle for each license of CrystalClear. 

Using this Manual 
This manual can be used as an introduction and as a reference. It is mostly task oriented rather than tool 
oriented. It presents the various features and tools in the program in the context of their normal use and in 
the order that they are most often used. Once you learn to use these tools in this recommended way you 
will soon understand them well enough to be able to adapt them to your own style of work. 

Earlier versions of CrystalClear had extensive online and interactive help. But this feature was actually 
used very little in practice and was very time consuming to maintain, so it has been removed. It has 
proven more effective to spend time designing user interfaces that are easier to use than to maintain 
online help. The documentation for CrystalClear has been re-organized to focus on a coherent single user 
manual rather than fragments of online help. If you click the ? icon in the main toolbar or on Help Topics 
under Help, this manual opens as a pdf file using Acrobat Reader. You can use the Acrobat indexing to 
navigate to the relevant section. 

Chapter Outline 
1. Overview.  

2. Installation and Administration. This is primarily for the user who is responsible for installing 
and updating CrystalClear for your site. It covers the procedures for installation and for 
configuring various files to reflect the actual instrument setup. Version 2.0 has a different 
directory structure, so updating to 2.0 is a bit more complex than previous updates. Even if you 
have upgraded CrystalClear earlier (e.g., from 1.3.6 to 1.4.0) it is worth referring to this Chapter 
as you update to 2.0. This chapter also covers administration functions such as setting up new 
users.  

3. Getting Started. As in any complex computer program, it is important to understand a few 
fundamental concepts in order to effectively use CrystalClear. If you don’t read anything else in 
this manual, you should read Chapter 3. 

4. The Toolbar and Views. The main window tool bar provides access to the most common 
functions. CrystalClear provides a set of viewers to allow you to examine the data images, the 
state of the hardware, the cell and other processing information, etc. These views usually pop up 
when they are relevant to the task at hand, but they can also be selected via the Windows menu. 
Since they are used in many different tasks, we will illustrate their use first so that we can 
concentrate on the flow of the task itself. 

5. Small Molecule Tasks. For small molecule work you have the option of running in Auto mode 
where the entire process of collecting and processing data is highly automated or in Expert mode 
where you have detail level control as you work through the process manually. In addition, in 
Expert mode, you have the choice between d*TREK, FS_PROCESS, and TwinSolve. You may 
safely skip this chapter if you are a macromolecular user. 

6. Macromolecular Tasks. For protein and other macromolecules, you can either process the data 
with d*TREK or FS_PROCESS. The flow bars and approaches associated with each of these 
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tasks are described here. The individual steps are described in chapters 8 through 11. You may 
skip this chapter if you just work on small molecules. 

7. Collection Steps. This chapter concentrates on the process of collecting data. The collection steps 
are the same regardless of the processing suite and very similar for small molecule and 
macromolecule work. Strategy, which might be considered a collection step, is described in the 
next chapter since it is only provided if d*TREK is the processing suite and it is intimately tied in 
with indexing and other processing steps. 

8. Processing Steps with d*TREK. You can either process data as it is collected or wait and 
process it later. This chapter covers both approaches and explain the steps provided by 
CrystalClear when you have selected the d*TREK processing suite to integrate, scale, and 
analyze your data. 

9. Processing Steps with Fine Slice Process. The chapter describes the processing steps provided 
by FS_PROCESS. They are similar to those provided by d*TREK, but there are differences both 
in the flow and the parameters. 

10. Processing Steps with TwinSolve. The chapter describes the processing steps provided by 
TwinSolve. TwinSolve requires a separate license and is only applicable in Small Molecule 
Expert mode. 

11. Reciprocal Lattice Viewer. This chapter describes the Reciprocal Lattice viewer which can be 
used to examine reflections in reciprocal space and provides tools for manual indexing. 

12. Tools. This chapter covers menu accessible tools that are provided by CrystalClear for 
specialized functions. If you can’t find what you need in the previous chapters, you will probably 
find it here. 

13. FAQs. This chapter has a list of Frequently Asked Questions. 
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2. Installation and Administration 

 

Most of the information in this chapter is intended for the CrystalClear administrator. If you are the 
administrator or a joint administrator and are doing software updates, adding users, etc., then you should 
read the whole chapter. 

CrystalClear has its own definition of users and their privileges which is independent of Windows. 
Everyone in your lab can use the same Windows account to log on the Control computer and you can still 
set up separate CrystalClear users. Conversely, you could all have separate Windows accounts but run as 
the same CrystalClear user. Generally, since the login screen defaults to the Windows user name, it is 
most convenient if you set up CrystalClear users to match the Windows users. 

Similarly, a user who has administrative privileges in Windows need not have administrative privileges in 
CrystalClear and vice versa. The directory structure for CrystalClear has been modified significantly 
starting in version 2.0 to allow users to run without Windows administrative privileges. In newer versions 
of Windows this means moving any file that can be created or updated while running CrystalClear (e.g., 
log files, configuration files, etc) out of C:\Program Files. This is described in more detail in the section 
on File Structures. 

Installation 

Downloading the Installer 
You will have been given a link with a user name and password for the CrystalClear installer. Once you 
log into this web site, find the link to download the installer. Simply click this link and the installation 
downloads to your computer. This is a large file (more than 80 MB) so this may take a while. 

If the computer on which you are going to install or update CrystalClear is not on the net, then you can 
download the CrystalClear installer onto another PC that is on the net and then copy the installation file to 
a USB memory stick or some other medium and carry it by hand to your target computer. 

Running the Installer 
For CrystalClear 2.0, the released version of the CrystalClear installation file is called 
CrystalClear2.0.0r1. If the file name is something like CrystalClear2.0.0b7, then it is a beta version and if 
it is something like CrystalClear2.0.0rc4 it is a release candidate.  

You must have Windows administrative privileges to run the installer. 

To run the installer, simply double click this installation file. Depending on your protection schemes, 
Windows or your anti-virus software may want you to confirm that you really do want to install this 
software. 

New Installations or Major Version Upgrades 

First Installation 
Major new versions (e.g., CrystalClear 2.0) are treated as different programs in the installation process. 
So installing a major version is similar to a new installation even if an older version of CrystalClear has 
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been installed. However even for major version updates the installer looks for previous versions of 
CrystalClear and uses as much information (users, configuration, etc) as it can find. 

If this is the first time that any CrystalClear or a major new version has been installed on this computer, 
the installer starts walking you through a wizard to complete the installation. In general it is best to accept 
the defaults for the installation directory and other defaults, so you can just click through Next and then 
Finish in the final screen. 

You have to enter you identification and dongle ID even if this is a major version update. 

 
If you see a serial number (i.e. Dongle ID) that does not match the one on your dongle itself, you may 
need to run the old version of CrystalClear and go to Edit|Set Dongle ID. This brings up a dialog with the 
current dongle ID. Make a note of this and then click Cancel. 

There are some post installation processes that run after the Finish screen. For example: 

 
Click Yes if you have an R-AXIS with a SCSI interface, otherwise click No. There can be other processes 
that run at this time to install system dlls, etc. 

It is important that you wait for the post installation processes to complete and that you do not do 
anything else on your computer until they do. It could take several minutes. Also, the USB dongle driver 
installation occasionally hangs. When this happens stop CBSetup.exe with the task manager and the 
installation usually completes successfully after that. 
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Dongle Installation 
CrystalClear requires a dongle. If you are doing a new installation, this is a USB dongle. For an old 
system you might have a parallel port dongle. If you are replacing your computer and have a parallel port 
dongle on the old computer, contact Rigaku about replacing it. The driver for the USB dongle is installed 
during the CrystalClear installation process. If there are problems and you need to re-install, this file is in 
C:\Rigaku\CrystalClear20\CBSetup.exe. 

Under normal circumstances you just have to plug your dongle into an available USB 2 port. 

Special Issues for CrystalClear 2.0 Updates 
Between CrystalClear 1.4.0 and 2.0 there were major changes in the directory structure (see Directory 
Structure section) that were necessitated by the evolving security requirements in Windows XP and 
Windows Vista. This meant that everything had to be moved out of C:\Program Files. Rigaku has made 
every effort to automate this process back to CrystalClear 1.3.5. If you are updating an older version of 
CrystalClear or discover that your configuration is not updated automatically as it should be, please 
contact your Rigaku support person. 

There is an additional complication if any of your users have their User Data Directory (the root 
directory for all their projects and samples) in Program Files. This was a default for the Administrator 
account in earlier CrystalClear versions. These should eventually be moved out of program files if you are 
ever going to update your operating system or want to run as other than a Windows administrator. You 
cannot just move these files with Windows Explorer since they contain full file paths that need to be 
updated when the data is moved. If CrystalClear detects that you have users in Program Files, it brings up 
a message: 

 
If you click Yes all user data directories in Program Files are moved to C:\Rigaku\CrystalClear. If you 
do not want to move the data at this time, you should click No. You can always go back to 
File>Utilities>Move User Data Directories to move them. However, at that stage you are already 
logged in as a user which opens some of the files that need to be moved. Windows does not allow you to 
move open files, so you have to log in as a different user to move your user data directory. You may have 
to create a temporary user with administrator privileges to make the move at a later time (or get your 
CrystalClear administrator to do it). 

First Run After a New Installation 
When you click CrystalClear you see a splash screen which asks you for a user name and password. After 
installation of the first version of CrystalClear there is an Administrator user with no password. You 
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have to log on under Administrator the first time. Once you get in, you can setup new users and modify 
user accounts as explained in the User Administration section. If this is a major version upgrade, all 
your old users are still there. 

If this is the first installation or a major version upgrade of CrystalClear you are also asked questions 
about the instrument you are using and whether you are running mostly small molecule or macromolecule 
samples. Only those files that are needed for your site are loaded into the installation directory. If this is 
an upgrade, the installer makes every effort to find your configuration files from a previous version. 

Reverting to an Old Version 
Once the defaults are updated, you are ready to run under the new version. However, if you need to revert 
to an old version, it still works. Note however, that if you have moved the User Data Directory you are 
not able to run the older version of CrystalClear. This is one reason that you may not want delay moving 
the User Data Directory until you are sure you no longer need to run the old version. 

Updating CrystalClear to a New Minor Version 

Installing Updates 
Installing a minor version update is generally very simple, but still requires Windows administrative 
privilege. The recommended first step is to copy the following directories into some other location as a 
backup in case you have to recover.  

• C:\Rigaku\CrystalClear 

• C:\Rigaku\CrystalClear20 (or whatever the current version is) 

• C:\Rigaku\Config 

In general you should not uninstall CrystalClear nor delete any of the files in C:\Rigaku. If you do this 
you could lose a lot of information about your configuration, users, projects, samples etc. However, if you 
must do this, refer to the following section on uninstalling and reinstalling CrystalClear. 

When you double click the CrystalClear installer, you are presented with the following screen: 
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Make sure Repair has been selected and then click Next on the wizard screens. Even though this is an 
update, the CrystalClear installer still runs several processes after the final Finish. So it is important that 
you wait for these to complete and do nothing else on your computer until they have. 

When you update CrystalClear your user information, projects, samples, and settings are not overwritten. 

First Run after a Version Update 
CrystalClear defaults usually change between versions. Even though none of the existing parameter 
defaults may have changed, there are often new parameters that require a default. When CrystalClear runs 
the first time after an update, it usually asks you if you want to update the defaults and bring up the 
Default Manager described in Chapter 3. Unless you have modified the defaults extensively, it is a good 
idea to accept these new defaults and apply them to your site, users, and projects. It is not usually 
necessary or wise to apply the defaults to individual samples. 

If you are an administrative user, you are allowed to apply these defaults to other users, but they have the 
chance to review this decision for themselves when they first log on after an update. 

Uninstalling CrystalClear 
Uninstalling and then re-installing CrystalClear is not generally recommended. It is much better just to 
use the Repair option. If you must uninstall CrystalClear, you can either double click the Installer and 
then select Remove or use Add/Delete Programs in the Windows Control Panel. If you want to save 
configuration setup and user information, you need to make copies of some of the directories in 
C:\Rigaku in order to restore your settings and users. You should copy: 

• C:\Rigaku\Config 

• C:\Rigaku\CrystalClear\Administration 

Once you have re-installed CrystalClear, you can copy the saved versions of these directories into 
C:\Rigaku to restore your configuration settings and restore your users.  
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User Administration 
CrystalClear provides support for separate user accounts each with their own data directory, defaults, 
preferences, projects, and samples. A user without administrative privileges can only modify their own 
account settings. Administrative users can add new users and modify all user accounts. 

Creating and Editing User Accounts 
To setup or modify a user account select Tools>Administration and click the Users tab. The other tabs 
in the Administration dialog are rarely used and should only be changed as instructed by Rigaku support 
personnel. 

Administration Users Tab 

 
 

Parameter Description 
Users A list of the current users is selected. Click the user if you wish to edit or 

remove them. If you are not an Administrative user, you can edit only your own 
account and you cannot add new accounts. 

Add This brings up the dialog User Settings shown below and then adds the new 
user. 

Edit This also brings up the User Settings dialog but only the user name is read and 
the existing user account is updated. 

Remove Deletes the selected user. You are asked to confirm the deletion of this user. 
You are also informed that the files associated with this user have not been 
deleted and given the path for doing it yourself. This is to prevent accidental 
deletion of important data. Note that if your image files are not in a subdirectory 
of the Sample, they are not deleted. 
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Parameter Description 
OK, Cancel Both of these simply close the dialog. Cancel does not restore the previous state 

(i.e., it is not an “undo”). 

User Settings Dialog 
This dialog comes up when you click Add or Edit in the Users tab. 

 
 

Parameter Description 
Name The user name. It cannot contain spaces. Names are not case sensitive. 
Description This is redisplayed when this user account is edited. It is for record keeping 

purposes only and not otherwise used. 
Data The User Data Directory is the root directory for all of this user’s information. 

If the user information is to be shared (e.g., to be able to run CrystalClear on 
another computer to process data etc) it is best to put this on a shared drive or 
shared directory. 

Password Passwords are case sensitive. Unless you have an environment where you are 
worried about security it is usually not necessary to supply a password. 

Default At this time there is only an English version of CrystalClear at this time, so 
leave this as English. 

Member of (Groups) Check Administrators if this user is to have administrative privileges. For non-
administrative users check Users and uncheck Administrators. There is a way 
to create new groups with the Groups tab, but it has not been fully developed 
and should not be used. 

After setting up a new user account, click OK, log out of CrystalClear and finally log back in as 
the new users. 

First Run as a New User 
The first time you run as a new user you are asked if you are connected to a real instrument or wish to run 
in simulation mode. If this is the control computer connected to the instrument, you should check Real. If 
you are running CrystalClear on another computer that is not connected to an instrument but will be used 
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for processing data, then you should click Simulator. These settings can be changed later in the Server 
tab to the Preference dialog (see Chapter 12 Preferences). 

Moving User Data Directories 
All user information, projects, and samples are stored in the User Data Directory and its subdirectories. 
Since some of these files contain absolute references to other files, you can’t just copy them to another 
directory without breaking these links and causing CrystalClear to crash. But starting with CrystalClear 
2.0, you can select File>Utilities>Move User Data Directory to move the whole user data directory and 
automatically repair all links. If you are moving the directory to a different disk, then Windows interprets 
a move as a copy and you  get a copy, but if it is on the same disk then the operation is a move rather than 
a copy and you do not get copies when you are done. This is an important consideration if you have a lot 
of data. 

In early versions of CrystalClear the Administrator User Data Directory defaulted to a subdirectory of 
C:\Program Files. Newer versions of Windows XP and all versions of Vista do not like data to be stored 
in Program Files which is normally write protected for non-administrative users and even for some 
administrative access. So it is strongly suggested that you move any user data directories you have in 
program files to somewhere else when you install a new version of CrystalClear. If you have 
administrative privileges (in CrystalClear not Windows) you can also move other users. 

Once you log into CrystalClear as a user, some of the files in the User Data Directory are opened for 
updating as you do your work. This prevents them from being moved. So you either need to log in as 
another user with administrative privileges or get your CrystalClear system administrator to do this for 
you. If you want to move the Administrator user and you do not have another use with administrative 
privileges you need to create a new account with administrative privileges and then log into that account 
to move the Administrator account. 

Move User Data Directories Dialog 

 
 

Parameter Description 
User Table This is a table with a list of all the current Users (if you have CrystalClear 

administrator privileges). It shows the Current User Data Directory for each 
user and provides a column to enter a New User Data Directory. All User Data 
Directories are full, absolute paths. You can select the user you want to move 
and then either enter the new directory path or click Browse… 

Browse… This brings up a directory browser. If you check Automatically append user 
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Parameter Description 
name to user data directory path when selecting a directory with Browse, 
the current user name is added to the directory you select. This is useful if you 
want to put all users under a common directory. 

Move Once you have filled out the table, click Move. Any user that does not have a 
new directory path in the New User Data Directory is not changed. Since quite 
a few files have to be updated if you have a lot of projects and samples, this 
process may take some time. 

Directory Structure 
Starting with CrystalClear 2.0, there is a new directory structure. 

C:\Rigaku – All Rigaku software will eventually be in this directory. 

ASPI – Only used for SCSI R-AXIS systems 

Config – Contains configuration file for all Rigaku applications. Some of the config files have 
been renamed (see Configuration Files below). This only contains configuration files for your 
instrument type. 

CrystalClear – Contains shared information that all versions of CrystalClear need. 

Administration – Contains the administration database with the user information. 

Administrator – The Administrator user data directory is typically kept here. If you are 
going to use it to actually collect data other than just for testing, it may be good to move 
it outside C:\Rigaku with the Move Directories command. 

Data – Site defaults 

SiteDefaults – Current site defaults. 

CrystalClear20 – This is the installation directory and contains the programs executables, dlls, 
and other files needed to run CrystalClear. A different version of CrystalClear (e.g., 2.1) has a 
different installation directory (e.g., CrystalClear21). 

Factory – All the factory configuration and default files are kept here. You should not 
generally modify anything in this directory. 

Mask Files –Current mask files 

Process/Database –This has various data files used by FS_PROCESS. 

TwinSolve – The error text files and other files needed by TwinSolve are installed here. 

Doc – This manual and various other documents are kept in this directory. This includes html 
files which document the various configuration files. 

Log – The CrystalClear and instrument server logs are stored here. However, the html versions 
are now in Web. Some log files are still kept in the sample or image directory for each sample. 

RAXWish – These directories contain the code and support files for RAXVideo and RAXShape. 

Scripts – Not currently used. 

Web – The html version of log files are kept here unless you have set another path in your 
preferences. 
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Configuration Files 
In CrystalClear 2.0 and above, the configuration files are in the C:\Rigaku\Config directory. For most of 
these files, there is a corresponding html file in the C:\Rigaku\Doc directory that gives you the details you 
need for maintaining these files. These configuration files are critical to the operation of your system, so 
you should only change them if you know exactly what you are doing or have been instructed to make the 
change by your Rigaku support person. 

Only some files should be edited with a text editor such as Notepad or Wordpad. Others are maintained 
through the user interface. Write the files as simple text files with no formatting information and 
remember to save before you run CrystalClear again. You need to restart CrystalClear for the change to 
become effective. 

The list of files below is an example with AFC-11 with a Saturn 724 CCD so that we can use actual file 
names. If you have a different instrument the names change to reflect that instrument. 

system.configuration. This file contains the IP address and the port for the Frame Grabber PC for CCD 
systems. 

CrystalClear.configuration. This has information about the mode (macro, small molecule expert, small 
molecule auto) and configuration information about JXG for managing the X-ray generator and RMailer 
for sending out emails when there is a failure or a data collection finishes. 

CrystalClear_Instrument.configuration. To update this file, log in as an administrative user and go to 
the Setup dialog and select the X-Ray Source Tab. The Save to Config updates this file with information 
about the X-Ray source. (In certain circumstances for small molecule Auto mode there may also be a 
sm_xxx_instrument.configuration that is used instead of this file.)  This file should not be edited 
manually. 

MSCServDetCCD.configuration. This has information that the instrument server needs about the 
goniometer type, overload handling, trigger delays, wavelengths etc. There are RAXIS, RAPID, and 
RAXISHTC versions of this file if you have an image plate instrument. 

AFC11_RCD3.configuration. This has the port for connecting to the goniometer controller (RCD3) and 
datuming and limit information. 

AFC11Saturn24.xml. This has a link to the collision files that are usually kept in the Factory directory. 
You should not normally modify this file nor the collision files themselves. 

RAXVideo.configuration. If you have a video camera and capture card and use RAXVideo, this file 
stores the RAXVideo version. The version can be set in CrystalClear by going to the 
Instrument>RAXVideo Version menu. 

Director.configuration. This is only used if you have an ACTOR system and are using Director. 

Instrument Setup and Maintenance 
To modify the instrument type (rare) or take direct beam shots  use the following function from the main 
menu. 

Instrument>Administrator Utilities 
The administrator utilizes are for setting up the instrument type and performing certain maintenance 
functions. They require administrator privileges. 
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Administrator Utilities View 
 

 
 

Parameter Description 
Image collection device 
type 

This is normally setup for you by your Rigaku installation engineer and you 
seldom need to change it. But if you do, there is a drop down list of all the many 
available instrument types that CrystalClear recognizes. Note that you do not 
need to change your instrument type in order to process images from a different 
instrument (even a non-Rigaku instrument) since the information for processing 
is derived from the image itself. If you do change the instrument type you need 
to restart CrystalClear. 

Director beam shots This is the area of the view that you use to take direct beam shots. You should 
be trained by Rigaku service personnel or a Rigaku application scientist in how 
to take these images. The parameters for this are: 

• Number of shots. How many direct beam images to collect. 
• Exposure time. The exposure time for each direct beam shot in 

seconds. 
• Initialize before direct beam shots. This check box forces an 

initialization of the instrument when you click Take! and before the 
direct beam images are collected. 

• Set Refined Values…  This is a new feature in CrystalClear 2.0 and 
above that allows you to update the Distance, 2 Theta and direct beam 
with refined values (e.g., from indexing and refining a known crystal). 
This can be especially useful for the SCXmini and XtalLABmini to 
update these refined values. There is a dialog that pops up which allows 
you to do this that is described below. 

• Take!  This activates the collection of the direct beam. 
Attenuation Factor This activates the collection of the images used to calculate an attenuation 

factor for a given attenuator. 
• Number of shots. How many attenuation images to collect. 
• Exposure time. The exposure time for each attenuation image. 
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Parameter Description 
• Initialize before atten factor shots. Checking this causes the 

instrument to be initialized when you click Take! 
• Take!  Starts the collection of attenuation factor images. 

Continuous IP read This is a maintenance function for R-AXIS image plate detectors. It is disabled 
for CCDs. 

• Number of cycles. How many times to repeat the read 
• Initialize R-AXIS. Check to initialize before the reads start. 
• Write images to the same file. If this is checked all the images go into 

a single file. 
• Open X-ray shutter during read. 
• Take!  Starts the continuous read. 

PMT Check The R-AXIS has two photo multipliers and they have to be very carefully 
aligned. This section is used to run a diagnostic on the PMTs. 

• Initialize R-AXIS. Check to initialize before the PMT test starts 
• Take! Run the PMT test. 

Light Leak Check This is another R-AXIS diagnostic check. 
• Take. Run the check. 

Set Refined Values Dialog 

 
 

Parameter Description 
Refined Scan 
Parameters 

Before you click Set Refined Values in the Administrator Utilities View you 
should have collected data and processed data on a high quality crystal with 
well known cell parameters with the options checked to refine the Distance, 2 
theta, and Direct Beam position. If you have done that, these values are 
automatically entered into the Distance Offset and 2-Theta Offset fields. You 
can then click Set Refined Values to set the distance and 2 theta offsets. 

Direct Beam 
Parameters 

Similarly after you have run the refinement, the direct beam parameters in this 
table are updated. You should review these to make sure they are reasonable 
and then click Set Direct Beam. 
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3. Getting Started 

This chapter tells you how to start up CrystalClear and explains the central concepts that are necessary to 
understand in order to use CrystalClear effectively. If you are new to CrystalClear, this is the most 
important chapter in the manual for you to read. 

Starting CrystalClear 

Icons 
When CrystalClear is installed it puts an icon on the desktop. To start CrystalClear simply double click 
this icon. 

 

Login Screen 
When CrystalClear starts up it presents a login screen as follows 

 
The Login Name defaults to the current Windows user. If this is the first time you have run CrystalClear 
after a new installation, the only user is Administrator and there is no password. If your Login Name has 
not yet been setup, then you should login as Administrator. Login Names are not case sensitive, but 
passwords are. 

Once you click OK, CrystalClear should start up. See the instructions in Chapter 2 if you need to add a 
new user or edit your user setup. 



2. Getting Started 
 

 

3-2 CrystalClear User Manual 

Users, Projects, and Samples 
CrystalClear organizes the data collection and processing into a hierarchy. Each user has a collection of 
projects and each project has a collection of samples. Understanding this user/project/sample hierarchy 
and how it affects defaults is vital to using CrystalClear effectively. If you understand and use projects 
and samples they can provide a flexible and useful way of organizing your data. 

Users 
When you log into CrystalClear you specify a user name. The procedure for creating users and editing 
user information is described in Chapter 2. Each user has a User Data Directory. This is the root directory 
for all of the data that CrystalClear maintains for this user. The exception to this rule is that images can 
optionally be stored in an image directory that can be anywhere on disk. The User Data Directory 
contains: 

• User preferences (.ho and .xml). These are preference for display options and other program 
features that are stored for each user. The8 can be set in the Preferences Dialog described in the 
chapter 12 on Tools. 

• User defaults (.ho and .xml). These are the default parameters for the various dialogs that 
correspond to steps in CrystalClear (e.g., Index, or Collect). When the user is created, the site 
defaults are copied into the User Data Directory and become the user defaults. These defaults can 
then be updated by the user by using the Save button provided on most dialogs. Note that since 
you copy rather than refer to the site level defaults, changing the site level defaults does not 
update the user defaults. However, a default update mechanism described later in this chapter 
allows you to update selected levels of your defaults at the same time. 

• Project List (.ho and .xml). These are the projects that have been created for this user. 

• Project Directories. 

For the examples in this section we assume that the User Data Directory is C:\UserData\Russ, but of 
course in practice it can be any accessible directory. 

Projects  
A project is a collection of samples that are related in some way. Each project has a name. The name must 
be unique for the current user. A directory is created under the User Data Directory that corresponds to 
this project. For example if the project name is HSP90, then the directory in our example is 
C:\UserData\Russ\HSP90. This directory file contains the sample directories and a set of default and other 
files with .ho or .xml extensions. 

Project Directories contain: 

• Project defaults (.ho and .xml). These are the default dialog parameters for this project. When the 
project is created, the user defaults are copied into this directory as the project defaults. Since 
they are inherited at this point, changing the user defaults does not change the project defaults. 

• Sample List (.ho and .xml). The samples in this project 

Samples 
A sample generally corresponds to a physical sample crystal. A sample also has a name and a directory is 
created to store the log files, reflection files, and other data relevant to the sample. For example if the 
sample name were Soak0246, then the directory in our example would be: 

 C:\UserData\Russ\HSP90\Soak0246.  
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The sample directory by default includes an Images subdirectory where the images are stored, but it is 
possible to specify that the images are stored in a separate directory anywhere accessible to the control 
computer. For Process only samples you set the image directory to refer to the already collected image 
files. 

Sample directories contain: 

• Sample files (<sample>_20.ho and .xml). This is sometimes referred to as the sample database. 
This file contains the current status, dialog parameter defaults, and a history of the sample. Older 
versions of this file are also retained. If you install a new version of CrystalClear and reprocess 
the data you get new versions of the <sample>_xx.ho file and the old files are maintained. This 
allows you to revert to an older version of CrystalClear and still access this sample. 

• Log files for d*TREK , FS_PROCESS, or TwinSolve. These are the logs that are created by 
indexing, refinement, and other processing steps. 

• Header (.head and .dat) files. These are used by d*TREK  or FS_PROCESS to pass sample 
information from one step to the next (e.g., from index to refine). 

• Reflection and CIF files. These are the output files that are used for structure determination and 
refinement. 

The images directory may or may not be included in the sample directory. In either case the image 
directory contains: 

• Image (.img or .osc) files. These are your data images. 

• Collision.xml File. The collision file used to prevent goniometers collisions while collecting data. 

• Instrument Server log file. This can be useful in diagnosing any problems and your Rigaku 
support person may ask for this file. 

Each time you mount a new crystal, you should create a new sample to hold the data associated with that 
crystal. The normal and default practice is to store the images you collect in the Images subdirectory of 
this sample.  

If you need to screen a lot of samples to find one that you can collect, you can also open up a sample and 
then just add a screen scan for each new crystal changing the image name template each time. Then when 
you find a good crystal you can go on with the sample. 

You can reopen a sample at a later time after the data has been collected and reprocess some or all of the 
data. The complete state and history information of the sample is maintained in the various files, so that 
nothing is lost by stopping CrystalClear and restarting at some later time. 

Process Only Samples 
It is sometimes useful to process the data in a sample without reopening the original sample. For example, 
if you have processed a data set with d*TREK and suspect that it is twinned, you should normally open 
up a process only sample for the TwinSolve processing. Or you may want to process the data on a 
different computer which has its own installation of CrystalClear and its own directory structure for each 
user. When you open a process only sample, you are asked to browse to where the data images are kept. 
This can be on an external drive, but you need to make sure the drive stays accessible during the time you 
have the sample open. 

Sample names must be unique to the project, so if you open a process only sample in the same project as 
the original sample, give it a different name. 
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The Flow Bar 
Each sample has an associated task. In order to explain what these tasks mean, you must first understand 
how the flow bar works. 

There are various ways to navigate to a particular step and it associated dialog in CrystalClear. Almost all 
steps are accessible through the menus. Some of these steps are only accessible through the menus. Other 
features are accessible through the toolbar at top of the user interface. But the most common steps are 
arranged in a flow bar along the left side of the user interface. The goal of the flow bar is not only to 
provide a convenient way to navigate to a particular step, but to guide you through the steps for a 
particular task. 

Using the Flow Bar 
Most flow bar steps bring up a dialog when you click them. You then fill in the parameters for that dialog 
and click OK. Once that step is done the next step in the flow bar is activated automatically. If you want 
to skip that step, you simply click another step in the flow bar. A unique feature of CrystalClear is that 
most dialogs associated with flow bar steps are not modal. This means the rest of the user interface is still 
active while the dialog is up. There is also an implicit cancel features which means you do not need to 
close a dialog before you click another flow bar button. If there is a dialog active when the flow bar 
button is pushed it closes automatically before the next dialog comes up. 

Some flow bar steps are containers for other steps. For example the Assign Unit Cell step appears as 
follows when it first comes up. 

 
The down arrow on the left indicates that this is a compound step. When you click the box it expands to 
reveal: 

 
The Find Spots and other flow bar boxes are actual steps.  
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The previous example illustrates some other flow bar concepts. Normally when you click the flow bar 
button a dialog pops up. However, if you click the lightning bolt to the right of the button, CrystalClear 
executes the step immediately with the current parameters for that dialog. 

You will also notice the down arrows and the dotted arrow looping back to a previous step. The down 
arrow indicates the next normal step in the flow. This is usually the step that is activated automatically 
when the current step is completed. For manual processing the arrow is just a visual guide to the next 
step, so changing it into a stop sign has no effect. The dotted arrow is merely to indicate that you may 
want to return to a previous step if the results of the current step are not satisfactory for some reason. 

You can click the down arrow and it turns into a stop sign. This stops any automatic processing of 
the flow bar (e.g., in small molecule Auto mode) at the step before the stop sign.  

Many of the flow bar buttons have a lightning bolt to their right side. If you click this lightning bolt 
you immediately start executing the step using the current default parameters rather than bringing up the 
dialog associated with that set. While the step is executing this arrow has a red X on it. If you click this X 
it aborts the step. Alternately you can click the Stop button in the upper right corner of the screen. 

Tasks 
There are actually four different flow bars that correspond to each of four different tasks. You can select 
the task and its associated flow bar using task drop down in the upper left corner of the user interface. 

 
 

When you click a task in this dropdown the sample task is set and the associated flow bar is displayed. 
These tasks include: 

• Screen Collect and Process. This is the most common task for collecting data even if you do not 
plan to integrate the images during data collection. In order to be able to use this task 
successfully, you need to be connected to either a real or a simulated instrument. 

• Collect and Process. For those who use the “Wild West” method (shoot first and ask questions 
later) to collect the data. This is not used very often in practice since it is often useful to collect 
screen images and index in order to decide how best to collect the data. 

• Collect. Even more bare bones for those who simply want to collect the data and plan to process 
it later. 

• Process. This is often referred to as Process Only and is used quite commonly to process or re-
process data that has been previously collected. 

These are same selection of tasks that are provided in the dialog to create a new sample. 

Processing Suites 
A processing suite is a program or set of programs used to process either screened images or collected 
data. These run as separate programs, but are integrated into CrystalClear’s user interface. CrystalClear 
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comes standard with two state of the art processing suites with an optional third choice for twinned small 
molecule samples. 

d*TREK. This was originally written by Dr. James W. Plugrath with more recent contributions from 
other members of Rigaku staff in the US. In addition to the standard processing operations, d*TREK 
includes features for ranking screen images and for automatic strategy calculations. d*TREK tends to 
work better for narrow images (< 2 degrees) than for wide images. 

 
FS_Process (FS_PROCESS)  Fine Slice Process was written by Dr. Tsuneyuki Higashi with 
contributions from other staff members of Rigaku Japan, FS_PROCESS is the successor to the PROCESS 
program. This program is popular in Japan and works well for both narrow and wide images. It does not 
currently include ranking or strategy. 

TwinSolve. Under a separate license CrystalClear, also provides an interface to Dr. Christer Svensson’s 
TwinSolve program. As its name implies, it is particularly well suited to twinned small molecule crystals. 
If you have a small molecule system from Rigaku, this probably includes a license to TwinSolve. 

It is possible to mix and match the processing suites to a limited extent. In particular, you can use 
d*TREK up through data collection and then process with FS_PROCESS. This is a fairly common 
approach for small molecule work especially on RAPID and SPIDER instruments. 

Working with Samples 

Opening a Sample 
Many CrystalClear operations require a current sample open. When you start CrystalClear it 
automatically presents the Open Sample dialog. 

 
 

Certain operations (e.g., Manual Instrument Control) can be done without an open sample. So if you 
really don’t want to open a sample, you can just click Cancel. But without an open sample, many 
functions are disabled. 

Parameter Description 
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Parameter Description 
Project The existing projects are listed in the Project drop down list. If you want to 

open a new project, click the New project check box. Of course, if you open a 
new project you also have to open a new sample.  

Sample All the current samples in the selected project are listed in the Sample 
drop down list. Again check the New sample box if you want to open a 
new sample. This can be done either in an existing project or a new 
project. 

Task If you are not connected to either a real or simulated instrument, it is best 
to change the task to Process otherwise CrystalClear tries to connect to 
the Instrument Server for that instrument which fails if there is no 
instrument setup. See the Task section for more detail. 

Image directory If you are creating a sample with any of the Collect tasks, then the Image 
directory defaults to <sample directory>/Images, but you can browse to 
another directory if you wish. If this is a Process sample, then you need 
to click Browse… and navigate to the image directory. You can select 
any image in this directory that matches the image template you want to 
use. 

Processing suite Each sample has one of the available processing suites associated with it. The 
default is d*TREK. 

Import If New Sample is checked, the Import button is enabled. You can navigate to 
any sample in either your user area or in another user’s area. You should select 
the <sample>_20.ho file in this sample directory. All of the files in the sample 
directory are copied to your new sample directory except the Image 
subdirectory. You are also given the opportunity to reset the path to the image 
directory since it could be on an external drive that has a different letter on your 
computer. 

Sample Manipulation Commands 
There are other ways to get to the Open Sample dialog. 

 
 

  New Sample…  This pops up the Open Sample dialog with New sample checked.  

  Open Sample… This pops up the Open Sample dialog with nothing checked. 

 Close Sample  This closes the currently open sample (usually close is automatic). 
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New Project… Pops up the Open Sample dialog with New project checked. 

 Save Sample. Save the sample database (.ho, xml) file. 

Saving a Sample 
Sample information is kept updated on disk at the end of each step in the flow bar and whenever 
significant changes are made through toolbar or menu functions. When you exit CrystalClear, close a 
sample, or open a new sample, you are asked if you want to save the sample information. If you say No 
then any changes you have made to open dialogs and other temporary information is lost. But the changes 
made to the sample by each step are saved. Log, reflection, and other files are also updated as the 
processing steps are run. They are versioned. The database (.ho) file is also versioned up to 5 levels in 
case you need to back up. You can also save a sample explicitly with either the toolbar icon or the menu 
command. 

Deleting Projects and Samples 
Since CrystalClear keeps an internal list of projects and samples, you should delete them through 
CrystalClear rather than just deleting them with Windows Explorer or other file manipulation program. If 
a project or sample is not actually found on disk in the expected path, you are asked if you want to update 
the internal list. If you really wanted to delete it, you should say yes, but if you are going to restore it later 
on, it is best to say no.  

When you delete a project or a sample you are warned that this involves deleting directories and files and 
you are asked to confirm that you really want to do this. If the images are kept in an Images subdirectory 
of the sample, they are deleted with the sample, but if they are not in the project/sample directory 
structure, they are not be deleted. So you can, for example, delete a process only sample that refers to 
images collected in a different sample without deleting the images. 

Use the following command and dialog to maintain your projects and samples. The menu entry is 
File>Delete Projects/Samples. 
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Parameter Description 
Projects This is a list of your current projects. When you select one of these projects the 

samples associated with this dialog are listed under Samples. 

Samples These are the samples in the currently selected project. 
Delete Project(s) Delete the currently selected project and all the samples that it contains. 
Delete Sample(s) Delete the currently selected sample(s). 

Defaults 

Dialog Defaults 

Overview 
CrystalClear comes with a set of defaults that were determined by the application scientists at Rigaku to 
be the recommended values. These are based on instrument type and the mode (small molecule or 
macromolecule). Furthermore, within a sample, even if you close and then re-open a sample or exit 
CrystalClear altogether, the last values you set for a dialog are retained. So it is not usually necessary to 
change the defaults. In any case, this is not recommended until you have become familiar with 
CrystalClear and understand thoroughly how it works. 

The chart below illustrates a site installation with three users and several projects and samples in order to 
illustrate how defaults are set and updated in CrystalClear. 
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When a new user is created, their defaults are taken from the site defaults. Note that the defaults are 
copied from the next higher level when the user (or project or sample) is created, so changing the defaults 
at a higher level does not automatically change them at the lower levels. 
 
When a project is created, its defaults are taken from the user defaults. 
 
When a new sample is created, its defaults are obtained from the project under which it is created. 

Example:  When sample Zn_13 was created, a copy of the defaults from project Zn was made 
and assigned to Zn_13. 
 

Each CrystalClear dialog has a Save button. This button brings up the Default Manager dialog shown 
below which allows the user to save the defaults for that dialog to the selected level. When the user saves 
defaults at the project level, the changes are not automatically reflected in other, existing samples in the 
project, but the Default Manager allows defaults to be propagated to other samples, projects (and if you 
are an administrator, other users and the site defaults). In any case, any new samples created reflect the 
new defaults. 
 

NOTE:  Only the administrator can save defaults at the level of other users and the site. Any user can 
save up to their own user level. 

Default Manager Dialog 
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This dialog allows you to choose both the level and the individual objects you want to update. The 
general practice and recommendation is that you save defaults to the project, user, and site level only. 
Once a sample has been created, it is a little misleading to go back and change the defaults that brought 
you to the current state. The exception to this rule is that you may want to save the defaults for a 
particular dialog to the current sample so that they are retained for later use. 

The tree control on the right side of this dialog is what actually controls which samples, projects, and 
users have their defaults updated. If the circle is filled in, the associated level is updated. The controls at 
the left of the dialog are only shortcuts for selecting or deselecting elements in the tree control.  

You have to have administrator privileges to set the site level or to set anything for another user. Note that 
this means that you are in the administrator group for CrystalClear which was specified when your 
CrystalClear user account was added, not that you have administration privileges in Windows which is 
entirely separate. 

Parameter Description 
Current levels This series of check boxes just selects the current sample, project, user, or the 

site level. It does not affect how the buttons below it work. 

Set/Unset These two buttons just set or unset whatever is highlighted in the tree control. 
Since you can toggle the selection state simply by clicking on the circle next to 
the object name, these are not heavily used. 

Set All/Unset All These buttons set or unset everything in the table. This can get you closer to the 
final selections that you want, but you usually have to go through and select 
objects one at a time. 

OK Click OK when you have selected the items to be updated by the new defaults. 

Cancel Exits without updating any defaults. 

 



2. Getting Started 
 

 

3-12 CrystalClear User Manual 

Collection Schedule Defaults 
There are some additional steps to create collection schedules that can be shared with other samples, 
projects, or users. The best way to do this is from the Scan State Display which is described in the next 
Chapter in order to create and store new schedules. 

CrystalClear Databases 
The CrystalClear database files are binary files with a .ho extension that contain information that 
CrystalClear needs to maintain from one run to the next. These files are also stored as xml files, but the 
xml files are read only if the .ho file cannot be found. Normally these fails are maintained entirely by 
CrystalClear and you need not worry about them. However, they can occasionally become corrupted (e.g., 
if the computer has a problem during the middle of a write operation) and you are asked by your Rigaku 
service person to delete the .ho file to force CrystalClear to revert to the xml file. 

The database files in CrystalClear are listed in the following table. 

 

Database Directory File Name 
Administration 
(Users) 

*C:\Rigaku\CrystalClear\ 
Administration 

*AdminDatabase_20.ho 
*AdminDatabase_20.xml 

Site defaults *C:\Rigaku\CrystalClear\Data\ 
SiteDefaults 

<instrument name>_20.ho 
<instrument name>_20.xml 

User preferences <user data directory> *UserPrefs_20.ho 
*UserPrefs_20.xml 

User defaults <user data directory> *CrystalClearUserDefaults_20.ho 
*CrystalClearUserDefaults_20.xml 

Project list <user data directory> *CrystalClearProjects_20.ho 
*CrystalClearProjects_20.xml 

Project defaults <user data directory>\<project> *CrystalClearProjectDefaults_20.ho 
*CrystalClearProjectDefaults_20.xml 

Sample list <user data directory>\<project> *CrystalClearSamples_20.ho 
*CrystalClearSamples_20.xml 

Sample 
(cell parameters, 
history, dialog 
defaults, collection 
information) 

<user data directory>\<project> 
<sample> 

<sample name>_20.ho 
<sample name>_20.xml 

 
* - Directory or Filename for this database does not change. 
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4. The Toolbar and Views 

 

CrystalClear includes a set of views (also referred to as displays). The toolbar is described briefly and the 
most commonly used viewers are discussed in detail in this chapter. Specialized viewers that are used less 
often are covered in Chapter 12 on Tools.  

Some of these views also allow you to interact directly with the instrument or modify parameters and 
settings used data collection or processing, so they are interactive views rather than simply passive views. 

The viewers covered in this chapter include 

• Image Viewer. For examining the collected images. 

• Processing State Display. Cell parameters and other processing information 

• Scan State Display. For monitoring and managing collection schedules 

• Instrument State Display. Axis positions and image collection monitoring 

• Manual Instrument Control. Control functions for low level operations on the instrument 

• Log File Viewer. To review processing log files 

Toolbar Overview 
The Toolbar displays buttons which are easily accessible to complete common activities. As you move 
your mouse cursor over each button, a Tool Tip flyover helps you identify the button function. Many of 
these functions can also be accessed using the menu. 
  

 

  

New Sample. Accesses the Open Sample dialog, allowing you to create and name a new 
sample. 

   

Open a Sample. Accesses the Open Sample dialog, allowing you to open an existing 
sample.  

   

Save Sample. Saves the current sample.  

   

Use d*TREK as the processing suite. 

 

Use TWINSOLVE as the processing suite.  

   

Use FS_ PROCESS as the processing suite. 



3. Toolbar and Views 
 

 

4-2 CrystalClear User Manual 

  

View Image Collection Updates. When toggled on, image updates are displayed during 
collection. Toggle ON position shows as the button pushed in. 

  

View Image Processing Updates. When toggled on, processing results are displayed 
during processing. Toggle ON position shows as the button pushed in. 
If View Image Processing Updates is toggled ON, the reflection in the reflection file is 
represented on each image using the following color scheme:  

 Included = blue circles,  
 Excluded = green circles,  
 Rejected = red circles.  

Adjusting Resolution Range fields, and I/σ includes/excludes reflections. Adjusting the 
rejection limit, (X and Y in mm, Rot in Degrees) includes/rejects peaks). Also displayed 
on each peak is a difference vector representing the difference between the peak top on the 
image and the center of the predicted reflection related to the current values of the 
orientation matrix. 

   

View Image. Accesses the Open Image File dialog, allowing you to select an image to 
view.  

   

View Processing State Display. Accesses the Processing State Display dialog, allowing 
you to make adjustments in the processing state. 

   

View Scan State Display. Accesses the Scan State Display dialog, allowing you to make 
create, edit, and examine scans within named schedules. 

   

View Instrument State Display. Accesses the Instrument State Display dialog. 

   

View Manual Instrument Control. Accesses the Manual Instrument Control, allowing 
you to control the instrument. 

    

View Log File. The Open Text File dialog appears, allowing you to select the log file to 
view in text format. The file is then opened in the Log File Editor.  

    

Set Resolution. Access the Set Resolution dialog, allowing you to set resolution limits.  

   

The RAX Shape crystal viewer are displayed. This is available for small molecule only. 

   

Open Reciprocal Space Viewer. Initiates the Reciprocal Lattice Viewer which uses the 
current cell parameters (including any twin information found by TWINSOLVE). The 
Lattice Viewer can also be used to help diagnose and even index problem samples.  

   

Display Summary of Indexed Twins. Accesses the Twin Summary (TwinSolve) table. 

   

Previous Window. The previous window is displayed. (Note there is a separate green 
arrow for the next image in the Image Display.) 

   

Next Window. The next window is displayed.  
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About. The About dialog displays information about the current version of CrystalClear.  

 
Pause. Pause data collection after the current image has been collected. This turns into a 
continue button once you have paused. These controls are also in the instrument state 
control. 

 
Stop After Image. Stop after the current image has been collected. The advantage of this 
over the full immediate stop below and the Abort button that is always visible is that since 
it allows the current image to finish, the system state is known and you do not have to re-
initialize when you restrart. 

 

Toggle Task List. Toggle ON/OFF to display/remove Task List on Toolbar. Toggle ON 
position shows as light, recessed frame.  

   

Toggle Standard Tools. Toggle ON/OFF to display/remove Standard Tools on Toolbar. 
Toggle ON position shows as light, recessed frame.  

   

Toggle Flow Bar. Toggle ON/OFF to display/remove the Flow Bar on CrystalClear 
interface. Toggle ON position shows as light, recessed frame. 

   

Toggle Command Bar. Toggle ON/OFF the Command Line to display/remove it from 
the CrystalClear interface. Toggle ON position shows as light, recessed frame. The 
Command Bar is not used currently, so this should be left off. 

   

Toggle Message Bar. Toggle ON/OFF the Message Bar to display/remove it from the 
CrystalClear interface. Toggle ON position shows as light, recessed frame. 

   

Toggle Status Bar. Toggle ON/OFF the Status Bar to display/remove it from the 
CrystalClear interface. Toggle ON position shows as light, recessed frame. 

   

Not used  

 

STOP (shown inactive) Close the shutter and shut down the device driver or processing 
server immediately.  

   

Cube  The cube rotates to show the activity of processing and collection data. 

Activating Views 

Toolbar Icons 
The viewers can be activated by the icons toward the center of the toolbar. 

 
They are also activated automatically when they would be useful to display the results of an operation. 
For example, if the View Image Collection Updates is active, the image viewer is started when the first 
image has been collected. More than one view can be open at once, but only the front view is active. 

You can use the Windows menu or the green forward and back arrows to bring views to the front. And of 
course, you can move views around within the CrystalClear main window. 
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Image Display 

Overview 
 

   The Image Display is activated by selected by clicking on this icon. Alternately you can select 
File|Open Image… from the menu. The Image Display may also be opened automatically if you have 
selected either View Image Processing Updates or View Image Collection Updates from the toolbar. 

The Image Display provides many options for displaying the image in various ways at various scales and 
position. It also provides an interface for defining masks and selecting reflections. Most of these functions 
are documented in the section on the main toolbar. 

The basic layout is show below. 

 
There are several areas of this viewer. 

• Main Display. This is the large image display area which is shown with a red cross in the above 
view. The tool bar icons at the top of this display area operate on this display. 

• Profile Display. These are the two areas along the bottom and to the right of the main display 
which display profiles of the cross section of the image along the red cross. 

• Zoom Display. This is the smaller image display to the upper right which shows a zoomed in 
view of the part of the image selected by the red cross. 
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• Image Information. This is the form at the lower right which contains information from the 
image header.  

• Main Toolbar. The toolbar at the top of the display operates on the main display. 

• Right Toolbar. This vertical toolbar operates on the zoom display. 

 

Image Controls 
The icons in the main toolbar allow you to manipulate the main display. The icons in the right toolbar 
have the same function as they do in the main toolbar except they apply to the zoom display rather than 
the main display. For most of these icons you click the icon to select the desired control and then click the 
image to perform the function associated with that tool. 

 

 
Select You can left click anywhere in the main display. This centers the red cross 

and the zoom display on this pixel and show information about that pixel 
in the Image Information window. The horizontal and vertical profiles 
along the red cross are displayed automatically in the profile display. 
 
You can also right click and drag out a box. This zooms into the area 
selected by the box preserving the aspect ratio of the main display. 

 
Magnify With the Magnify tool you can left click the image and the area 

immediately under the cursor is magnified. You can drag the cursor to 
scan across regions of the image. 

 
Zoom Generally the best way to zoom is to use the right click feature under 

Select which changes both the zoom level and the center of the image. If 
you want to change the zoom level and leave the center as it is, you can 
left click Zoom and click anywhere in the display and drag the cursor up 
for zooming in and down for zooming out. 

 
Full View This tool returns the display to the original image display size which fits 

the entire image in the space available in the main display. You can also 
double click the main image display. 

 
Pan Left click and then drag the image. Note that this does not change the 

selected pixel on the image which means that the zoom display, red cross, 
and profile display do not move when you pan.  

 
Measure This tool displays a measurement in Ångstroms between two points. Click 

a point, then drag to a second point.  

 
Profile Use this tool to get a Profile of a cross section. Unlike the Select profile, 

which gives only horizontal and vertical profiles, with this tool you can 
get a profile of pixel values in any arbitrary direction. Click a point, then 
drag to a second point to display the profile. 

 
Add Spots Click a spot to add it to the displayed reflection list.  

 
Delete Spots The spot closest to where you click is removed from the reflection list that 

is being displayed. 

 
Measure Pixels By clicking on a point in the display and then dragging to another point in 

the display, you can determine the number of pixels between the points. 
Note that these are pixels in the original detector image and not simply 
display pixels so they are independent of the zoom level.  

 
Quad Erasure This is used to create a mask region for a mask file. You can click four 

different points which defines a quadrilateral (the line from the fourth 
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point back to the first point is implicit). Any reflections within this 
quadrilateral are masked out for integration. After you have used this tool 
and the circle tool to define the mask areas, you must save the mask file. 

 
Circle Erasure To define a circular mask region you need to click first on the center of 

the circle and then drag the radius out as far as you would like.  

 
Free-hand 
Erasure 

This tool is not currently active.  
  

 
Undo Last 
Erasure 

Undo the last erasure. This tool only allows a single undo of the quad and 
circle tool actions. 

 
Write File Save an image that has been modified.  

 
Write Mask File Click this tool to save a mask file. The mask file is an image file that 

includes any erasures you might have made. You are prompted for the 
location of the mask file.  

 
Contrast This brings up a control which lets you interactively adjust the contract of 

the image. 

 
Reverse Reverse the pixel values (i.e. show the negative) of the image.  

 
Color Toggle between gray scale and color display.  

 
Toggle Square 
Root Display 

Displays the image with each pixel value being converted to its square 
root. This gives more contrast to the image, truncating the strong pixels 
and raising the display of weak pixels.  

 
Reset Local 
Contrast 

Sets the contrast of the displayed portion of the image. This is useful in 
zoomed areas where there is a smaller or greater difference in minimum 
and maximum pixel intensities than the current contrast values.  

 
Load Reflection 
List 

Loads a reflection list into memory. If you would like to add or remove 
reflections from this list you can use the Add Spots and Delete Spots 
tools, then click Write Reflection List to save the edited reflection list.  

 
Write Reflection 
List 

Saves the current reflection list with any additions or deletions.  

 
Set Reflection 
Size 

Adjust the size of the circle drawn around each spot. Note that this circle 
is for display purposes only and does not reflect the integration area or 
background/peak separation.  

 
Toggle Filtering Filter out spots from reflection list that are not located on the current 

image. For example, a spot that appears in Image 10 may not intersect 
Image 1. This tool filters out all spots whose rotation range does not 
intersect the displayed image.  

 
Previous Image Display the previous image in the series. For example, if the current 

image is Img004.osc, clicking this tool displays Img003.osc. 
This allows you to click through the images in a data set very quickly.  

 
Next Image Display the next image in the series. For example, if the current image is 

Img004.osc, clicking this tool displays Img005.osc. 

 
Overlay Images Display an image created from a specified series of images. Each pixel in 

the resultant image is generated by using the maximum value occurring in 
the images for that pixel position. This is generally used to display the 
image that would result from a wider rotation/oscillation angle.  

 
Underlay Images Display an image created from a specified series of images. Each pixel in 

the resultant image is generated by using the minimum value occurring in 
the images for that pixel position. This is generally used for examining the 
background over wide rotation/oscillation angle or for examining the 
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extent of a reflection across several images and rotation angle values.  

 
Average Images Display an image created from a specified series of images. Each pixel in 

the resultant image is generated by using the average value occurring in 
the images for that pixel position.  

 
Tile Images Displays an image created from tiling a specified series of images.  

 
Image Font Clicking on this tool brings up a dialog which allows you to change the 

font used in the image viewer. 

 
FSP Mask Delete This deletes the current FS_PROCESS mask file (blind.dat) and is only 

useful when FS_PROCESS is the current processing suite. 

 
Write JPG File This writes the current image as a jpg file. Images are quite large. Being 

able to write them as a jpg file compresses them and allows them to be 
included in documents and viewed by standard image viewers. 

   

Image Information 
The image information area contains vital information about the current image, the current selected pixel 
on that image, and controls for filtering the reflection list and controlling display options. 

 

 
 

The image name and associated image information for the current image are display in the top section of 
this panel. The values relating to the current pixel are: 
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Pixel position. Pixel position (in the original image space, not the image display space – so this does not 
depend on zoom). 

Pixel Value. The value of the current pixel in the image file. 

Peak Intensity. The intensity of the nearest peak to this pixel. 

Resolution. The resolution of the current pixel in Angstroms and degrees. 

Intensity/Sigma. The I/Sig of this pixel. 

HKL. If the sample has been indexed and there are cell parameters, and you are reasonably close to the 
reflection center, the integer HKL values are reported. 

Spot Distance. If you are using the Measure tool, the current distance between spots is display in this 
area. 

Number of spots. This text control is actually replaced with the number of spots in the current image. 

Spot Slider. The spot slider allows you to filter out the weakest spots. This is only really useful after Find 
and before Index. You can then save the spot list to the sample directory using the Write Reflection List 
tool in the main toolbar and then use this reflection list for indexing. 

Resolution Arcs. This brings up a dialog for setting resolution arcs. 

 
To display arcs you need to click the Visible check box. You can then control the number of Default arcs, 
or select Custom arcs that you define yourself. The Prefs… button brings up the preferences dialog which 
is described in Chapter 2 on installing CrystalClear. 

Display Orientation. This shows you the display orientation. To change the orientation, you must click 
the Prefs… button which brings up a dialog described in Chapter 12. In the example above the image 
orientation is taken from the image header which is the normal and recommended setting. 
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Creating a Mask File 
A Mask File may be used to define the shadow of the beam stop on images and mask the pixels in the 
beam stop shadow. Reflections overlapping with the shadow are excluded during Integrate Reflections. 
d*TREK and FS_PROECSS, and TwinSolve use mask files to improve the quality of the integration.  
 
The mask file is usually defined interactively in the Image Viewer with the tools described below. You 
may do this at any time, but it might be best to do it after you have collected the screen images. Note that 
mask files are dependent on 2 Theta and to a lesser extent on distance, so if your scans have multiple 2 
Theta and distance values, you should do a mask file for each scan. 
 
If you have not specified a mask file prior to clicking the Run button on the Integrate Reflections dialog, 
the following CrystalClear message appears: 
 

 
 

 Clicking No discontinues the Integrate Reflections so you may go back to the Image Viewer to 
create and specify a mask file before continuing. 

 Clicking Yes continues with the Integrate Reflections without a mask file. 
 

1. Select and display any image in the Image Window by clicking the View Image  on the 
CrystalClear Toolbar. Select any image. 

2. Click Circle Erasure  on the Image Window Toolbar to define a circular area to be masked 
during processing. To use, click the center of the circular area, then drag to the outside edge of the 
area. When the mouse button is released, the circular area are defined. This is usually used to define 
the mask for the cup of the beam stop.  

3. Click Quad Erasure  on the Image Window Toolbar to define a four-sided area to be masked 
during processing. To use, click in four corners of the area to be removed. This created 3 lines since 
the 4th line is automatically connected back to the first point. This is usually used to define the mask 
for the support of the beam stop from an image.  

 

4. Click Write Mask File  on the Image Window Toolbar to save a mask file. The mask file is an 
image file that includes any erasures you might have made.  
The Save Image File As dialog appears. 
 

5. In File Name type a unique name for this mask file.  

NOTE:  You may create multiple mask files by repeating steps 1-4, then using a unique name for each 
mask file. 

6. Click Save.  
The following CrystalClear message appears: 
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7. Click Yes to use this mask file for all scans. Click No to use different/multiple mask files for various 
scans.  

 
All Rigaku CCD detectors now create an Active Mask which is encoded at the end of each image file 
which marks bad pixels. This is all handled automatically, so that you do not need to worry about it. 

Processing State Display 

Overview 

 The processing state display is used to show the current cell parameters and other information 
related to the current sample. It can be activated at any time by clicking on the icon in the top tool bar 
shown here. It can also be activated by clicking Processing State Display… in the View menu. And 
finally, it pops up on its own after indexing or other processing steps that change the state. 

CrystalClear maintains a full copy of the state of the sample after each processing step. These states are 
numbered and stored in a stack (most recent on the top of the stack). This complete state history allows 
you to go back to any previous step (e.g., if the last refinement messed up the cell parameters beyond 
repair). It is even possible to edit parameters (e.g., the cell values) by hand and create a new state to be 
used for further processing. This state history is stored when you Save the sample and is restored when 
the sample is re-opened even if you have exited CrystalClear.  

Display Parameters 
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Parameters Description 
Current State The number and description of the step that created the current 

state. In this example this is the 9th state and was created by 
Refine Primitive Cell.  

State History This is drop-down list that contains the history of all states of 
the sample with the most recent at the top. When you select a 
state, the values associated with that state are shown in the 
Processing State Display. 

Set As Current Although the new state values are displayed when you select 
the state in the State History, they are not set as the current 
state for further processing unless you click the Set As 
Current button. 

Save Changes To New State To create a new state, select an existing state that is near to 
what you want and then edit the parameters you want to 
change (e.g., change a cell axis that is twice as long as it 
should be). You can then click this button and it creates a new 
state with the current values and make this the current state for 
further processing. 

Discard Changes If you have made edits to the parameters in the Processing 
State Display and decide you do not want to keep them, you 
can click Discard Changes and the original values associated 
with the selected state is restored. 
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Parameters Description 
Crystal Component 
(refined values) 

The crystal component can be used for selecting the current 
twin component. This is most useful when using the 
TwinSolve option. Otherwise this is just 1.  

  a 
b 
c 
α 
β 
γ 

The current unit cell parameters. 

Rot1, Rot2, Rot3 These are the orientation angles determined during indexing. 
Mosaictiy The current mosiacity as calculated by the current processing 

suit. 
Volume The crystal volume. 
Space group The first group of radio buttons has one of three states 

depending on the extent to which the space group is known. 
 Unknown 
 Possible 
 Known 

Crystal System This drop down shows the current crystal system and allows 
you to select a different one. 

Number The most likely space group number 
 Name The most likely space group name 
 {possible space groups} This is a list of possible space groups starting with the most 

likely. 
 Laue Class The current Laue class with the option to select others through 

a drop down list 
 Lattice The current lattice with a drop down list 
 Centricity Centric or Acentric 
Scan This shows the scan that was used to in the last step. All the 

current scans are in the drop down list, so you can select other 
scans. 

Detector 
(absolute refined values) 

This area displays the refined detector settings. 

  XShift 
YShift 
Distance 

Refined detector shift and distance 

 Rot About Beam 
2 Theta 
Rot Y 

Refined rotation and 2 Theta shifts. 

 X 
Y 
Pixel Size 

The direct beam position (calculated back to 2 Theta = 0 even 
if the current 2 Theta is something else). 
Pixel size for this detector 

Source 
 
  

The source settings are for information and should not usually 
be changed here. It is best to change them in the Setup dialog 
and then save them to the configuration file. 

 Wavelength 
Rot1 
Rot2 

Source parameters 

Mask File Shows the mask file currently used for integration. This can be 
changed in the integration step. 
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Parameters Description 
Num Accepted This shows the number of reflections accepted in the last step 

(e.g., refinement). 
RMS Residuals This is a summary of the RMS residuals that came from the 

last refinement step in millimeters and degrees. 
  

 

Scan State Display 

Overview 

 The Scan State Display can be activated by clicking on this icon in the top toolbar or by selecting 
Scan State Display in the View menu. This view shows what is collected and what has already been 
collected. It also allows you to create and store collection schedules so that they can be used in other 
samples. You can use this view for several different purposes: 

• Review the current status of your data collection. This can also be done through the Instrument 
State Display which gives you a more detailed view. 

• Review the status of your data collection if it has had to be interrupted for some reason. The scan 
state display tells you exactly what you were collecting and how far it got. 

• Review the scan information from a sample that you re-open or create as a process only sample. 

• Create standard schedules that you can re-use at other times or share with other users at your site. 

Before getting into the details of this view, it is necessary to define some of the terminology used by 
CrystalClear which is adopted from d*TREK conventions. 

Images 
An image is a single exposure from the detector. For image plate detectors (e.g., R-AXIS, Rapid, etc), 
these have a .osc extension (since historically these devices have fairly long exposure times and oscillate 
at least once back and forth during the exposure). For CCDs the images have a .img extension. Images 
correspond to what are sometimes called “frames” in other crystallographic software. 

Scan 
A scan is a collection of images that differ from each other only in the setting of a scan axis. For example, 
the scan may be from 0.0 to10.00 degrees. Each image in the scan has a width which is the amount the 
axis rotates during the exposure and a step which is the distances from the start of one image to the start 
of the next image. For screening small molecule data you might have a scan with a 1 degree width and a 
10 degree step that would go from 0.0-81.00 degrees in 10 degree steps, so that there would be 9 images. 
Note that the end angle is the angle at the end of the last image, not at the beginning. 

If a set of images do not meet the rules for a single scan, they are divided into two scans. For example, if 
you collected four 0.5 degree images at 0, 0.5 and 90.0, 90.5, this becomes two scans. Similarly if another 
axis changes (e.g., chi or kappa) from one image to the next, a new scan is generated. 
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Schedule 
A schedule is a collection of scans that usually defines a complete data set. There are Screen schedules 
and Collect schedules maintained separately by CrystalClear. Schedules have names and can be made 
accessible to other samples and even other users. 

Controls 

 
 

There are several regions of this display that are dealt with separately. 
• Screen 

o Schedule Management 
o Scan Table 

• Collect 
o Schedule Management 
o Scan Table 

• Miscellaneous Controls 
 
The schedule management and scan tables are the same for both screen and collect, so we only describe 
these controls once. The exact scan tables and similar schedule management is also used in the separate 
screen and collect dialogs that are associated with the Initial Images and Collect steps in the flow bar. 

Schedule Management 

The controls for schedule management are shown below. 
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Schedule Drop Down. This is a drop down list of pre defined schedules for either screen or collect. 
These are stored in the defaults and so your sample inherits the schedules that are in the project defaults. 
If this is a process only sample, then there is a derived schedule which was constructed when the sample 
images were read in. The name for this schedule is a path to a directory. When you select a schedule, the 
scans associated with that schedule are shown in the scan table. 
 
Add. This button allows you to add a new schedule to the screen or collect schedule list. The dialog that 
comes up when you click this is: 
 

 
 
You should enter a Name for the new scan and choose one of the existing scans as a starting 
point for deriving this scan. If you want to use this schedule in other samples, you need to click 
the Save button at the bottom of the dialog after you have added the schedule. This brings up the 
standard Default Manager described in Chapter 2 which allows you to select the levels and 
objects to be updated with the new schedules. Note that this saves the entire current scan table 
list to each of these rather than just adding the new sample you have created. 
 
Delete. When you no longer need a schedule, you can delete it with this button. 
 
Manager. For more complex schedule management, this button brings up a separate dialog. 
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The Samples tree control allows you to navigate to a user, project, and sample. The current schedules for 
the selected level are shown in the Schedules list. You can navigate to the schedule you want to operate 
on and then use one of the following buttons 

• Rename. This allows you to rename the schedule. You should not rename schedules that 
are not in your current sample, project, or user. 

• Delete. Delete removes the selected schedule. Again you should restrict this to your own 
sample, project, and user. 

• Import. If there is a schedule that you would like to use which is not in your current 
schedule list, you can navigate to this schedule and then import it. 

• Close. Closes the schedule manager. 
 
Add Scan. This adds a scan to the screen or collect schedule. Its initial settings are copied from the last 
scan. 
 
Delete Scan. If you want to remove a scan, select it and the click Delete Scan. 

Scan Table 
Scan Tables are used in the Scan State Display and in the screen and collect dialogs. It works the same 
way in all these environments. 

 
The Scan Table is very flexible and can be customized to your particular needs. The table below describes 
the interaction with this table. Many of these functions are activated by right clicking, so they are not 
always obvious, so it is useful to read the following section carefully. 
 
Mouse Action Results 
Right-click any 
column heading 

To display a column, just click the column name. If you click a checked 
column, it toggles to unchecked and is not displayed. This allows you to 
customize the scan table to fit your needs. To close this dialog, just click 
somewhere outside this list. 
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Mouse Action Results 

 
Right-click  
"Images Scheduled" 
column heading 

Right-click the column heading named Images Scheduled. In addition to the All 
Columns menu (shown above), a Schedule All menu appears (shown below). 

 
Right-click "Images 
Scheduled" field 
entry 

A pop-up menu appears which allows you to: 

 
Right-click any other 
field entry 

A pop-up menu appears. This feature is helpful in moving scans and when 
setting similar parameters for several different scans. 
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Mouse Action Results 

 
Click and drag 
heading lines 

Dragging a vertical column line allows the user to extend the column widths to 
view an entire columnar heading. Making columns narrow allows the user to fit 
more columns into the viewing area.  
Dragging on horizontal lines expands depth of the table.  

Double click a field In order to edit a field you should double click the field you want to change. 
Tab To get to the next field, you can just tab. Note that some of the fields are gray 

since they are read only fields. 
 
The meaning of each field in the Scan Table is given below. Chi is replaced by Kappa for AFC-11K and 
AFC-12. 
 
Column Heading Description 
Scan ID Scan identification number. 
Scan Template A separate dialog pops up in which you enter the template without the 

????. 
Detector Distance Value of the distance axis of the detector goniometer. Also referred to as 

the crystal-to-detector distance (in mm). 
2θ Value for 2θ axis of the detector goniometer (in degrees). 
Max Resln (deg) Maximum resolution at edge of detector for specified distance (in Å or 

degrees depending on your settings in Preferences). 
λ (Wavelength) λ of the X-ray source specified in Å. 
Beam X Position of latest direct beam shot along the X-axis. 
Beam Y Position of latest direct beam shot along the Y-axis. 
ω Position of ω (Omega) axis of crystal goniometer (in degrees). 
χ  Position of χ (Chi) axis of crystal goniometer – Replaced by  

Κ (Kappa)  for AFC-11K and AFC-12 (in degrees). 
φ   Position of φ (Phi) axis of crystal goniometer (in degrees).  
Rotation Axis Scan axis which is usally Omega (ω), or Phi (φ).  

NOTE:  Phi (φ) is normally used on the R-AXIS. Omega (ω) is used on 
the AFC8 and AFC9. Omega (ω) and Phi (φ) are used on the 
AFC7, AFC11, and Kappa goniometers. 

Start Angle 
  

Angle of scan start position for the rotation axis (in degrees).  

End Angle Angle of scan end position for the rotation axis (in degrees).  
Width Width of one image (in degrees).  
Step The angular distance between the start angles of two consecutive images 

in the scan. Step usually has the same value as Width, but it may different 
in for collecting separated screen images or other purposes. 

Num Images The number of images to be collected in the scan.  
Completeness Percent completeness of the data in that scan. 
Start Num Image number to assign to first image of scan.  
Exp Time Exposure time (in seconds or minutes).  
Image Sequences Images in sequence groups.  
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Column Heading Description 
Collected Images already collected, if any. 
Scheduled Images currently scheduled for collection during next collection run. 
Sched Start  Scheduled start angle position for images (in degrees).  
Sched End  Scheduled end angle position for images (in degrees).  
  

Scan Selection Table 

Scan Selection Table Dialog Component 
The Scan selection table does not appear on its own, but is a common component of many dialogs. Since 
it is closely related to the Scan State Display, it is described here. 

 
 

Each scan is represented by a row in this table. For this example there is one screen scan and one 
collection scan.  

Parameter Description 
Template This is the file name template for the particular scans. More than one collect 

scan may have a given template, but the Available numbers are different. 

Available Image numbers within the scan template are displayed in the Available column. 
To Use This is where you specify which of the images within this scan you want to use 

for the particular operation. For example if you wanted to use all the images in 
the collect scan in this example, you would type in 1-180 in To Use. There are 
other ways to fill in To User 

• You can double click the Available cell for that scan. This selects all 
the images that are available. 

• You can right click the To Use cell and click Select Images. This gives 
you the dialog shown below from which you can select the images you 
want 

• Another option for right click is Select All which selects all the 
available images for that scan. 

• The final right click option is Clear which clears the To Use cell for 
this scan. 

Select All Most instances of this dialog component have a Select All button which selects 
all available images from all scans. 

Clear All Most instances also have a Clear All button which clears the entire To Use 
column. 
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Select Images Dialog 
This dialog is activated when you right click a To Use cell and then click Select Images.  

 
 

Parameter Description 
Scan This shows the scan number (an arbitrary integer identifier), the scan template, 

and the available images. 

Image List Each image is shown in a row of this list. Each row has a check box and 
includes the scan information (the O in the table above is for Omega, the scan 
axis it is not a numeric 0). You can check individual files, but if you just want 
to leave out some images, it is better to click Select All and then uncheck the 
images you don’t want. 

Sequence This is the sequence of images that have been checked. When you click OK, 
this goes into the To Use column in the Scan Selection Table. 

Select All Check all the images. 
Clear All Uncheck all the images. 

Instrument State Display 

Overview 

 The Instrument State Display is purely a viewer and has no interaction controls that allow you to 
change the state of the instrument. The one exception to this is that there is a button to allow you close the 
shutter in an emergency. It is common practice to display this viewer during data collection since it also 
gives expected finish times for the current scan and schedule. The instrument state display is somewhat 
different for CCD and image plate (R-AXIS, RAPID, etc) instruments. 
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To control the low level operations of the instrument (e.g., to rotate a goniometer axis), use the Manual 
Instrument Control icon described in the next section. 

CCD 
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Parameters Description 
X-Ray Source 
  Shutter Status:  Open:  Elapsed Exposure Time displayed and Close 

button enabled. 
 Closed: Enabled when Shutter Status Open.  
 Unknown.  

Voltage (kV) Voltage setting of X-ray goniometer. 
Current (mA) Current setting of X-ray goniometer. 
Slit Size Size of Slits. 
Element Target element producing X-radiation. 
Focus X-ray generator focus type. 
Collimation Type Type of collimation of attached optics. 
Source Type Type of X-ray generator. 
Optic Type Type of optics system. 

Goniometer 
  Crystal Current positions and names of crystal goniometer axes. 

Detector Position Current names and positions of detector axes (e.g., Distance 
and 2Theta) 

Detector  
  Image Current image being collected and total images in current 

scan. 
Requested Settings Various information about current image and scan being 

collected. 
Expected Finish Time Expected finish time for current image and current scan. 

 Pause Collection This pauses data collection after the current image has 
completed. The button is then renamed and allows you to 
resume data collection. You do not have to re-initialize to 
resume. 

 Stop After Image This stops the current schedule after the current image has 
been collected. This is the preferred way to stop a data 
collection (e.g., the crystal has died or slipped out of center) 
since you do not need to re-initialize to continue on with the 
next sample or to restart the collection on the current 
schedule. 

  Detector Type Type of detector. 
  CCD Status Current action being performed by CCD, elapsed time of 

action, miscellaneous information. 
  

R-AXIS 
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The parameters for this are similar to the CCD version, but there are additional parameters for the status 
of the image plates. 

Parameters Description 
X-Ray Source 
  Shutter Status:  Open:  Elapsed Exposure Time displayed and Close 

button enabled. 
 Closed: Enabled when Shutter Status Open.  
 Unknown.  

Voltage (kV) Voltage setting of X-ray goniometer. 
Current (mA) Current setting of X-ray goniometer. 
Slit Size Size of Slits. 
Element Target element producing X-radiation. 
Focus X-ray generator focus type. 
Collimation Type Type of collimation of attached optics. 
Source Type Type of X-ray generator. 
Optic Type Type of optics system. 

Goniometer 
  Crystal Current positions and names of crystal goniometer axes. 

Detector Position Current names and positions of detector axes 
Detector 
  Image Current image being collected and total images in current scan. 

Requested Settings Various information about current image and scan being 
collected. 
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Parameters Description 
Expected Finish Time Expected finish time for current image and current scan. 

Detector Type Type of detector. 
  Read Head Position Current X and Z positions of read head. 

IP Status Current status of IP: position, expose, erase, read, decay, and 
moving elements. 

  

Manual Instrument Control 

Overview 
 

 The Manual Instrument Control viewer functions both to report the current status of the instrument 
and to control the settings of the goniometers and detector positions. It can also be used for collecting 
single images. Like the Instrument State Display, there are different forms of this viewer depending on 
your instrument type. 
 
This viewer is intended primarily for installation and maintenance functions, but depending on your 
instrument it can be useful to move to a position where it is easier to mount the crystal or perform some 
other function. You have to have administrator privileges to use the manual instrument control.  

CCD 
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Parameter Description 
Goniometer Positioning  
  Crystal: Displays current positions of crystal goniometer axes and allows for 

positioning of goniometer axes. You can only move one axis at a time, 
so you first need to select the axis you want to move by clicking on the 
radio button next to it. You then need to enter the new value for that 
axis. Note that the Move! button does not become active until you 
have entered a value into the edit box. So if you have initialized and it 
is still deactivated you just need to enter a value and it becomes 
enabled. 

Detector Displays current positions of detector axes and allows for positioning 
of detector axes. 

Shutter Control 
  Open Specifies Open Shutter control  

 Until manually closed -  the shutter remains open until Close! 
button is clicked. 

 Timed - X-ray shutter remains open for specified time (in 
seconds) or until the Close! button is clicked. 

Open! Click button to open the shutter. 
Close! Click button to close the shutter. 

Attenuator Indicates if the attenuator is placed In or Out of X-ray beam. 
Beam Stop Indicates if the beam stop is placed In or Out of X-ray beam. 
Expose and read  
  Expose time Allows a change in the Expose time (in seconds). 

Dezingered 
exposure 

Allows Dezingered exposure. Stipulate the Multiplier. 

Bin mode Specify the binning mode. 
 1X1 
 2X2 
 4X4 

Shutter It is sometimes useful to take images with the shutter closed, so this 
control gives you the option. 

Expose and Read! This activates the exposure cycle. 
Initialize Nothing else in this dialog works until the instrument has been 

initialized. 
 

R-AXIS HTC 
Initialize Tab 
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Parameter Description 
Initialize Displays Initialize parameters to be included. The Instrument State Display 

appears during initialization 
  Goniometer If Goniometer is selected, it is included in Initialize 

R-AXIS  If selected, the detector is included in Initialize. 
Scanner* If Scanner is available and selected, it is included in Initialize. 
Erase Plates  If Erase Plates is selected, plates are erased during Initialize. Specify: 

 1 plate 
 All plates  

Initialize! Click the button to complete the initialize. 
Read head position Displays Current Position of Read Head. Allows for input of a position to move 

to. This should only be done by a trained Rigaku service person. 
  Move! Click button to complete the move. 
 
Goniometer Positioning Tab 
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Parameter Description 
Crystal Displays Current positions of crystal goniometer axes and allows for re-

positioning of goniometer axes. 
  ω Move the omega axis of crystal goniometer (in degrees). The new position is 

entered in the edit box next to the selected axis. 
χ Move the chi axis of crystal goniometer (in degrees). 
φ Move the phi axis of crystal goniometer (in degrees). 

 Move! Perform the move. 
Detector Displays Current positions of detector goniometer axes and allows for re-

positioning of goniometer axes. 
  Dist Move the distance axis of the detector goniometer. Also referred to as the crystal-

to-detector distance (in mm). 
2θ Move the value of 2θ axis of the detector goniometer in degrees). 
Move! Perform the move. 

 
IP Control Tab 
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X-ray Tab 
 

Parameter Description 
IP positioning  

  IP 1* Click one of these buttons to select the IP to be controlled. The current 
position of the IP is displayed. The Move drop down selects a new 
position for the IP. You and also select an Erase or Read operation 
from these drop downs. 

IP 2* 
IP 3* 
IP 4* 

Move! Click button to perform the actual move and selected operation. 
Erase Lamps Display Erase lamps (in seconds). 

  On! Click button to turn Erase lamps on. 

Off! Click button to turn Erase lamps off. 

Manual IP read Make desired changes to the Manual IP read parameters.  

  Read head Specify Read head: 
 Single 
 Twin 

Pixel size Indicates Pixel Size of image to be read. Click the down-arrow to 
change the selection: 

 100x100 
 100x150 
 200x200 

Gain*  Normal 
 High 

Scan area* Displays Scan area. Click the down-arrow to change the selection: 
 Narrow 
 Wide 

Starting line First line in image read. 
Ending line Last line in image read.  
Lines to read Number of lines in image read. 
Filename 

Name of file written for image read. Click the  button to access 
the Open Image File dialog. 

Read! Click the Read! button to complete the read. 
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Parameter Description 
Shutter Control 
  Until manually 

closed 
Shutter remains open until Close! button is clicked. 

Timed X-ray shutter remains open for specified time or until Close! button is 
clicked. Specify time (in seconds). 

Attenuator* Indicates if the Attenuator is placed In or Out of X-ray beam. 
  Move! Click button to complete the Move! 
Beam stop* Indicates if the Beam stop is placed In or Out of X-ray beam. 
  Move! Click button to complete the Move! 
 
R-AXIS II Controls 
 
Parameter Description 
Laser shutter* Click to Open Laser shutter (R-AXIS II) 
Oiler*  
  Rotate* Specifies Counterclockwise or Clockwise rotation of read head. Also 

indicates number of Pulses of oiler (R-AXIS II only). 
Check Oil 
Status* 

Click to Check Oil Status to see if the read head needs to be oiled. 

Oil Read Head* Click to Oil Read Head when necessary. 
Initialize* Initializes the instrument.  
  Erase Plates* If Erase Plates is selected, IP plates are erased during initialization. 
 
* Parameter included only on some instruments. 
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Log File Viewer 

Overview 

 Log files are shown when the various steps are run by the processing suites. However, it is 
sometimes useful to go back to look a specific log file to analyze the processing results. When you click 
this button, a file open dialog comes up and allows you to choose the log file you wish to open. You can 
simply double click this file and it is opened in a viewer that allows you to scroll through the file. 

d*TREK  
      OPERATION      LOG FILENAME 
Find Spots dtfind.log 
Refine Spots dtrefine.log 
Index Spots dtindex.log 
Predict Spots dtpredict.log 
Integrate Reflections dtintegrate.log 
Num Abs Corr   
Merge Reflections dtreflectionmerge.log 
Scale and Average dtscaleaverage.log 
Rank Crystal dtranker.log 
Strategy dtmulitstrategy.log 
Laue Check dtcell_laue.log 
Centricity dtcell_cent.log 
Spacegroup Check dtcell_sgrp.log 

TwinSolve  
      OPERATION      LOG FILENAME 
Find Spots tsFind.log 
Refine Spots tsRefine.log 
Rinal Refine tsFinalRefine 
Index Spots tsIndex.log 
Predict Spots tsPredict.log 
Integrate Reflections tsiIntegrate.log 
Num Abs Corr tsNumabs.log 
Reject & Average tsRejectAverage.log 
Scale & Shape tsScaleShape.log 
Laue Check tsLaueCheck.log 
Spacegroup Check tsSpacegroupCheck.log 
Get Twin Relations tsTwinRelations 
Update Reflection File tsUpdateReflectionFile.log 

 FS_PROCESS  
      OPERATION      LOG FILENAME 
Find Spots prfind.log 
Refine Spots prrefine.log 
Index Spots prindex.log 
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      OPERATION      LOG FILENAME 
Predict Spots prpredictspots.log 
Integrate Reflections printegrate.log 
Num Abs Corr   
Merge merge.log 
Scale scale.log 
Post Refine post.log 
Average average.log 
Peak Search psearch.log 
Refine refosc.log 
Integrate integ.log 
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5. Small Molecule Tasks 

There are two different small molecule modes. Auto mode is designed for automatic data collection, 
processing, and structure solution. It is targeted especially for the SCXmini and XtalLABmini and is only 
enabled for those two instruments. Expert mode is designed for the crystallographer who wants more 
detailed control of the instrument and procedure. In previous versions of CrystalClear what is now Auto 
mode was called SCXmini mode. In CrystalClear 2.0 Expert mode works on any instrument including 
SCXMinin and XtalLABmini. 

Auto mode uses d*TREK to index the cell and then FS_PROCESS to integrate the data. There are four 
different tasks available in Auto mode. 

The four tasks are Screen Collect and Process, Collect and Process, Collect and finally Process  

In Expert mode you have your choice between d*TREK, FS_PROCESS, and TwinSolve to process the 
data. TwinSolve is available under a separate license and is most suited to processing data from twinned 
crystals. You also have the choice of four different tasks.  

This chapter contains quick start guides for Auto mode and Expert mode for d*TREK on a CCD, 
d*TREK on a Rapid, and TwinSolve. 

Auto Mode 

Screen Collect and Process 
The Screen Collect and Process task is used when you want to automate the entire process of collect and 
processing you crystal. The flow bar is shown below. 
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The steps in this flow bar are executed automatically using the default parameters for each step. If you 
want to change these default parameters you can just click the step manually, enter the new parameters, 
and then use the Save button to save the defaults to the desired level. See the section in Chapter 3 on 
Defaults. 

The Mount Crystal step contains the controls for automated processing. This step is just a reminder for 
other modes, but for Auto mode it is critical. Note also that there is no Setup step in Auto mode since a 
simplified version of this is found in Mount Crystal. 

Initialize Instrument. Before you can collect data, the goniometers and detector must be initialized. If 
the instrument is already initialized (e.g., when you opened the sample) you can skip this step. See 
chapter 7 for more details. 

Mount Crystal. This is the key step for automating data collection and processing and since it is very 
different for Auto mode than it is for other mode of CrystalClear, it is documented in this section. 
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Parameter Description 
Size (X, Y, Z) If you already know the size of your crystal, you can just enter it here. If not, 

you may wish to run RaxShape through the View Crystal icon in the top 
toolbar. 

Molecular formula The molecular formula is vital if you intend to go on to structure solution. 
CrystalClear accepts the formulas such as C9H13O5N3. 

Color Color of the crystal. You may enter the color name or use a drop-down list 
which provides predefined colors. The predefined color choices are:  

 •  Blue 
 •  Colorless 
 •  Gray 
 •  Green 
 •  Orange 
 •  Red 
 •  White 
 •  Yellow  

Morphology Specify the Morphology of the crystal. You may enter the name in the 
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Parameter Description 
field, or use a drop-down list which provides predefined morphology 
types. The predefined choices are:  

 •  Block 

 •  Chip 

 •  Chunk 

 •  Platelet 
 •  Prism  

Mount Type of Mount used for the crystal. You may enter the mount type in the field, 
or use a drop-down list which provides predefined mount types. The predefined 
mount choices are:  

 •  Fiber 

 •  Capillary 

 •  Loop 

Initial screen images 
exposure time 

The time you enter here is in seconds and specifies the exposure time for the 
screen images. If you know your crystal is week, you might want to make the 
initial time longer, if it is a very strong diffractor you may want to shorten the 
time. 

Automatic behavior 
options 

Once you click Start, the steps in the flow bar executes automatically. You may 
choose any of three different check points for CrystalClear to stop and allow 
you to examine preliminary results. 

• Stop after screening to check indexing and unit cell information. If 
you want to make sure this is a good crystal before you collect it, you 
may want to put a stop here. This also allows you to change the 
exposure time for Collect. 

• Stop after Scale and Absorption to check processed information. 
You should check this if you do not want to attempt to solve the 
structure automatically or if you would like to check the processing 
results (e.g., Rmerge) before you go on. 

• Display AutoSolve dialog in CrystalStructure. Normally, the 
automatic structure solution proceeds with the default parameters. By 
having it bring up this dialog this effectively stops the automatic 
execution at this point and also allows you to specify different 
parameters for the AutoSolve. 

Start This button starts the automatic execution of the steps in this flow bar. 
Depending what Stop boxes you checked, the data is collected and processed 
automatically unless in encounters and error. 

 

Initial Images. It is usually useful to collect a set of screen images to assess the crystal quality so that you 
can make sure the crystal diffracts and is good enough to warrant data collection. You can also index the 
crystal and use the symmetry information to either manually select the appropriate collection schedule or 
run Strategy to calculate a collection schedule specifically for your sample. See Chapter 7 for a detailed 
description. 

Find Spots. This step identifies spots to be used for indexing. In Auto mode the d*TREK version of this 
step is used. The parameters available are described in Chapter 8. 
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Index Spots. Indexing is also performed by d*TREK in Auto mode. The index parameters are described 
in Chapter 8. There is no explicit Refine step in Auto mode, but FS_PROCESS does an implicit 
refinement of the indexed cell during integration 

Predict Spots. This step predicts and displays reflections. This gives you a visual check that the indexing 
is right, but does not change the state of the sample. Since the integration is done using FS_PROCESS, 
the FS_PROCESS version of Predict Spots is used. 

Collect Images. The collection schedule defaults to three scans that give you a complete data set. If you 
have high symmetry you can remove one or two of these scans. See chapter 7 on Data Collection.  

Integrate Reflections. In Auto mode, FS_PROCESS is used for the integration step. This step is 
described in more detail in Chapter 9. 

Scale and Absorption. This is a FS_PROCESS step as described in Chapter 9. This step also does a Laue 
check, averaging, and a final cell refinement. Note that the default is Numerical absorption correction 
which requires the polygonal cell boundaries from RaxShape. 

Solve Structure. The structure solutions step, which is new to version 2.0, requires that you have 
CrystalStructure 4.0 or above properly licensed and installed. Unless you have checked on the Display 
AutoSolve Dialog in CrystalStructure box, CrystalClear causes CrystalStructure to automatically 
execute the AutoSolve operation. CrystalStructure remains running so that you can examine and further 
process the solved structure. AutoSolve requires at least an approximately correct molecular formula. 

Collect and Process 
The flow bar for Auto mode Collect and Process is shown below 
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In the Auto mode Collect and Process task, there are no screen images and the Initial Images step is 
replaced by the Collect Images step. Thus Find and Index are performed using collected data images 
rather than the initial screen images. Otherwise the steps are identical to the Screen Collect and Process 
steps described in the last section. 

Collect  
The Auto mode Collect task collects with the default schedule. The Auto mode version of the Mount 
dialog is displayed so that you can start this process (see description under Screen Collect and Process). 
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Process 
The Process task in Auto mode is for automatically processing previously collected data. Since there is no 
data collection, it does not have the Auto mode Mount dialog to kick off the automation, but it does have 
its own version of Setup which is described in this section. 

 
 

Setup. In the Auto mode Process task, the Setup step has a special dialog that replaces the normal Setup 
dialog. 
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Parameter Description 
Crystal to detector 
distance 

The distance is taken from the image headers and is provided for informational 
purposes here. It is a read only control and the units are millimeters. 

Detector 2θ The 2θ value is taken from the image header also. It is in degrees. 
Temperature This is a Celsius value for the temperature at which the data was collected.  
Size (X, Y, Z) If you already know the size of your crystal, you can just enter it here. If not, 

you may wish to run RaxShape through the View Crystal icon in the top 
toolbar. 

Molecular formula The molecular formula is vital if you intend to go on to structure solution. 
CrystalClear accepts the formula in a variety of forms. 

Color Color of the crystal. You may enter the color name or use a drop-down list 
which provides predefined colors. The predefined color choices are:  

 •  Blue 
 •  Colorless 
 •  Gray 
 •  Green 
 •  Orange 
 •  Red 
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Parameter Description 
 •  White 
 •  Yellow  

Morphology Specify the Morphology of the crystal. You may enter the name in the 
field, or use a drop-down list which provides predefined morphology 
types. The predefined choices are:  

 •  Block 

 •  Chip 

 •  Chunk 

 •  Platelet 
 •  Prism  

Mount Type of Mount used for the crystal. You may enter the mount type in the 
field, or use a drop-down list which provides predefined mount types. 
The predefined mount choices are:  

 •  Fiber 

 •  Capillary 

 •  Loop 

X-Ray Source These are the X-Ray Generator settings for this sample that may not have 
been entered when the data was collected. So you have another chance to 
enter them. 

Automatic behavior 
options 

Once you click Run, the steps in the flow bar executes automatically. You may 
choose any of two different check points for CrystalClear to stop and allow you 
to examine preliminary results. 

• Stop after Scale and Absorption to check processed information. 
You should check this if you do not want to attempt to solve the 
structure automatically or if you would like to check the processing 
results (e.g., Rmerge) before you go on. 

• Display AutoSolve dialog in CrystalStructure. Normally, the 
automatic structure solution proceeds with the default parameters. By 
having it bring up this dialog this effectively stops the automatic 
execution at this point and also allows you to specify different 
parameters for the AutoSolve. 

Run This button starts the automatic execution of the flow bar. Depending on the  
Stop boxes you checked, the data is collected and processed automatically 
unless an error is encountered. 

Once you have click Run, the rest of the steps are executed automatically until the processing is 
completed unless an error occurs. The processing steps are the same as described in Screen Collect and 
Process for this section. 

Auto Mode Quick Start Guide 

 Parameters 
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The values given for various parameters are suggestions, and may not be appropriate for all samples. Feel 
free to adjust certain parameters in order to evaluate their effect on the results. For parameters not listed 
here, start with the default values.  

Getting Started 
• Check the X-ray power settings with the JXG program.  
• Check that both of the green LEDs next to the detector are on. If the power to the detector has been 

off, the second LED does not light until the CCD temperature has reached the set point (-40°C). 
The instrument cannot be used until this is reached.  

• If a low-temperature device is attached, check the temperature and flow rates.  
• Start CrystalClear, check the New sample box and enter a name for your sample. Select Screen 

Collect and Process as the Task, and press OK.  
• Press Yes to initialize the instrument.  
• WARNING: The Door open button must be pressed and the warning beeper heard before the door 

is opened. Failure to do so cuts the power to the X-ray generator. Close the door smoothly and 
firmly to avoid accidentally engaging this fail-safe feature.  

Setup 
Enter the molecular formula and check the temperature, color, etc. in the various fields in the Setup 
dialogue. (The “size” fields can be skipped for now.) The Start RAXShape box should be checked. The 
Run button starts the video camera and crystal-centering routine.  

Crystal Centering and Shape Measurement 
Mount the crystal while watching the video screen to get the sample close to the center, then adjust the x, 
y, and z translations until the center of mass of the crystal no longer moves when rotated. The video 
output can display circles (CTRL-M) that are helpful. See the RAXShape Quick-start Guide for details.  

Initial Images 
Adjust the exposure time for the screening images: larger/better crystals require less time than 
smaller/poorer crystals. Exposure times can be as small as 2 seconds and as long as 300 seconds. The 
default screen scan creates only 6 images; for crystals that produce very few reflections per image, more 
images may be required. The Step is the number of degrees skipped between images, and if more images 
are required then the step can be reduced. (If the Step is not visible, right-click one of the column 
headings, and select Step so that the column is visible.) Images can be re-collected by changing the 
numbers in the Scheduled column.  
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The next few steps (under Assign Unit Cell) occur in succession without stopping. To stop at each step, 
click the small arrow between the steps in the flow bar; the arrow changes to a stop sign and the next step 
does not execute automatically. You can still run the next step just by clicking on the button. 

Find Spots 
The Find Spots step normally run automatically. By default the screen images are used and the Find 
Spots routine attempts to locate all reflections having I/σ(I) greater than 5.0. For very weak samples it 
may be necessary to reduce this value to 4 or even 3. For very strong samples, larger values (10 to 25) 
may be used to filter out spurious reflections.  

Index Spots 
This step is also automatic. The default parameters give good results for good crystals. If you suspect a 
very long axis, change the “Max cell length” (on the Advanced tab) to 100. Beam check and Deice 
should not be checked. For troublesome samples try using the Diffs option. A higher I/σ(I) value may be 
selected here as in the previous step (but a value lower than the one used in Find Spots is not useful).  

Predict Spots 
This step simply allows you to visually verify that the indexed unit cell accurately predicts the positions 
of all (or most) of the reflections. For poor/twinned/split crystals, there may be a number of spots that are 
not predicted, but in many cases the correct unit cell has actually been found and the reflections that are 
from satellite crystals or minor twin components can be safely ignored (although the structural results 
from such samples cannot be expected to be of high quality). In case most of the spots are not correctly 
predicted it is likely that the crystal is badly twinned, or split (or suffers from a serious problem such as 
modulation), and the results of the indexing are wrong. In these cases a search for a better sample is 
warranted.  
 
Step through the images with the green arrows at the top of the image viewer window (not the ones above 
them in the main toolbar). By default, predictions are only produced for the first 5 images; you may select 
more images by opening the Predict Spots dialog. Use the zoom tool (or just right-click and drag on an 
area in the image) to get a closer look at the reflections. The contrast tool may also be useful for looking 
at higher resolution spots. Use the Reset Local Contrast button to refresh the contrast level.  

Collect 
The Collect dialog is similar to the Initial Images dialogue. Only the exposure time needs to be adjusted; 
other adjustments are optional. The default scans (three sets of 180 images) produce an almost complete 
sphere of data (i.e. a redundant triclinic data set). The safest strategy is to collect all three scans. However, 
monoclinic and orthorhombic data sets need no more than the first two scans, and tetragonal and higher-
symmetry lattices need only one scan. As before, exposure time can be as low as 2 seconds per image and 
as high as necessary to produce observed data to a high resolution. (Note that exposure times longer than 
300 seconds may not be useful.) To remove a scan, highlight the scan with a mouse click the row, then 
press the Delete Scan button.  

Integrate Reflections 
The Integrate Reflections and the Scale and Absorption steps run automatically when the image collection 
finishes unless the stop sign has been inserted after Collect. The default resolution limit for integration is 
0.77Å (or 2θ = 55° with Mo radiation). If a higher or lower resolution limit is desired this can be changed 
before the integration step starts, or the integration step can be run again with new parameters. Note that 
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resolution arcs can be displayed on any image by selecting View → Resolution Arcs. Possible changes to 
the default parameters are discussed in the Common problems section below.  

Scale and Absorption 
The Scale and Absorption step is actually a large number of steps combined into one menu. Several 
scale factor refinements, a Laue group check, an absorption correction, a final cell refinement and the 
output of intensity data are all included. Parameters for each step are set in sub-menus, but the default 
values are used in the automatic procedure. The user should look through the log file that is created, 
paying attention especially to the section headed by the title Laue Class. When this step finishes, a 
summary of the results appears; if the Accept button is pressed the automatic structure solution step 
starts. The Common problems section below suggests alternate parameter values for difficult cases.  

 

Common Problems and Possible Solutions 
During Integration:  

• Note that all data sets are handled as Laue class -1 (triclinic) during the integration step. Even when 
the symmetry seems obviously higher, the -1 Laue class should be used at this point.  

• If you notice that a lot of the integration boxes are overlapped by adjacent boxes during integration 
(common when the unit cell has one or more long axes), it is necessary to change the behavior of 
the automatic box size routine. This problem often leads to very low values of completeness since 
many reflections are rejected (the ideal value for completeness is 100%). On the Advanced tab of 
the Integrate Reflections dialogue, the integration box size can be changed from Auto to Fixed 
and the x and y dimensions specified explicitly. To determine an appropriate box size, run the 
Predict Spots step, then press the Set Reflection Size button on the toolbar. Different values can 
be tried and then set so the box size is slightly larger than the reflection size. You may want to 
use the measure pixels tool to estimate spot size. 

 
During Scale and Absorption:  

• If this step fails at the very beginning with a Scale failed message, bring up the dialogue and 
uncheck the first Scale check box (third check box from the top in the Programs section). This 
error occurs because the first scaling step uses only -1 symmetry and shorter data sets (one scan) 
may not contain enough Friedel opposites for scaling.  

• The Laue check commonly reports a Laue group that is of lower symmetry than expected. Carefully 
inspect the Laue Check section of the log file. The Laue class is determined by choosing the class 
that provides a low R

merge 
value. The default cutoff is 15%. (R

merge 
is the agreement index for 

symmetry-related reflections and is therefore different for each possible Laue group.) You may 
notice that a particular Laue group actually passes the R

merge 
test but is still rejected. This is 

usually because one of the symmetry checks fails the Correlation check. The default minimum 
correlation is 0.95; inspect the table in the log file to look for problems — especially an operation 
that passed the R

merge 
test but has a correlation of something just less than 0.95. You can change 

the minimum correlation value on the Advanced tab of the dialogue (in the Laue section) and run 
the step again.  

Expert Mode using d*TREK 
In Expert mode you have full control of the instrument and the processing procedure. In most cases when 
one step completes the next step’s dialog is popped up automatically so that you can just fill in the desired 
parameters and run that step. If you want to skip that step or go back to a previous step, you just have to 
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click the step you want to run and it automatically closes the open dialog and open the dialog for the new 
step. 

The d*TREK processing suite is best suited to narrower images (e.g., under 2 degrees). It has a separate 
step for refining the orientation matrix values, unit cell parameters, and detector offsets. There is also a 
Strategy step which computes and optimizes collection schedule. 

Screen Collect and Process 
The Screen Collect and Process task is used when you want to collect and process a data set in one 
session. It is possible to integrate the data as it is being collected. 

The flow bar for this task is fairly complex, so we break it down into two parts. The first part covers 
through Strategy and the second part covers from Collect Images on. 
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Initialize Instrument. Before you can collect data, the goniometers and detector must be initialized. This 
can also be done when the sample is opened or through the Manual Instrument Control. If the instrument 
is already initialized you can skip this step. See chapter 7 for more details. 

Setup. This step allows you to specify information about the sample. If you are just starting to use this 
instrument, you should check the X-Ray Source tab to make sure that it is right. If it is not, you should set 
the values appropriately and then click Save to Config. See chapter 7 for more details. Setup is 
particularly important for small molecule work. Many of these values go into your CIF. But most 
importantly, you must have a valid molecular formula for structure solution. 

Mount Crystal. This is really a pseudo step to remind you to mount the crystal and lock down phi. Once 
you have done this click OK and go on to Initial Images. 

Initial Images. It is usually useful to collect a set of screen images so that you can make sure the crystal 
diffracts and is good enough to warrant collection. You can also index the crystal and use the symmetry 
information to either manually select the appropriate collection schedule or run Strategy to automatically 
determine an optimized collection schedule. You need to collect enough screen images to allow the 
processing software to index. For d*TREK this means that you need a few dozen spots. See Chapter 7 for 
a detailed description. 

Find Spots. This step identifies spots to be used for indexing. The parameters available are described in 
Chapter 8. 

Index Spots. Indexing determines the cell parameters and metric symmetry. If you know what the cell 
should be, this can be a good check that this is a good crystal. This also gives you a reasonability check. If 
the cell parameters do not make sense, it is an indication that something is wrong. The parameters for 
indexing are described in Chapter 8. 

Refine Primitive Cell. For small molecule work, refinement proceeds in two stages. The first step refines 
the primitive triclinic cell. This uses the standard refinement step described in Chapter 8, but with 
parameters setup for refining the primitive triclinic cell. 

Reduce Cell. After the initial primitive cell refinement, the next step is to reduce the cell. The dialog for 
doing this is shown in Chapter 8. 

Refine Standard Cell. Once the cell has been reduced, the second stage of refinement is performed. This 
is the same dialog as shown in Refine Primitive Cell, but the defaults are setup differently and it now 
works on the standard cell. 

Predict Spots. This step predicts and displays reflections. This gives you a visual check that the indexing 
is right, but does not change the state of the sample. 

Strategy. Strategy suggests a collection schedule based on the cell parameters and symmetry and 
completeness and redundancy requirements provided through the interface. If you prefer to specify the 
collection schedule manually, you can skip this step. Strategy is only available for the d*TREK suite and 
is documented in Chapter 8. 

The second part of this flow bar is shown below. 
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Collect Images. This step performs the actual data collection. If you have run Strategy, the results of that 
step is a strategy collection schedule. Alternately, you can select and edit other collection schedules. If 
you are using the d*TREK processing suite, you can start the Integrate Reflections step as soon as the 
Collect Images step has started. The details for this step are in Chapter 7.  

Integrate Reflections. This can either be done while the images are being collected or after collection has 
finished. Chapter 8 provides the details for the parameters that control integration. 

These next three steps are optional steps to check the cell symmetry of the diffraction pattern and 
determine the space group using the integrated data.  

Laue Check. This step checks the Laue group. See Chapter 8. 

Centricity Check. See Chapter 8. 

Space Group Check. See Chapter 8. 

Num Abs. Correction. This step makes a numerical absorption correction and prepares the data for Scale 
and Average. This type of correction requires the shape of the crystal to have been saved through 
RAXShape. See Chapter 8. 

Scale and Average. The scale and average step scales and averages the data and may be used to carry out 
a multi-scan absorption correction. It creates a reflection file that can then be used in structure solution. 
See Chapter 8. 

Final Refine Cell. In small molecule work it is customary to do a final cell refinement after the data has 
been scaled. This brings up the standard refinement dialog, but with the defaults set for a final refinement. 

SolveStructure. Structure solution is performed through CrystalStructure and requires a CrystalStructure 
license. This step starts up CrystalStructure and brings up the AutoSolve Dialog. AutoSolve requires a 
molecular formula, so if you have not entered one, you are prompted to do so at this stage. See the 
CrystalStructure User Manual for information on running AutoSolve. 
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Collect and Process 
This task replaces the Initial Images step with the Collect Images step and you then index and refine on 
some or all of the collected images. 

 
With the exception of the replacement of Initial Images with Collect Images, these steps are identical to 
the steps in Screen Collect and Process. The final steps in this process are also the same, so please refer 
to the previous section or directly to Chapter 8 for more details. 
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Collect 
The collect task is the same regardless of the processing suite. This task does not offer the Strategy step 
since you have not yet indexed. 

 

 
 

Process 
Once you have collected your data, you can either go back into the sample and change it to a Process 
(sometimes referred to as process only) task, or you can create a new process only sample which refers to 
the images you collected in another sample (or on another instrument). 
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These processing steps are identical to the processing steps in Screen Collect and Process. You can refer 
to that section of this chapter or to Chapter 8 for more details. 

d*TREK Quick Start Guide for CCD 

Parameters 
The values given for various parameters are simply suggestions, and may not be appropriate for all 
samples. Feel free to adjust certain parameters in order to evaluate their effect on the results. For 
parameters not listed here, start with the default values. Note that if a non-zero value is entered for either 
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min or max resolution, then the other value must also be non-zero. CrystalClear takes care of this 
automatically. 

Setup 
Main:  

• check that crystal-to-detector and detector 2θ are correct.  
 
Crystal1:  

• Molecule type = Small  
 
Detector:  

• Check that Direct Beam is correct  
 
X-ray Source:  

• Check that the Element type (wavelength) is correct  
 

Find Spots 
Main:  

• Use either the screening images or at least 20° of images from the first scan. A double-click in one 
of the To Use fields makes that field editable. A double-click in one of the Available fields 
selects that entire scan.  

• I/Sigma = 5.0  
 
Advanced:  

• Minimum pixel value = 100.0  
• Find beam center unchecked  
• Incl. saturated spots checked  
• Det’n. strong peak info unchecked  

 

Index Spots 
Main:  

• User chooses solution checked  
 
Advanced:  

• Deice unchecked  
• Beam check unchecked  
• Max. Residual = 0.01. This should result in only one (primitive triclinic) solution.  

 
Indexing notes: if the source is very strong and/or the crystal scatters extremely well, a few λ/2 spots may 
appear at low resolution. If these end up in the find-spots list, indexing may give the wrong cell. Try 
using only higher-resolution reflections for indexing if necessary.  

Refine Primitive Cell 
If the cell has been saved as triclinic, the angles are allowed to refine. By default, the refinement is done 
On images, using the same images on which indexing was done. This should work well, and the cell 
parameters should converge to values that reflect the true cell symmetry. The mosaicity often goes to 
some unreasonable value here, but it should not affect the results. If a Warning box appears, it is because 
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one or more values have shifted by more than some expected amount; this is usually OK - you can slide 
the warning message over and take a look at which values differ greatly from their starting values.  
 
When refining On images, d*TREK uses the current orientation matrix to predict where spots should 
appear on each image. If a good reflection is found, its centroid is saved. You should press Run at least 
twice. Note the number of reflections Accepted (near the top right corner) after the first time. The number 
should increase the second time, as the "better" orientation matrix allows the program to find more good 
spots the second time. To selectively turn refinement parameters on or off, change Macro to Single Step 
Refine. For sealed tube sources all source rotations should be off. When convergence is reached, press 
the Close button.  

Reduce Cell 
This step searches for higher metric symmetry. If the cell is especially poor, you may need to raise the 
value of Max. Residual (try 1.0) and press the Reduce Cell button. (Note: Be careful about choosing a 
cell of higher symmetry. If there is any uncertainty, it is better to choose a lower symmetry at this point 
and ensure that a complete dataset is collected. You will verify the Laue group after integration, at which 
time you will know the correct symmetry.)  

Refine Standard Cell 
Run Refine once again; the cell dimensions are constrained by the saved crystal system. The final values 
in the Δ/σ row should be very low for each parameter. Note that you may also use the first few images 
from any scan for refinement.  

Predict 
Close the Refine dialogue and press Predict Spots. If the mosaicity shown is less than 1.0 or appreciably 
greater than 1.0, set it to 1. The first 10 images or so should be enough to check that the cell and detector 
corrections are appropriate. Step through the images with the green arrows. Use the zoom tool (or just 
right-click and drag on an area in the image) to get a closer look at the reflections. The contrast tool may 
also be useful for looking at higher resolution spots.  

Create a Mask 
Using any image that shows the beam stop shadow, reduce the High level of the contrast so that the 
shadow of the beam stop is obvious. Use the circle tool to draw a radius representing the beam stop (See 
Chapter 4). If you don't like it, use the Undo last erasure tool (two buttons to the right of the circle tool) 
to undo the erasure. Use the quadrangle eraser to remove the shadow of the beam stop arm; you get four 
clicks, each one defining a corner of a quadrilateral. Use the quadrangle eraser more than once to define 
oddly-shaped shadows. You can clear the erasures and start over by just clicking one of the green arrows 
to move to the next image. Click the Write Mask File button to save the mask file. If all images were 
collected at the same 2θ and distance, click Yes for Use... for all scans?  If a set of images were collected 
at high 2θ swing (no beamstop shadow) these scans should have the mask file set to FirstScanImage.  

Integrate Reflections 
Main:  

• All of the data collection images should be selected by default.  
• Set min and max resolution if desired; otherwise leave at 0.0. Resolution arcs can be superimposed 

on the image by using View → Resolution arcs.  
• Box width and height = 0 (determined automatically)  
• Padding = 1  
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• Images per batch: Scaling = 1. For Refinement, choose a number of images that represents about 15 
degrees of omega rotation (i.e. for 0.5deg images, use 30).  

 
Advanced:  

• Profile analysis ON, Num refl=20, Max images = 10  
• Refinement macro = Most  
• Find refls before... OFF  
• Refine before integration: Macro = Most; Images = 3 refine batches (i.e. 3 batches of 15° to give 

about 45° of refinement before integration).  
• Mosaicity model Off.  

 
Note: During integration, the cell is refined and updated using the number of images determined by 
(Images per batch) times (no. refine batches). These should be adjusted, depending on the number of 
degrees per image, to represent 30 to 60° of data. These are used for local refinement of the cell during 
integration. These should be adjusted depending on the size of the cell. Integration of each scan starts 
with a prerefine using these parameters.  
 
In order to monitor the log file as it is updated, you can turn off the image processing updates with the 
View Image Processing Updates button (or on the menu bar: View → Image Processing Updates).  

Laue Check 
• Set Maximum Residual to 1.  
• If this fails miserably, select the Laue group that you "know" to be correct and continue.  
• IMPORTANT: If the Laue check results in a cell transformation, the new reflection list is called 

'dtcell.ref'. Be SURE to use this file for the next step.  

Numerical Absorption Correction 
If you have used the RAXShape utility to save a model of the shape of the crystal, you have a shape.dat 
file in the current sample directory. Enter the molecular formula for the compound; press the Tab key and 
the expected Z value is shown. Enter the correct (usually integer) Z value and press Run. The corrected 
file is called dtnumabs.ref. Be sure

Scale and Absorption 
Main:  

• Input reflection file: dtprofit.ref (unless as changed above).  
• B Factor unchecked. Batch scale and absorption correction checked.  
• Absorption correction method: Spherical 4,3 (may also try 'Fourier' method)  
• Exclude sigma for refinement = 5 (adjust as necessary for strong or weak crystals)  
• Scale anomalous I+ and I- separately unchecked  
• Usually output is Uncorrected, unaveraged reflections, with correction factors, and the output 

file name is f2plus.dat  
• Error model = (multiplier: Explicit, 3.0; addend: Explicit: 0.0)  

o Note: Try Auto error model to get an idea for a realistic value for the multiplier and/or 
addend values. Note how I/σI, Chi2 and Rmerge are affected by the variations in the error 
model.  

 
Advanced:  

• Rebatch unchecked.  
• Restrain batches checked, set parameter to 0.005.  

 to use this file for the input to the next step if you want to use the 
absorption-corrected data.  



4. Small Molecule Tasks 
 

 

5-22 CrystalClear User Manual 

 
HINT: Click the arrow between the Scale and Absorption button and the Final Refine Cell button: it 
changes to a stop sign. Now the refine dialogue does not appear automatically after this step. This is 
useful since we often run the Scale and Absorption step multiple times. Just click the Final Refine Cell 
button when you are ready to run this step. 
 

Final Refine Cell 
• At this point, a final cell refinement is done using the integrated data from ONE of the scans.  
• For Reflection list, data from the first scan (dtprofit1.ref) are used by default. Another scan may be 

chosen, i.e. dtprofit2.ref, etc.  
• Press Run; this may take a while since a large number of data are being included  

 
The final cell refinement uses (by default) the reflections from the entire first scan (dtprofit1.ref). If 
another scan is larger (contains more reflections) choose the appropriate dtprofit'n'.ref as the reflection 
file.  
 
At the end of the Final Refine Cell CrystalClear writes the CrystalClear.cif file, which contains the cell 
and data collection parameters for transferring to the structure solution program.  
 
When done, a lot of unnecessary files can be removed with the File → Purge files function.  
Only two files are needed to use the CrystalStructure software: CrystalClear.cif and f2plus.dat. Starting in 
CC2.0, these files are automatically copied into a structure subdirectory.  

Notes 
o The size of the blue circles is arbitrary (does not signify integration area); the size can be changed 

to improve visibility with the Set Reflection Size button.  
o If the Refine Cell dialogue is brought up during integration, the values are updated as refinement 

continues during integration.  
o The JDTPlot utility is a very nice way to analyze the results of the integration and Scale and 

Average routines. In order to enable this utility, install the Java run-time environment available 
from http://java.sun.com/j2se/1.4.2/download.html Use Tools → Preferences → ScaleAverage 
Plots to select JDTPlot. Uncheck the Prompt before box to allow automatic display of the plots. 
The plots can be generated anytime after running Scale and Average from the menu View → 
Scale/Average Plots.  

d*TREK Quick Start Guide for Rapid 
This quick start guide runs through an example that was done with three scans, all scanning omega, 5° per 
image. For any parameters not listed, the default was used. Note that for wide sliced images 
FS_PROCESS to TwinSolve often product better results than d*TREK. 
 
Scan 1: χ=0, φ=0, ω 20 to 200  
Scan 2: χ=54, φ=0, ω 20 to 200  
Scan 3: χ=54, φ=90, ω 20 to 200  

Setup 
Main:  

• check that crystal-to-detector is shown as 127.4mm and detector 2θ = 0  
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Crystal1:  

• Molecule type = Small  
 
Detector:  

• Check that Direct Beam is correct  
 
X-ray Source:  

• Check that the Element type (wavelength) is correct  
 

Find Spots 
Main:  

• Use either the screening images or at least 30° of images from the first scan. A double-click in one 
of the To Use fields makes that field editable. A double-click in one of the Available fields 
selects that entire scan.  

• I/Sigma = 5.0  
 
Advanced:  

• Minimum pixel value = 20.0  
• Find beam center unchecked  
• Incl. saturated spots checked  
• Det’n. strong peak info unchecked  

 

Index Spots 
Main:  

• User chooses solution checked  
 
Advanced:  

• Deice unchecked  
• Beam check unchecked  
• Max. residual = 0.01. This should result in only one (primitive triclinic) solution.  

 
Indexing notes: if the source is very strong and/or the crystal scatters extremely well, a few λ/2 spots may 
appear at low resolution. If these end up in the find-spots list, indexing may give the wrong cell. Try 
using only higher-resolution reflections for indexing if necessary.  

Refine Cell 
If the cell has been saved as triclinic, the angles are allowed to refine. By default, the refinement is done 
On images, using the same images on which indexing was done. This should work well, and the cell 
parameters should converge to values that reflect the true cell symmetry. The mosaicity often goes to 
some unreasonable value here, but it should not affect the results. If a warning box appears, it is because 
one or more values have shifted by more than some expected amount; this is usually OK - you can slide 
the warning message over and take a look at which values differ greatly from their starting values.  
When refining On images, d*TREK uses the current orientation matrix to predict where spots should 
appear on each image. If a good reflection is found, its centroid is saved. You should press Run at least 
twice. Note the number of reflections "Accepted" (near the top right corner) after the first time. The 
number should increase the second time, as the "better" orientation matrix allows the program to find 
more good spots the second time. To selectively turn refinement parameters on or off, change Macro to 
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Single Step Refine. For sealed tube sources all source rotations should be off. When convergence is 
reached, press the Close button. 
  
The Reduce Cell step searches for higher crystallographic symmetry. If the cell is especially poor, you 
may need to raise the value of Max residual (try 1.0) and press the Reduce Cell button. (Note: Be careful 
about choosing a cell of higher symmetry. You will verify the Laue group after integration, at which time 
you will know the correct symmetry.)  
 
Run Refine once again; the cell dimensions are constrained by the saved crystal system. The final values 
in the Δ/σ row should be very low for each parameter. Note that you may also use the first few images 
from every scan for refinement.  
 
Close the Refine dialogue and press Predict Spots. The first 5 images or so should be enough to check 
that the cell and detector corrections are appropriate. Step through the images with the green arrows. Use 
the zoom tool (or just right-click and drag on an area in the image) to get a closer look at the reflections. 
The contrast tool may also be useful for looking at higher resolution spots. If the mosaicity is much 
different from 1.0, you may get better results if you set it to 1.0.  
 

Create a Mask Image 
Using any image, reduce the High level of the contrast so that the shadow of the beam stop is obvious. 
Use the circle tool to draw a radius representing the beam stop. If you don't like it, use the Undo last 
erasure tool (two buttons to the right of the circle tool) to undo the erasure. Use the quadrangle eraser to 
remove the shadow of the beam stop arm; you get four clicks, each one defining a corner of a 
quadrilateral. Click the Write Mask File button to save the mask file. Click Yes for Use... for all scans? 

Integrate Reflections 
Main:  

• All of the data collection images should be selected by default.  
• Set min and max resolution if desired; otherwise leave at 0.0 (Note: if a non-zero value is entered 

for either min or max, then the other value must also be non-zero.) Resolution arcs can be 
superimposed on the image by using View -> Resolution arcs.  

• Box width and height = 0 (determined automatically)  
• Images per batch: Scaling = 1, For Refinement, choose a number of images that represents about 

15° of omega rotation (i.e. for 5° images, use 3).  
• Padding = 0  

 
Advanced:  

• Profile analysis ON, Num refl=20, Max images = 7  
• Refine before integration: Macro = Most; Images = 3 refine batches (i.e. 3 batches of 15° to give 

about 45° of refinement before integration).  
• Mosaicity model: Mult=1, Add=1. This parameter setting depends somewhat on the image width. If 

image width is more than 5°, then use Add=2. For images of 1° or less, turn off mosaicity model.  
 
Note: During integration, the cell is refined and updated using the number of images determined by 
(Images per batch) times (no. refine batches). In the above paragraph, this is 3x3, so 9 images, 
representing 45° of data, are used for local refinement of the cell before integration. These should be 
adjusted depending on the size of the cell. Integration starts with a prerefine using these parameters.  
In order to monitor the log file as it is updated, you can turn off the image processing updates with the 
View Image Processing Updates button (or on the menu bar: View → Image Processing Updates).  
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When integration is finished, the actual integration ellipses are superimposed on the images of the final 
scan. These can be useful for evaluation of the quality of the integration.  

Laue Check 
• Maximum Residual = 1.  
• If this fails miserably, select the Laue group that you "know" to be correct and continue.  
• NOTE: If the Laue check results in a cell transformation, the new reflection list is called 'dtcell.ref'. 

Be sure to use this file for the next step.  

Numerical Absorption 
If you have used the RAXShape utility to save a model of the shape of the crystal, you have a shape.dat 
file. Enter the formula for the compound; press the Tab key and the expected Z value is shown. Enter the 
correct (usually integer) Z value and press Run. The corrected file is called dtnumabs.ref. Be sure to use 
this file for the input to the next step if you want to use the absorption-corrected data.  

Scale and Absorption 
Main:  

• Input reflection file: dtprofit.ref (unless as changed above).  
• Batch Scale checked. B Factor unchecked. Absorption correction Checked.  
• Absorption correction method: Spherical 4,3  
• Exclude sigma for refinement = 5  
• Error model = Auto, also try explicit values (start with multiplier = 3 and addend = 0)  
• Scale anomalous I+ and I- separately unchecked  
• Output: Uncorrected, unaveraged reflections with correction factors  
• Output name: f2plus.dat (Alternatively, output SHELX data directly)  

 
Advanced:  

• Rebatch unchecked  
• Restrain batches checked, use a value of 0.005.  

 
Also may want to try without batch scaling. Compare the results and decide which is better. (If you did a 
numerical correction, change the selection to dtnumabs.ref as the input file.) See the notes below 
regarding the plots that are generated. 
  
HINT: Click the arrow between the 'Scale and Absorption' button and the 'Final Refine Cell' button: it 
changes to a stop sign. Now the refine dialogue does not appear automatically after this step. This is 
useful since we often run the Scale and Absorption step multiple times.  

Final Cell Refinement 
• At this point, a final cell refinement is done using the integrated data from one of the scans.  
• For Reflection list, data from the first scan (dtprofit1.ref) are used by default. Another scan may be 

chosen, i.e. dtprofit2.ref, etc.  
• Press Run; this may take a while since a large number of data are being included 
 

At the end of the Final Cell Refinement a CIF file is automatically created. 
 
A lot of unnecessary files can be removed with the File → Purge files function.  
Only two files are needed to use the CrystalStructure software: texray.inf and f2plus.dat. These files are 
automatically put into the Structure directory. 
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NOTES:  
o The size of the blue circles is arbitrary (does not signify integration area); the size can be changed to 

improve visibility with the Set Reflection Size button.  
o If the Refine Cell dialogue is brought up during integration, the values are updated as refinement 

continues during integration.  
o The JDTPlot utility is a very nice way to analyze the results of the integration and 'Scale and 

Average' routines. In order to enable this utility, install the Java run-time environment available 
from http://java.sun.com/j2se/1.4.2/download.html 

Expert Mode using FS_PROCESS 
The FS_PROCESS (for Fine Slice PROCESS) is suitable both for narrow and wider images. There is no 
separate Refine Cell step. There is no strategy available and the Laue check and other cell operations are 
options within the Scale and Average step. 

Choose the Java Runtime Environment (JRE) 
component - "allows end-users to run Java applications". Download and install this package. 
Back in CrystalClear, use Tools → Preferences → ScaleAverage Plots to select JDTPlot. 
Uncheck the "Prompt before..." box to allow automatic display of the plots.  

 

Screen Collect and Process 
The collection steps are the same regardless of the processing suite, but the processing steps are different. 
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Intialize, Setup, Mount Crystal, Initial Images, and Collect Images are all the same as for d*TREK 
and are described in Chapter 7. Note that there is no Strategy step available in FS_PROCESS so the 
collection schedule must be selected and edited manually. 

Find Spots. FS_PROCESS has a separate Find Spots step which is described in Chapter 9. The dialog 
and parameters are different than for d*TREK. 

Index Spots. For FS_PROCESS Index Spots also includes refinement, so there is no separate refinement 
step. The details are in Chapter 9. 

Predict Spots. FS_PROCESS also has its own predict step. See Chapter 9 for the FS_PROCESS predict 
details. 

Integrate Reflections. FS_PROCESS integration cannot be run until the Collect Images step has 
completed. See Chapter 9 for details on the FS_PROCESS integration dialog. 

Scale and Average. The Scale and Average step is also different in FS_PROCESS. It includes Laue 
check and other cell operations that are separate steps in d*TREK. See Chapter 9. 
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Collect and Process 
In this task the Initial Images step is replaced with the Collect Images step and since there are no screen 
images, you index and refine on some or all of the collected images.  

 
 

These steps are described in the previous section. 

Collect 
The collect task is the same regardless of the processing suite. This task does not offer the Strategy step 
since you have not yet indexed. 
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Process 
Once you have collected your data, you can either go back into the sample and change it to a Process 
(sometimes referred to as process only) task, or you can create a new process only sample which refers to 
the images you collected in another sample (or on another instrument). 

 
 

Expert Mode using TwinSolve 
TwinSolve is available under a separate license for processing twinned crystals. Most installations of 
CrystalClear for customers doing small molecule work include a TwinSolve license. If you don’t see a 
Swedish flag in the toolbar between the American and Japanese flags, you should contact your Rigaku 
support person to see about getting a TwinSolve license or getting your existing license activated. There 
must be a TwinsolveLicense.lic with the proper key in your installation directory. 

TwinSolve is most often run as a process only sample once you suspect that your crystal is twinned. The 
other tasks are available in CrystalClear for completeness, but since they are seldom used, the focus is on 
the Process task. 
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If you do want to collect in TwinSolve mode, you can refer to the collection steps in the d*TREK mode 
for additional description of these tasks. 

Process 
Once you suspect your crystal is twinned, you may want to open a new process only sample using the 
TwinSolve processing suite. This automatically puts you in the Process task where you see the following 
flow bar. The details for each TwinSolve step and general information on TwinSolve are presented in 
Chapter 10. 
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Setup. TwinSolve uses the standard Setup step described in Chapter 7. 

Find Spots. In TwinSolve you should usually select a large number of images (often the whole data set) 
for the find. 

Index Spots. This step search indexes the major twin component and then removes those reflection from 
the found spots. You should repeat the Index and Refine steps for every twin component of your crystal. 

Refine Cell. TwinSolve has a separate refine step that should be repeated for every indexed twin 
component. 

Predict. Once you have indexed and refined the twin components, you use the Predict step to see if the 
predicted reflections match up with the spots. 

Integrate Reflections. TwinSolve integrates each twin component in a single step. 

Laue Check. In TwinSolve this is a separate step 

Space Group Check. The TwinSolve space group check along with these other steps is document in 
Chapter 10. 

Num. Abs. Correction. TwinSolve does numerical absorption correction in this step. 

Scale and Shape. TwinSolve adds shape analysis to the scaling procedure. 

Reject and Average. TwinSolve separates rejection of bad reflections and averaging into a separate step. 

Final Refine Cell. At the end of the process, TwinSolve does a final cell refinement. 

TwinSolve Quick Start Guide 
This is a short overview with useful information to allow you to get started. However, to get the full 
benefit of TwinSolve, you really should take the time to read the details in Chapter 10 along with the 
TwinSolve interactive manual. 

1. Start with a complete set of images before starting TwinSolve (TS). It is best if multiple scans 
have been collected, each involving rotation about a different direction through the crystal (for 
example, one scan with χ=54°, φ=0° and a second scan with χ=54°, φ=90°). 

2. For the Find Spots step, use the entire set of data collection images (except screen images). It 
may be useful to examine a few images very closely before starting here in order to set the Peak 
threshold minimum counts. Use a Sigma (this is I/sigma(I)) of 5 or 6 here. Zoom in on a few 
spots and look at the max. counts/pixel to determine whether the “minimum” value in the Peak 
threshold box is appropriate. After the Find Spots step is finished, the first image should be 
displayed with the found spots circled (SCXmini: see Note 1), if processing updates are enabled 
(View → Image Processing Updates checked, or associated button on the toolbar enabled). Step 
through the first few images to see whether Find Spots has detected a reasonable number of 
reflections. If powder rings exist, the program may detect hundreds or thousands of reflections 
within the rings; in this case re-run with the Sigma values increased and/or a higher Peak 
threshold minimum counts, or set the 2θ limits (Sample → Set Resolution… or Set 
Resolution Limits icon on toolbar) to use only those reflections above the 2θ of the powder 
rings. 

3. Index - normally just use all defaults here. Use Quick search with 90%. If you know that there 
are spots which are very close together, you may need to decrease the 'hkl deviation' value to 
something less than the default 0.2 (like 0.1). [NOTE - even if the first indexing results look 
wrong, go ahead and refine the cell to improve the detector corrections. This wrong twin 
component can be deleted later.] Input: oriref.xor. 

4. Refine - Normally should not check the Constrain unit cell according to symmetry box until 
the crystal system is definite. After refinement the program asks Transform to the conventional 
cell? If you say yes, the program looks for a higher symmetry cell and offers to change it for you. 
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In the current version you can only accept or reject the suggestion in this version of the program. 
This is a problem if you have something that is close to higher symmetry but not quite. There is 
an interactive mode that includes much more flexibility in what you can do with the cell, etc. 
Eventually you may want to learn some of the extended commands. Input: oriref.xor 

5. Once the refinement is done, look at the last line printed in the refinement log printed to the 
screen. It shows the number of reflections assigned to the current twin component and the total 
number of reflections available. If the number of reflections assigned to the current twin 
component is very much less than the total, then you may have a twin and need to do another 
round of indexing to find another component. Just click Index Cell again. Only the reflections 
which are not yet assigned to a twin component are used. Refine each component until you are 
satisfied with convergence of the least-squares results. 

6. If you have two or three (or more) twin components that all have the same cell dimensions, you 
should finally refine them all together. In the Refine menu, make the Active component the one 
that has the most reflections (usually component 1), then check the box Restrain using other 
components box. Click the Reset all twins button if the list of twins is not correct. 

7. If you have more than one component, and you haven't done so already, use the Get twin 
relations button to get the twin law(s), and use the Predict Spots function to get a visual 
representation of how the twin components overlap on your images. 

8. For integration, the default parameter settings are usually best. Check the Use Twinsolve 
proposed values for Box Size and FWHM unless you have reasons to set them manually. 
Output: datmi?.raw, ?=1,2,… and datmg.raw.  

9. A numerical absorption correction (shape-based) is NOT recommended for a twin. Unless you are 
handling a single crystal, skip to the next step. For single crystals, input is datmg.raw. If you have 
measured the shape, use Gaussian correction. For a spherical crystal, just specify the radius. 
Output: datab.raw 

10. Scale and Shape: The default values are recommended. You may need to increase the number of 
cycles if the calculation does not converge. For problem data, try different Shape factor model 
settings. The recommended ones are the first, third, and fifth ones in the list. The one that you use 
last is the one kept. Input: datmi%.raw (% = 1,2,3..) unless Numerical Abs.Corr. has been run, 
then use datab.raw. Output: dataa.raw. 

11. Reject and Average: Input: dataa.raw if Scale and Shape was run, otherwise datmg.raw. 
a. For single crystals, Twin output doesn't matter. Set averaging to None, for rejecting outliers 

start with Reject limit = 3.0. 
b. For twins, this step may be run more than once. Run once with Twin component set to 1 and 

No twin overlaps checked. This creates a file named hklf_1.hkl, containing only reflections 
from component 1 that are not overlapped with other components. To create a twin reflection 
file (in SHELX 'HKLF 5' format), use Twin components = 0, Calculate for all twin 
combinations, and turn on Averaging (unit weights OK). Reflections in a HKLF 5 format 
file must be averaged! 

12. Do a final cell refinement with constraints. All of the operations are summarized in the CIF 
(tsarchive.cif). The reflection data are in hklf4.hkl or hklf4_1.hkl and/or hklf5.hkl. 

CrystalStructure 
To use TwinSolve data in the Rigaku CrystalStructure program, you need the data file and the CIF created 
by TwinSolve. The CIF is named tsarchive.cif, and normally can be used as-is. Alternately you can use 
the texray.inf file that is created in the Structure directory. 
 
The data file that you use depends on how you want to handle the data. If you are using only a single 
component or if you created a non-overlapped file of one component, you should have a file named 
hklf4.hkl or hklf4_1.hkl. This file is edited to add a format line and then renamed to f2.dat and stored in 
the Structure directory. 
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If you have created a twin data file, it is named hklf5.hkl and contains data from multiple twin 
components. This file can be copied into the Structure directory, and will be copied to shelxl.hkl when 
refinement with SHELX is begun. 

Once the project has been opened, click Tools → Refine mode → Twin. You are asked to enter the twin 
law. If you are refining with SHELXL, this matrix can be left as the identity matrix, otherwise enter the 
twin law for refinement with Crystals 

Tips and Tricks 
In C:\Rigaku\CrystalClear20\Twinsolve folder, find a file named tshelp.xhe. This is a text file that 
contains all of the author’s help information for every command, and is especially useful for using 
TwinSolve in interactive mode (Processing→Twinsolve interactive).  
 
Every operation in TwinSolve is written to one long log file called logger.xlg. This is a text file that you 
can go through to verify everything that happened during the processing.  
 
Notes:  

1. For SCXmini, the circles displayed after Find Spots do not correspond to the reflections on the 
image. Continue with indexing and refinement, then “Predict” correctly indicates the reflection 
positions.  

 
2. Be careful when using index more than once. If you have already indexed a cell, and use Index 

Cell again, the program only uses the reflections that were not assigned to the first cell, and a 
second cell is added to the twin list. There are times when you may want to index several times, 
then go back and delete the unwanted cells: in the Processing State Display, choose twin number 
(Crystal component) from the drop-down list, press Delete. When a component is deleted, 
reflections assigned to that twin component are released and then assigned to another component 
(if they fit) during cell refinement.  
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6. Macromolecule Tasks 

There are two available processing suites each with four different tasks for protein and other 
macromolecular crystallography. You normally select the processing suite when you create a sample, but 
you can change it though the icons in the main toolbar. For each of these combinations there is a flow bar 
provided which guides you through the steps for that task. This chapter concentrates on the work flow. 
The details on the steps themselves are provided in chapters 7-10. 

d*TREK Tasks 

Selecting d*TREK 

 To select d*TREK as your processing suite click the American flag icon in the top toolbar. This is 
the default for CrystalClear. You also have the chance to select the processing suite for each sample as it 
is created (see Chapter 3). 

Selecting the Task 
Whenever you create a sample, you must select the initial task for that sample. However, it is possible to 
change that task either when you re-open the sample or using the task drop down list. 

 
Simply select the task you want and the flow bar is updated with the new task flow. 

Screen Collect and Process 
Select this task when you plan to screen samples and then collect and process a full data set for the best 
one. Only one instance of CrystalClear that involves any image collection can be open at a time. 
However, you can run additional instances of CrystalClear with Process only samples. 

The first part of the flow bar is shown below. 
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Initialize Instrument. Before you can collect data, the goniometers and detector must be initialized. This 
can also be done when the sample is opened or through the Manual Instrument Control. If the instrument 
is already initialized you can skip this step. See chapter 7 for more details. 

Setup. This step allows you to specify information about the sample. If this is a new instrument, you 
should check the X-Ray Source tab to make sure that the X-Ray source information right. If it is not, you 
should set the values appropriately and then click Save to Config. See chapter 7 for more details. Once 
you system has been configured properly, this step is often skipped for macro work. 

Mount Crystal. This is really a pseudo step to remind you to mount the crystal and lock down the 
rotation axis. Once you have done this click OK and then click Initial Images, which unlike some other 
steps does not open automatically. 

Initial Images. This step allows you to collect a few screen images for evaluation and possible indexing.. 
See Chapter 7 for a detailed description. 

Find Spots. This step identifies spots to be used for indexing. The available parameters are described in 
Chapter 8. 

Index Spots. Indexing determines the cell parameters and symmetry. The parameters for indexing are 
described in Chapter 8. 
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Refine Cell. For d*TREK indexing and cell refinement are two separate steps. CrystalClear provides a 
comprehensive interface into refinement. You can refine either on the reflection list from Find Spots or on 
the screen images themselves. 

Predict Spots. The purpose of this step is to allow you to compare the position of the predicted and 
experimental spots and thus check the validity of the refined unit cell parameters. You can also use this 
step to experiment with various mosaicity values. 

Strategy. Strategy suggests a collection schedule based on the cell parameters and crystal symmetry 
determined in previous steps. The user sets the completeness and redundancy requirements. If you prefer 
to specify the collection schedule manually, you can skip this step. Strategy is only available for the 
d*TREK suite and is documented in Chapter 8. 

The steps from Collect Images on are shown in the next screen shot. 

 
 

Collect Images. The collection schedule for this step can be entered by the user or can come from 
Strategy. You can start the Integrate Reflections step before Collect has completed so that the images 
can be integrated as they are being collected. See Chapter 7 for details 

Integrate Reflections. This can either be done while the images are being collected or after collection has 
finished. Chapter 8 provides the details for the parameters that control integration. 

Laue Check. These next three steps are optional steps to check the cell parameters after integration of the 
entire data set. This step checks the Laue group. See Chapter 8. 

Centricity Check. See Chapter 8. 

Space Group Check. See Chapter 8. 
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Num Abs. Correction. This step does numerical absorption correction to prepare the data for Scale and 
Average. This is option since other mathematical absorption models are available in the Scale and 
Average step. See Chapter 8. 

Scale and Average. The scale and average step creates a file of merged, averaged and scaled reflections 
that can then be used in structure solution. See Chapter 8. 

Write CIF. The sample and cell information can be written to a CIF file if desired. See Chapter 8. 

Collect and Process 
The Collect and Process task implements the so called “Wild West” method. Shoot first and ask questions 
later. You can use this task when you want to collect a full data set without previously screening the 
crystal. The flow bar is show below. 
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All these steps are described above in Screen Collect and Process. The difference is that the Initial Images 
step is omitted and the Assign Unit Cell steps (Find, Index, etc) are moved after Collect and before 
integrate. Note that it is not possible to integrate during data collection in this task because you have not 
yet indexed the cell and you need to be able to predict to integrate. 

Collect 
The simplest task is just a simple data collection. This assumes processing is done later or even with a 3rd 
party program.  
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Process 
The Process task (sometimes referred to as Process Only) is commonly used for processing a data set 
that has been collected previously. It can run on a different computer from the control PC on which the 
data was collected. The only requirement is that the PC which is running the process only task must be 
able to access the image directory.  

It is also sometimes useful to create a Process only task to if you want to change the processing suite or 
process the data with different parameters. This can keep the cell parameters, log files, etc separate and 
gives you a “clean start”. 

The flow bar for Process is show below. 
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These steps are identical to the Screen Collect and Process steps except that the Initialize, Initial 
Images, and Collect Images steps are removed. 
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Fine Slice Process  

Selecting FS_Process 

To select Fine Slice Process ( FS_PROCESS) as your processing suite click the Japanese flag icon in 
the top toolbar. You also have the chance to select the processing suite for each sample as it is created 
(see Chapter 3). 

Selecting the Task 
FS_PROCESS has the same set of tasks as d*TREK. 

Screen Collect and Process 
The collect steps are the same in FS_PROCESS as in d*TREK, but the processing steps are different. The 
flow bar is: 
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Intialize, Setup, Mount Crystal, Initial Images, and Collect Images are all the same as for d*TREK 
and are described in Chapter 7. Note that there is no Strategy step available in FS_PROCESS so the 
collection must be set up manually. 

Find Spots. FS_PROCESS has a separate Find Spots step which is described in Chapter 9. The dialog 
and parameters are different than for d*TREK. 

Index Spots. For FS_PROCESS there is no separate refinement step. The details are in Chapter 9. 

Predict Spots. FS_PROCESS also has its own predict step. See Chapter 9 for the FS_PROCESS predict 
details. 

Integrate Reflections. FS_PROCESS integration cannot be run until the Collect Images step has 
completed. See Chapter 8 for details on the FS_PROCESS integration dialog. 

Scale and Average. The Scale and Average step is also different in FS_PROCESS. See Chapter 9. 

Collect and Process 
The Collect and Process task in FS_PROCESS simply replaces the Initial Images step with the Collect 
Images step. This is useful if you want to collect a data set without first collecting screen images. 

 

 
 

The collection steps (Initialize Instrument, Setup, Mount Crystal, and Collect Images are described in 
Chapter 7. The FS_PROCESS processing steps are described in Chapter 9. 
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Collect 
The collect task is identical to d*TREK..  

 

 

Process 
The Process task (sometimes referred to as Process Only) for FS_PROCESS has the same role as it does 
for d*TREK. FS_PROCESS does not allow you to integrate data until the data collection step has 
completed. You cannot create the sample until the data collection has completed. 

The flow bar for Process is show below. 

 
These processing steps are identical to the processing steps in FS_PROCESS Screen Collect and 
Process and are document in Chapter 9. 



 

CrystalClear  

 

CrystalClear Macromolecule Tasks 6-11 

This page is left blank intentionally. 

 

 





 

CrystalClear  

 

CrystalClear Data Collection 7-1 

7. Data Collection 

This chapter describes the steps that are related directly to setting up a sample and collecting data. These 
steps are normally activated through one of the task flow bars, but can also be activated through the 
Instrument menu. The steps in this chapter apply to all processing suites. They have different defaults for 
macromolecular and small molecule modes, but have the same functionality. 

Initialize 

Initialization 
Before you can perform any data collection steps, you must initialize the instrument. The instrument must 
be initialized at the following times: 

1. Whenever you start or re-start CrystalClear. CrystalClear restarts the instrument server, so the 
instrument server must initialize so that it knows the exact status of the instrument. 

2. If there is an error in the data collection or goniometers movements. When these errors occur they 
often leave the instrument in an unknown state, so it must be re-initialized. 

3. If you do an Abort, either through the software abort button or any of the hardware aborts. Again 
this leaves the instrument in an unknown state so it is necessary to re-initialize. 

In some cases CrystalClear realizes that it needs to re-initialize and do this automatically, but when you 
start or re-start CrystalClear you must do it explicitly. 

There are several ways in which you can initialize in CrystalClear 

1. When you open a sample with a task that involves Collect, CrystalClear asks you if you want to 
initialize. 

2. You can open the Manual Instrument Display (see Chapter 4 Views) and click Initialize. For 
an R-AXIS and other image plate systems this can give you more control over the initialization 
process 

3. You can click the first step in the Screen Collect and Process, Collect and Process, or Collect 
flow bars. 

Initialize Instrument Step 
The Initialize Instrument step in the flow bar issues an initialize command to the Instrument Server and 
brings up the Instrument Sate Display so that you can monitor the progress of the initialization. 

 

Setup 

Overview 
The Setup step is used for both tasks which collect data and process only tasks. Its primary purpose is to 
collect information that is useful in processing the sample. It also gives you a chance to enter information 
that is useful in solving the structure. Much of this information is for record keeping only and can be 
skipped if you do not need this information or have it available from another source. 
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Setup is also used to define X-Ray generator configuration settings. For samples you are collecting on 
your home lab instrument, updating the X-Ray configuration only needs to be done rarely. To do this 
enter the information for your site and then save this to the configuration file. If you are processing data 
from a beam line or elsewhere you may need to change the X-Ray information if it is not right in the 
image headers. But in this case you should not save the updates to the configuration since they do not 
apply to all data sets. You should pay particular attention to the section about the X-Ray Source tab. 

Setup Dialog MainTab 
When you click the Setup Step, the following dialog appears: 

 
 

Parameter Description 
Project  Current Project (Read only – to make sure this is the sample you think it is)  
Sample  Current Sample. (Read only) 
Crystal ID Crystal ID is a name or number you can give to your crystal for your personal 

reference. This value is not used in collection or processing.  
Crystal-To- Detector 
Distance (mm) 

The distance from the crystal to the detector when collecting images.  
If you are processing existing images, the value specified when the images 
were collected is displayed.  

NOTE: Crystal-To-Detector Distance (mm) field shows the hardware or 
unrefined values. 

NOTE: This information is descriptive and not proscriptive. If you are 
collecting new data for this scan, you should enter the Distance in the scan 
table. 
 
If "per scan" is displayed in the Crystal-To-Detector Distance (mm) field, 
different scans have different values. In this case, refer to the Scan State 
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Parameter Description 
Display window to view these values for each scanned image.  

Temperature  (oC) The Temperature of the crystal sample at the time of collection, in degrees 
Celsius. The options are: 

 •  20.0 
 •  4.0 
 •  -160.0 
 •  custom value 

Detector 2θ (o) 2θ  angle of the detector goniometer. Detector 2θ (o) field shows the hardware 
or unrefined values. 

NOTE:  If existing images are being processed, the value specified when the 
images were collected is displayed. 

NOTE: This information is descriptive and not proscriptive. If you are 
collecting new data for this scan, you should enter the 2θ  in the 
scan table. 

Setup Dialog Crystal1Tab 
There are two tabs for entering crystal information. Much of this information is used for record keeping 
(e.g., a CIF file), but is not used in processing. The exceptions are the Unit Cell Parameters which are 
used if you choose Known Space Group and the Molecular Formula which can be used for numerical 
absorption correction and small molecule structure solution. The first Crystal tab is: 

 

 
 

Parameter Description 
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Parameter Description 
Unit Cell Parameters The Unit Cell Parameters for the sample.  

 a (Å) default = 10 
 b (Å) default = 10 
 c (Å) default = 10 
 α (o) default = 90 
 β (o) default = 90 
 γ (o) default = 90 

Size The Size of the crystal in millimeters.  
 X (mm) default = 0.2  
 Y (mm) default = 0.2  
 Z (mm) default = 0.2  

Mosaicity Starting value to use for crystal Mosaicity.  
The default starting value is 0.6.  

Molecule Type Specify the Molecule Type: 
 •  small 
 •  macro (protein) 

NOTE: Setting this does not change the mode of CrystalClear itself. 
Color Color of the crystal. You may enter the color name or use a drop-down list 

which provides predefined colors. The predefined color choices are:  
 •  Blue 
 •  Colorless 
 •  Gray 
 •  Green 
 •  Orange 
 •  Red 
 •  White 
 •  Yellow  

Mount Type of Mount used for the crystal. You may enter the mount type in the field, 
or use a drop-down list which provides predefined mount types. The predefined 
mount choices are:  

 •  Fiber 
 •  Capillary 
 •  Loop 

Morphology Specify the Morphology of the crystal. You may enter the name in the field, or 
use a drop-down list which provides predefined morphology types. The 
predefined choices are:  

 •  Block 
 •  Chip 
 •  Chunk 
 •  Platelet 
 •  Prism  



 

CrystalClear  

 

CrystalClear Data Collection 7-5 

Setup Dialog Crystal2 Tab 
The second Crystal tab is: 

 
 

Parameter Description 
Space group   Specify the Space group of the crystal: 

 •  Unknown 
 •  Possible 
 •  Known 

  
To enter a Known Space group, type either the number or the 
name in the appropriate field. Alternately, if you know the Crystal 
System and need to be reminded of the possible Space groups, 
select the Crystal System, then scroll and choose the Space group 
from the list under Number and Name.  

System If you selected Known Space group, this option becomes enabled. 
You can select from the drop down list of predefined Crystal 
Systems. Known Crystal System options are: 

 •  Triclinic 
 •  Monoclinic 
 •  Orthorhombic 
 •  Tetragonal 
 •  Trigonal 
 •  Hexagonal 
 •  Cubic  
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Parameter Description 
Laue class Select the Laue class from the drop-down list. Options are: 

 •  -1 
 •  2/m 
 •  mmm 
 •  4/m 
 •  4/mmm 
 •  -3 
 •  -3m1 
 •  -3/m 
 •  6/m 
 •  6/mmm 
 •  m-3 
 •  m-3m 

Centricity Select the Centricity from the drop-down list. Options are: 
 •  Centric 
 •  Acentric 

Number Scroll through the available space groups from the list under 
Number and Name, or alternately, type either the number or name 
in the appropriate Number or Name field. The other field updates 
automatically to match. 

Name 

Molecular 
Formula 

  The Molecular Formula for the crystal. You may enter the formula 
as it appears in your compound. CrystalClear determines the 
empirical formula for you. This is, of course, for small molecule 
users. 

Orientation 
angles 

  Rot1, Rot2, Rot3  values are reported here for a sample that has 
been indexed. For a sample yet to be collected they are calculated 
later on by CrystalClear so you should leave them as 0.0 when 
starting a new sample.  

Setup Dialog Detector Tab 
This tab describes information about the detector. 
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Parameter Description 
Distance Crystal-to-Detector distance.  

 
NOTE:  The Crystal-to-Detector Distance may be changed on the Main tab of 
the Setup dialog, as well as on the Detector tab. The 2θ (o) can also be set on the 
Main tab. The other Direct Beam settings on this tab are generally not changed. 

X Shift Detector shift along the X-axis (usually zero).  
Y Shift Detector shift along the Y-axis (usually zero).  
Rotation About 2 
Theta 

Amount the detector is rotated about 2θ (swing angle). 

Rotation About Beam Amount the detector is rotated about the beam axis (usually zero).  
Rotation About Rot Y Amount the detector is rotated about the Y-axis (usually zero).  
Direct Beam at θ = 0 The Direct Beam settings are based on the type of X-ray detector. Normally, the 

values are set as site defaults by your CrystalClear administrator. You may set 
the X, Y values and Pixel Size (µ). 

Mask File The Mask File group box displays information about the mask file. Using a 
Mask File may be useful when running Integrate Reflections to define the 
shadow of the beam stop or other shadowed regions. Reflections overlapping 
the masked region is excluded during data processing. It is not necessary to use 
a mask file during processing, however, it is advisable. 
 
If you are collecting a new data set, there is another opportunity to specify a 
mask file at the Collect step. 
 

Click the    button to access the Open Image File dialog. 

Click the    Button to access the Non-Uniformity dialog. The 
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Parameter Description 
recommendation is that you use the non-uniformity information that comes 
automatically in the image headers since this reflects what is actually collected, 
so you rarely need to use this button. 

 

Setup Dialog X-Ray Source Tab 
Much of the setup information is for book keeping or informational purposes only and does not affect 
data collection and processing. However, this tab contains information that does affect data processing 
(e.g., the Wavelength) and so it is very important that this is right. Some of the X-Ray Source information 
can also be used to update a system configuration file (if you are a user with administration privileges). In 
fact, if you are the system administrator, you should open a dummy Screen Collect and Process sample 
and then go into the Setup dialog, select the X-Ray Source tab and make sure this information is correct. 
If not, you should update it and then click Save to Config. 

 

 
 

Parameter Description 
Optics The following attributes pertain to your detector: 
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Parameter Description 
  Type Select from the drop-down list. The options are: 

 •  Confocal 
 •  Graphite Monochromator 
 •  Mirrors 
 •  Multilayer 
 •  Synchroton 
 •  Other 

Slit Size Specify the value.  
Focus Select from a drop-down  list: The options are: 

 •  0.1 
 •  0.15 
 •  0.2 
 •  0.3 
 •  0.5  

Collimation Type Specify the value. 
Voltage (kV) The Voltage (kV) of your X-ray source.  
Current (mA) The Current (mA) of your X-ray source.  
Element The Element type of your X-ray source from the predefined drop 

down list. If the Source Type is Synchrotron then this field is 
disabled. The predefined choices are: 

 •  Chromium 
 •  Copper 
 •  Gold 
 •  Iron 
 •  Molybdenum 
 •  Silver 
 •  Tungsten  

Wavelength (Å) The Wavelength of your X-ray source. The wavelength is based on 
the Element type. When you select an Element, a valid wavelength 
is automatically selected for you. If the Source Type is 
Synchrotron, then you need to enter this value explicitly. 

Source Type The Source Type of the X-ray source from the predefined drop 
down list. The predefined choices are: 

 •  Rotating Anode 
 •  Sealed Tube 
 •  Synchrotron 

Polarization Polarization (per scan) displayed. Use the Reset button if necessary. 
If there is no polarization set this value to 0.5. Synchrotron beams 
may be highly polarized, so it is important to specify a value and 
the normal vector. 

  Normal vector... Normal vector to polarization plane: 
 •  x 
 •  y 
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Parameter Description 
 •  z 

Save to Config The values in the X-Ray Source Tab are saved in a configuration 
file rather than the default database. Use the Save to Config button 
to save the X-Ray source information to the configuration file. This 
makes these settings the default for all new samples. 
NOTE:  This operation is available for CrystalClear Administrators 

only. 

Setup Dialog Notes Tab 
The final tab allows you to enter notes for future reference. 

 
 

Mount Crystal Step 
The Mount Crystal step is just a reminder that you need to mount the crystal and lock down the rotation 
axis at this point in the procedure. It also gives you another chance to enter the size of the crystal. This is 
handy if you have run RAXShape to determine the size of the crystal (small molecule modes) since it 
means you do not need to go back into the setup dialog. 
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When you have mounted the crystal and locked the rotation axis, then you should click OK and go on to 
the Initial Images step. 

Mount Crystal dialog using AFC7 
 
You may skip this section if you do not have an AFC7. 
 
The AFC7 has a special dialog for mounting. 

 
 

Parameters Description 
Move! φ The Current Position of the φ axis is displayed. To move the φ axis to the 

position, select Unlock, then click Move!  You can then manually unlock φ. Once 
you are finished mounting, you should move the φ axis position back to 0, after 
locking the  φ axis, by selecting 0 and then clicking Move! 

NOTE:  When positioned at 0, the CCD detector blocks access to the locking 
screw. 

Move! χ The Current Position of the χ axis is displayed. To position the axis, select -90, 
0 or 90, then click Move! 

NOTE:   χ allows adjustment of the sample height. Since the microscope is 
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Parameters Description 
mounted at an angle on the χ circle, the χ positions of -90 and 90 are 
generally used to check the height of the sample. Once the sample has 
been positioned at the appropriate height with χ at 90, the sample can 
then be moved to χ at -90 to verify that the height is correctly adjusted.  

Move! 2θ/ω The Current Position of the 2θ/ω axis is displayed. To change position, select -
15 or 0, then click Move! 

NOTE:  2θ/ω allows the detector to be moved so the χ circle may be 
conveniently positioned for mounting the crystal. When positioned at -
15 degrees, the detector is towards the back of the generator and the χ 
circle may be rotated for convenient crystal access.  

Initialize Instrument Click Initialize Instrument to initiate the procedure. 
Close Click Close to exit the dialog. 

 

Initial Images 

Overview 
It is often useful to collect screen images before doing a full data collection. This allows you to screen 
crystal to find one that diffracts well and then index the sample and determine symmetry so that you can 
either use Strategy to calculate a collection schedule or manually choose a schedule that is appropriate for 
this sample. For protein work, it is often sufficient to only collect one or two screen images, but for small 
molecule work you usually need to collect more (e.g., 10 to 20) to get enough spots to index. 

Initial Images Dialog 
This version of the dialog is for a CCD. If you have an R-AXIS or Rapid, the controls may be slightly 
different. 
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The central control in this dialog is the scan table. The scan table is described in detail as part of the Scan 
State Display in Chapter 4. If you are not familiar with the scan table, it is highly recommended that you 
read that section. 

In addition to the scan table, there are the following parameters and controls available. 

Parameter Description 
Dezinger exposure For CCD cameras, long exposures may record larger number of random zinger 

events (cosmic or optic taper related). Collecting the image a second time 
allows for analysis of intensities with respect to zingers. Note: this doubles the 
number of images and radiation decay effects, and thus the length of time for 
collection. 

Bin mode 2x2 binning is the most common for CCDs. But you may also select 1x1 and 
on certain detectors 4x4. 2x2 binning means that 4 camera pixels are summed 
into a single image pixel. 

Overload correction There are various options for handling overloads (i.e. when the intensity for a 
given pixel exceeds the dynamic range of the CCD; i.e. over 16 bit or 18 bits 
depending on your detector). When you click Settings… the following dialog 
opens: 

 
 

Your options are 
• Time 
• Attenuator 
• None 

You also have the option of saving overload correction images to disk. 
This is usually only necessary if you are having problems with the 
overload correction not being right. But it can be extremely valuable in 
that case. 

X-ray Generator 
Scripts If you have JXG installed and active, you have the option of running scripts 

before and after the data collection. This can be useful to power up before you 
start data collection and power back down after the data collection is finished, 
but this is a general mechanism and there are varous scripting options 
available. These are shown as disabled in this example because it was 
configured without JXG. 
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Parameter Description 
Screen Schedules This is a drop down list with all of the predefined screen schedules. When you 

select a schedule, the scans in that schedule display in the scan table. Adding 
new schedules is easier through the Scan State Display, but some functions 
can be done from this dialog by click Import… (see below) 

Add Scan When you need to add an additional scan to this schedule, click this button. 
The values in the scan are copied from the currently selected scan. 

Delete Scan Deletes the currently selected scan 

Estimated time to 
collect This gives the estimated collection time for both the selected scan and the 

entire schedule. 

Required disk space Since images are quite large, it is good to check the disk space requirements 
before you start the scan. When you run out of disk space you may have 
unpredictable results in CrystalClear and the instrument servers. 

Total disk space This shows you how much disk space there is left on the drive where your User 
Data Directory is stored. Available means what there is now, and Remaining 
is what there is estimated to be after this schedule is collected. 

If insufficient disk space is available to complete the scheduled image 
collection request, a CrystalClear warning dialog opens. The collection request 
may be cancelled to allow the user to free more disk space on the system 
before continuing.  

Image Dir… When you created the sample, you specified where images were to be 
collected. It is possible to override the specification at this point. 

Preferences… Preferences are settings for each user about how you want to see information 
presented and how certain things behave. There is a link to this dialog from 
here since some of the preferences have to do with how images are calculated 
(e.g., what the independent variable are for start, stop, and number of images). 

Import… This brings up the Schedule Manager Dialog described in the section on the 
Scan State Display in chapter 4. This allows you to easily import schedules 
from other samples, projects or users. 

Errors If there are errors in your schedule (e.g., it would collide somewhere) an error 
message with a yellow background with a More… button that tells you more 
about the error. 

Completeness This is not currently functional.  

Save Most dialogs have the ability to save their settings to the defaults. Clicking on 
this button brings up the Default Manager (see Chapter 3 Getting Started). If 
you want to change the default settings for the schedules, you can do it here. If 
you have created or modified a schedule that you want to be available to other 
samples in this project or for all your projects, you need to Save.  

Run You are asked to verify that you really want to collect this data and then the 
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Parameter Description 
collection starts. 

 

Once the Initial Images step is running, it brings up the Instrument State Display so that you can 

observe the images. If you want to view these images as they are collected you should click the  icon 
in the top tool bar. By default this is enabled, but it can be turned off since it adds a little time to the 
collection. 

During the time that the Initial Images step is running, the user interface is “live” so that you can look at 
already collected images and use other viewers to examine the state of the system. However, you should 
not try to execute any other steps since it could result in an unintended sequence of events. 

Collect Images 

Overview 
The Collect Images step brings up a dialog which is almost identical to the Initial Images dialog. The 
only difference is that the schedule list is labeled Collect Schedules rather than Screen schedules. For a 
detailed description of this dialog, see the previous Initial Images section. For a description of the scan 
table itself, see the Scan State Display in chapter 4. 

Strategy 
The collection schedule can be created manually or it can be generated by the Strategy step. This step is 
dependent on indexing and previous processing steps and is only available if d*TREK is the processing 
suite. Strategy is documented in Chapter 8 d*TREK Steps. 

Integration 
Most steps are mutually exclusive and you should not attempt to run them in parallel. The one exception 
to this rule is the Integrate Reflections step which can run in parallel with data collection. This option is 
only available when d*TREK is the processing suite. To use it just go on to the Integrate Reflections 
step once data collection has started. With a modern PC it is usually possible to keep up with the data 
collection so that your integrated data is available shortly after the data collection is completed. 

The one risk you run if you do this is that any severe problems in integration could halt your data 
collection. This is a rare occurrence, but the risk is not zero. If you have an older control PC, there is also 
a small risk that the timing of data collection or the readout of the image (on R-AXIS systems) could be 
disrupted by processing while you are collecting. Again the risk is small but not zero. 
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8. d*TREK Steps 

The d*TREK processing suite includes a set of crystallographic data processing programs originally 
developed by Dr. James W. Pflugrath and enhanced by Dr. Pflugrath and various members of the 
scientific and programming staff at Rigaku Americas Corporation. The command line version of d*TREK 
is available under separate license for Windows, Linux, and Mac. CrystalClear has a version of d*TREK 
which is packaged into a single server program. The license for this packaged version is included with 
your CrystalClear license. 

The d*TREK processing steps in CrystalClear generally correlate to the separate programs in d*TREK 
(e.g., Index Spots uses dtindex, etc). However this is not always exactly 1:1 and the parameters may have 
different names and defaults in CrystalClear and the command line version of d*TREK. 

Working with d*TREK 

Log Files 
Each d*TREK function creates a log file which contains information that is often useful to determine if 
the function was successful as well as information about the data, crystal, etc. These log files are 
displayed automatically in the Log File Viewer when a d*TREK function is run. For example, Find Spots 
runs dtfind which produces dtfind.log. Log files are automatically versioned up to 5 levels so that the 
second time you run Find Spots, the dtfind.log is for the latest run and dtfind.log.1 is for the run just 
before the latest run.  

Command Line 
CrystalClear sends the d*TREK function a command line that corresponds exactly with the command line 
version of d*TREK. This command line is printed at the top of the log file for the d*TREK function. To 
see the command sent to dtindex, look in dtindex.log. Looking at the command line in the log file also 
shows you how the CrystalClear parameters are mapped into the d*TREK command line. 

Header Files 
Some of the inputs for d*TREK functions come through the command line, but there is also accumulated 
state information (e.g., unit cell parameters etc) that is passed through header files. Each function reads 
input.head when it runs and produces an output.head when it completes. These header files have the same 
format as the header section of an image file. CrystalClear reads the output.head file to update its internal 
state history and writes input.head before running a d*TREK function. Looking at these header files can 
help track down a problem, but since they are written by CrystalClear at each step, attempting to edit 
them to change the behavior of d*TREK won’t work. 

Environment Variables 
CrystalClear does not normally use Environment Variables to control the operation of d*TREK, but since 
the CrystalClear version of d*TREK is built with the same source code as the command line version, they 
are still active. Normally you don’t need to worry about these and should not set them.  
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DOS Window 
When CrystalClear starts up the d*TREK server, a DOS window opens in your tray. There is usually 
nothing in this DOS window. This is normal and you should not close this window. If you accidentally 
close it between d*TREK operations, it is restarted automatically by CrystalClear. It also closes 
automatically when CrystalClear exits. However if there is an abnormal exit of CrystalClear that leaves 
this DOS window open, you should close it manually by activating the DOS window and clicking on the 
x in the upper right corner. 

Defaults as 0 
The d*TREK convention is that a parameter which is 0 (where 0 does not make sense – e.g., as a 
resolution cutoff) means “use the internal d*TREK default” or sometimes “calculate a reasonable value”. 
CrystalClear adopts this convention also. So an input of 0 or 0.0 usually means, “Do the sensible thing”. 

Resolution Limits 
Since it is often convenient to use the same resolution for multiple steps, there is a dialog set the 
resolution limits for multiple steps. This dialog can be activated by clicking on the toolbar icon or by 
clicking on the Set… button provided in the dialogs that contain resolution limit parameters.  

 Set Resolution Limits icon 

 
 

Parameter Description 
Resolution  0.0 means use the default. Otherwise these are the resolution limits to be used in 

all the checked d*TREK steps. These limits are in degrees for small molecule 
mode and in Angstroms for macromolecule. 

To Edge of Image Set the resolution limits so that they go to the edge of the image. This is of 
course dependent on the crystal to detector distsance. 

To Corner of Image Set the resolution limits so that they go to the corner of the image. 
Apply to Check All processing dialogs or select the specific dialogs you want these limits 

to apply to. 
OK, Cancel Make sure you click OK in order to set the values. Cancel quits without 
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Parameter Description 
updating the values. 

 

Pre Collection Steps 

Find Spots 
The first step in processing your data is to find spots to be used in indexing. The Find Spots step locates 
reflection centroids in a single image or a collection of images. Finding reflection centroids requires 
knowledge of the image properties. For subsequent steps, for example, Index and Refine, to function 
correctly, you need at least 50 to 70 reflection centroids in the Find spots step. The number can vary, 
depending on the centroid accuracy and location in reciprocal space. 

Find Spots Main Tab 

 
 

Parameter Description 
Scan Selection Table All of the screen and collect scans that been completed are listed here. You can 

fill in the images you want to use in the To Use section. See chapter 4 for a 
description of the Scan Table. 

Select Screen This is a shortcut to select all of the _screen images for Find. 
Clear All This is a shortcut to clear all image selection to let you start over. 
I/Sigma Specifies the minimum I/Sigma that a peak must have to be considered a spot. 

If you have weak data you may have to lower this number to get enough spots 
to index. Standard deviation (default 5.0) above background is tested after 
any non-uniformity correction is applied.  
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Parameter Description 
If I/Sigma is 0, Find Spots processes faster because it does not calculate 
average background and its standard deviation. However, a high 
Minimum Pixel Value (in the Advanced tab) should be chosen to avoid 
finding too many spots that are not Bragg reflections. 

Find Spots Advanced Tab 
The advanced tab has additional parameters. These values seldom need to be changed. 

 
 

Parameter Description 
Minimum pixel value Specify a Minimum Pixel Value for a pixel to be considered a peak. The 

Minimum Pixel Value is compared to non-uniformity corrected pixel values. 
The actual threshold used is the maximum of Minimum and Sigma above the 
average background. If you are picking up too many spots that are not actually 
Bragg reflections, you should increase this value. 

Peak Filter Specify the Peak filter to help distinguish between true spots and noise in the 
images. 
The Peak filter is specified as the number of pixels in a 3x3 area that must be 
above the threshold (Sigma, Minimum Pixel ) value for a peak to be considered 
a reflection. If spots are large, you might use value 9. If the spots are small, you 
might use value 4. 

Minimum pixel height 
above background 

Specify a value for Minimum pixel height above background for a pixel to be 
considered. The actual minimum value for a pixel to be considered part of a 
peak is the largest of  

1. I/Sigma 
2. Minimum pixel value 
3. Minimum difference between the maximum pixel value found in the 

peak and the average background pixel value near the peak. 
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Parameter Description 
2D/3D Specify a 2D/3D spot search method. 

• 2D search is performed by default. 
• 3D search is used to determine peak widths for mosaicity refinement. 

3D search uses a two-pass algorithm to add images to either rotation 
side. If you are going to examine the peaks with Reciprocal Lattice 
Viewer, it is best to use 3D. 

Padding The number of padding in images for 3D shoeboxes (in 3D search mode only) 
at the start and end in the rotation angle direction. In order to completely 
contain a 3D peak with a 3D shoebox or volume, pad by 2-4 images and have a 
Box size large enough. If any significant peak intensity is on the edge of a 
shoebox, Find Spots rejects the centroid determined for that peak, thus 
Padding is important to ensure that the peaks are recognized properly. 

Box Specify the Box Width and Height, in pixels, for the box appearing around 
each spot in the display. A good Box size is 3 to 4 times larger than the biggest 
spot, but without intruding more than half way into neighboring spots. If both 
Width and Height are set to 0, CrystalClear determines the box size for each 
spot automatically which takes extra computational power and time. Default 
Box settings include the entire image less a 1% border. 

Find beam center This attempts to find the direct beam position. It is usually better to do this in 
Index Spots. 

Include saturated spots Saturated spots are rejected for integration since you don’t really know their 
value, but they can still be used in indexing, so the default for this is checked. 

Determine strong peak 
info 

This adds information about strong peaks into the log file. 

Resolution  These are the standard resolution controls for d*TREK. 

Index Spots 
The Index Spots step indexes reflection centroids in the selected reflection list to elucidate the crystal 
unit cell dimensions, crystal orientation, and Bravais lattice type. Indexing normally starts with the 
dtfind.ref file from Find Spots and produces a set of cell parameters. In d*TREK the cell is not refined in 
this step, but rather in the Refine Cell step. The indexing in d*TREK is generally very robust, so you 
don’t normally need to use the Advanced tab. 
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Index Spots Main Tab 

 
 

Parameter Description 
Space Group Unknown – You don’t know the space group or want to let index work without 

bias. This is the recommended setting unless you want to force the space group. 
Possible – You have an idea of what the space group should be and would like 
indexing to bias towards your guess. 
 
Known – You know what the space group should be and want indexing to 
attempt to fit that space group. 

Crystal System For Possible or Known space groups, you should select the relevant crystal 
system. This then filters the list of possible space groups so that you can select 
the space group you want. This is just a short cut to help you find the space 
group and does not actually affect the calculation. 

Number – Name For Possible or Known space groups you can specify either the space group 
number or the name. The parameter you are not editing is updated 
automatically to correspond to the value you entered. Once you choose a crystal 
system, the list of possible space groups in that system fills in the selection box 
below Number and Name and you can simply select the one you want and 
Number and Name is updated automatically. 

Reflection Lists This is a list of the .ref files in your sample. The default is dtfind.ref which is 
usually what you want to use. 

Resolution You may specify resolution limits for indexing. These are in either degrees in 
2θ or Ångströms for small molecule depending on your preferences. For 
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Parameter Description 
macromolecule they are in Ångströms. 

User chooses solution Indexing produces an ordered list of possible cells with the most likely at the 
top of the list. If this box is not checked, the top (most likely) solution is used, 
but if the box is checked then you get the opportunity to see this list and select 
the solution you think is best. 

 

Index Spots Advanced Tab 
The advanced tab has additional parameters that you can specify if the standard indexing is not producing 
the results you want. 

 
 

Parameter Description 
Max cell length This is the maximum length of any axis in the cell. It can be used to force 

indexing to avoid very large cells even if they have a low residual. 
Max residual Max residual represent the residual between the current cell and the triclinic 

cell (lower is better). Depending upon the degree of accuracy of your detector 
geometric parameters, the Max residual varies (very small is a good fit.)  
CrystalClear fits the reduced primitive cell to 44 lattice groups. Only those 
solutions with a residual less than or equal to Max Residual are displayed. 
Typically, residuals greater than 2.5 are not valid solutions. The default of 2.5 
reduces output and helps make it easier to choose the correct solution. If using 
the 1D FFT method, a residual of 1 or higher indicates either the wrong solution 
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Parameter Description 
or misaligned hardware. 

Max vectors Maximum number of difference vectors to use in the calculations. With more 
difference vectors the calculations take more time and the residuals are larger. 
With fewer differences, the calculations take less time and solutions may be 
missed. If 0, Index Spots picks an appropriate number. 

Grid size Specify the Grid Size in Ångstroms for the direct space Fourier map. This 
parameter applies only if the Fourier Method is used. If 0, then Find Spots 
selects an appropriate grid size. 

I/SigI For historical reasons relating to d*TREK, this parameter has two 
interpretations depending on I/SigI. 

1. If I/SigI>=1.0 then it specifies the minimum I/SigI required for 
indexing contributors.  

2. If 0.0< I/SigI <1.0 then it specifies the fraction of the input list 
reflections to use. 

Method There are several indexing methods available. 
• 1D FFT (default and recommended for most uses) The DPS indexing 

algorithm of Steller, Bolotovsky, & Rossmann is used. About 7300 
different directions are examined using a 1D FFT for whether a 
principal cell axis is parallel to that vector. Three of the vectors with the 
most order are selected for cell reduction.  

• 3D Fourier A 3D cosine Fourier transform is calculated over a real unit 
cell volume with grid points x.  
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 is the reciprocal lattice vector for reflection i. Peaks appear 
in the Fourier function at the end points of the real cell axes a, b, c and 
linear combinations of these axes. 

• Reciprocal Space. The reciprocal space method of Sparks. 
Deice Deletes spots (thought to be in Ice Rings) found in resolution rings close 

to the resolution of the powder rings of hexagonal ice. 
Use difference vector Index Spots can use the vectors calculated from the reflection centroids (e.g., 

d(i)), or it can use difference vectors calculated from these vectors: d(i)-d(j). 
Beam Check Select the Beam Check option if you think that the direct beam location may 

not be correct in the image header. If this option is selected, you need to enter a 
Search radius (in pixels) to define a search area and a Valid radius to define a 
valid area, from the input header’s direct beam position. The beam check is 
performed after a pre-reduced cell solution is found by attempting to re-index 
the data with different beam centers within the search radius pixel value of the 
entered beam center. If a local maximum is not found within the valid radius 
pixel value of the original center, the original beam center is used. 

User known unit cell When you know the cell parameters you expect to find, you can check this box 
and force indexing to attempt to match this cell. You can specify the allowable 
errors as either a Percent error or an Absolute error. You need to then fill in 
the cell parameters and the allowable error. As in many cases 0.0 means use the 
internal default in d*TREK and not that the error has to be 0.0. 
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Choosing a Indexing Solution 
If you have selected the User chooses solution option, you need to choose an indexing solution 
before you can continue. An additional pop up dialog allows you to select both the desired 
indexing solution and the orientation. This table is sorted so that the most probable solution and 
orientation is at the top of the list. The number of Bravais Lattices in the list depends on the 
value set for Max residual. The Least Sq column represents the residual between the current cell 
and the triclinic cell. Lower is better. If User chooses solution is not checked, then the top 
solution and orientation are used. 
 

 

Improving Indexing Results 
If difficulties arise in indexing spots, consider the following solutions. 

• Ensure that the detector, source, and scan properties in the dialog boxes are accurate. Ensure that 
the detector translations (direct beam position on detector and crystal-to-detector distance) and 
scan rotation axis are correct. Ensure that the calculated or entered maximum cell length is large 
enough. 

• Ensure that the crystal is not split, cracked, or twinned. Expose images 90° and 45° away from 
the original image to verify the crystal integrity. 

• Use a different image or set of images in finding spots to get reflection centroids. 

• Use reflections from more than one image for indexing. The images should be separated 10° or 
more in rotation angle. But you generally do not need to use too many images to index with 
d*TREK. A rotation axis specified incorrectly with a slight tilt not specified in the input header 
may create difficulties. Refine small tilts in the rotation axis. 
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• Use three-dimensional reflection centroids from a single scan (contiguous set of images) or from 
more than one scan. 

• Enter a higher sigma or minimum fraction cutoff. 

• Accept a triclinic cell, then refine the detector position, and re-index.  

Refine Cell 
The Refine step refines the crystal, crystal goniometer, detector goniometer, and source properties to 
reduce the differences between observed and calculated reflection centroids. You can refine these 
parameters using a reflection file or with images. 

The Refine Cell dialog can appear in a variety of steps for small molecule work. The Process task, for 
example has a Refine Primitive Cell, Refine Standard Cell, and Final Refine Cell. These all pop up the 
same dialog and run the same d*TREK refine function, but just have different default parameters. 

The Refine Cell dialog is quite imposing but gives you fine control over the refinement and also allows 
you to monitor the progress of the refinement. But in practice, you do not need to use most of these 
controls and it is quite easy to run successfully. Refine is normally run simply by selecting the appropriate 
Macro. These macros are predefined and installed with CrystalClear. There are macros for most common 
refinement procedures, but you can add new macros or edit existing macros for your installation. 

In Small Molecule mode, the pre-collection refinement is done twice in the following sequence (see 
Chapter 5) 

• Refine Primitive Cell 

• Reduce Cell 

• Refine Standard Cell 
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Refine Cell Main Tab 

 
 

Parameter Description 
Crystal This section contains a series of check boxes most of which set by the macro 

you are running. For example, for the Most macro which is recommended, the 
only one you can change is: 

• Constrain unit cell according to symmetry – does not allow 
refinement to change the current symmetry of the cell. 

This section also shows the cell information, the orientation angles and 
the mosaicity before and after refinement. 

• Start – the starting values for the cell parameters before the first 
refinement 

• Last – the values of the cell parameters after the last refinement. 
• Delta – the differences after refinement between Result and Last. 
• Result – the values of the cell parameters after refinement. These 

fields are editable, but that is not normally necessary or 
recommended. 

• Sigma – the error in the cell parameter after the last refinement. 
• Delta/Sigma – the refinement difference divided by the error. 

This can be used to determine if the refinement has converged 
(the value is 0 or very small 
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Parameter Description 
Detector In the Detector section, you can specify which detector parameters to refine. 

The Trans1 and Trans2 options refer to detector translations along the X and 
Y axes and Trans3 refers to the detector distance. The Rot1and Rot3 refer to 
rotations of the detector about the X-ray beam and Y axes, and Rot2 refers to 
the detector 2θ position. 

Source In the Source section, you can specify which source parameters to refine. Rot1 
and Rot2 refer to rotations of the source around the X and Y axes. Source 
parameters are typically not selected for refinement. 

Statistics This section is also read only and reports the refinement statistics 
• RMS residuals (in mm and degrees) 
• Reflections. These are reported counts for Total, Rejected, 

Accepted, and Excluded (masked out) reflections. 
I/SigI This specifies the I/Sigma(I) level below which spots are rejected and not used 

for refinement. 
Cycles The maximum number of refinement cycles to run. The refinement stops 

whenever it meets the convergence criteria or when it reaches this number of 
cycles. 

Rejection Limits These control when a reflection is rejected (i.e. not included in the refinement) 
if it has to be moved more than the specified amount 

• X max translational deviation in millimeters 
• Y max translational deviation in millimeters 
• Rot. Max rotational deviation in degrees. 

Macro The refinement procedure is usually driven by a multiple step macro. The 
recommended macro is Most. It is also possible to define a new macro or edit 
the existing macros, but this is not normally recommended. 

Refine On Refinement can work on either a selected Reflection List or Images (the 
default). 

Reflection List This is a drop down list that you only see if you have selected Reflection List 
as the Refine On selection. This lists all the *.ref files in the sample directory. 
It is normal to refine on dtfind.ref 

Image Selection Table If you have selected Images for the Refine On selection, you see the standard 
image selection controls. The default is to refine on the same images that were 
used in indexing. 

Test Mosaicity No longer used.  
Undo If you have done several steps of refinement, you can undo the last step by 

clicking on this button. 
State This is a brief form of the instrument state control (See Instrument State 

Display in chapter 4). It allows you to select a previous state. This allows you to 
back up more than one step. 

Additional Arguments If you are an expert in d*TREK, it is possible to enter additional d*TREK 
arguments that are passed to dtrefine. This is not normally recommended and 
may compromise the state information. 
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Parameter Description 
Refine Macro Editor It is possible to edit existing macros or define your own new macros. This is not 

normally needed or recommended. If you do feel the need to make a change, it 
is recommended that you create a new macro rather than editing the existing 
macros. 

 

Refine Cell Macro Editor 
The Refine Macro Editor pops up the following dialog: 

 
Note that the macro is updated immediately for local use when you make a change rather than with an 
explicit save or write button. However, to save the new macro or edits for later use or for use in other 
samples you must use the Save button on the Main dialog. 

Most of these controls replicate the corresponding controls in the main Macro window, so the list below 
only shows the edit controls themselves. 

Parameter Description 
Macro This is a drop down list of existing macros. Whatever macro you select is the 

currently active macro and edits are recorded directly into that macro for this 
invocation of the refine dialog. For this reason, it is suggested that you create a 
new macro before you edit any of the controls. 

New Macro… This pops up a dialog which allows you to enter a new name and to copy the 
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Parameter Description 
exiting values from another macro. 

 
Remove Macro Delete the current macro definition. Once it is gone, there is no way to restore 

this automatically, so you should be careful doing this. You are asked to 
confirm the delete. 

New Step Add a new step to the current macro (at the end of the step list). You are given 
the option to copy the step values from a step of the same name in another 
macro. 

 
Remove Step Removes the first step in the macro. This does not ask for confirmation, so be 

careful. 

 

Refine Cell Advanced Tab 
The Advanced tab is actually much simpler than the main tab for Refine.  
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Parameter Description 
Global refinement No longer used. 
Wide slice refinement This gives you the option to invoke a special refinement methods for wide 

sliced images (e.g., more than 3 degrees). However, for wide slice images (e.g 
on a RAPID or SPIDER) it is often better to use FS_PROCESS. You can open a 
d*TREK sample and index with d*TREK and then change the mode to 
FS_PROCESS to integrate. You need not refine with d*TREK at all in this 
mixed mode. 

Viewing refinement results 
If you have refined on images, when the step has finished running, the results are displayed graphically in 
the Image Display. This displays the image used by the step, and also shows the reflections used by the 
step. The reflections are color-coded according to their usage: 

• Blue circles – reflections used in the refinement 

• Red circles – reflections rejected from the refinement 

• Green circles – reflections ignored in the refinement. 

The displayed reflections also show, as short red line, the difference vector between the observed and 
calculated reflection positions. If your refinement results show more red circled reflections than blue, or 
have large difference vectors displayed, then you should consider using some of the solutions in the next 
section to help improve your refinement results. 

Improving refinement results 
If difficulties occur during refinement, use the following solutions. 

• If the starting crystal and detector properties are not close to the true values, you might increase 
the rejection limits so more reflections are included in the refinement. However, there is a danger 
they are increased too much and refinement diverges away from the true answer. It is sometimes 
better to use only low resolution reflections at first because the radius of convergence with them 
is larger. Then use high resolution reflections to get the more accurate results. With good 
reflection centroids, it is best to use all reflections. 

• Sometimes it is useful to fix or not refine a property. With input reflections found in a single 
image, the crystal rotation around the X-ray source and the detector rotation around the X-ray 
beam are correlated, so one of them should be fixed. The same is true for the detector translation 
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along Y and the detector 2θ rotation. It is a good idea to fix one of them. With input reflections 
from widely spaced rotation values, these correlations should not be a problem. The detector 
distance can be refined even with reflections from a single image, especially if you have a 
tetragonal or higher space group. 

• Sometimes refinement works better if you fix most properties and refine only a few at a time. 
Common sense should dictate the order of properties that are fixed and refined. For example, if 
you know the unit cell parameters from previous work, a, b, c and α, β, γ can be initially fixed. If 
the detector has just been moved, refine the detector translations first, then the crystal orientation 
angles, then the unit cell parameters, then everything. The detector distance should be fixed if 
there are reflections from a narrow rotation range and a crystal principal axis is nearly parallel to 
the source. 

Reduce Cell 

Cell Reduction may be required if: 

1. The wrong Bravais lattice was chosen during indexing. After integration, the cell parameters are 
known with more accuracy, enabling the user to select the correct lattice. 

2. The wrong cell Orientation was selected. Since the choice of cell orientation is arbitrary, it may be 
necessary to transform the data to match a cell orientation obtained from another program, or a 
separate CrystalClear sample. 

 
If all goes well, indexing a sample should be easy and automatic. However, in some difficult cases, 
determining the correct lattice might require some additional work. For example, after indexing a set of 
screening images, it might be unclear which lattice parameters should be used. Sometimes, this 
information is not readily available until the entire data set has been integrated. For this reason, cell 
reduction (i.e. determination of the correct Bravais lattice) is provided as a separate tool which can be 
executed before or after integration to alter the cell parameters.  

There is no dialog that pops up when you click Reduce Cell. It runs immediately and then presents you 
with the opportunity to choose the solution or change the residual and try re-run it. 
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Reduce Cell Results Table 

 
 

Parameter Description 
Input cell These are the current cell parameters and rotation angles when you click 

Reduce Cell. 
Max residual You can change the residual and re-run Reduce cell. For example, if there are 

no solutions proposed, you might want to double the Max residual and try 
again. 

Choose reduced cell The options that satisfy the residual specified are presented in a table. You 
should select the one that you think is right and want to use for the rest of your 
processing. 

Orientation You also have the option of changing the orientation. The results of this 
transformation is shown in both the Transformation matrix and Rot1-Rot3 
rotation angles. 

Accept Cell Once the parameters are set to your liking, you should click this button to 
accept the cell. If none of them work and you want to re-index or re-refine, then 
click Close. 

 

Predict Spots 
The Predict Spots step creates a reflection list with calculated reflection centroids that can be displayed 
on more or more images. It is typically used to confirm the results of the refinement step and to better 
estimate the crystal mosaicity if it was not refined previously. The step predicts the reflections to appear 
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on a range of images. When the step has finished, CrystalClear can then display the calculated reflection 
positions, based on the orientation matrix and unit cell, on the corresponding images. 

Predict can also be useful when configuring the system to make sure the goniometers vectors in the 
header are right. If the spots match for one scan, but not for another scan with different goniometer angle 
settings, then the goniometers vector is probably wrong and you should contact your Rigaku support 
person. 

Predict Spots Dialog 
 

 
 

Parameter Description 
Images Scan Table This is the standard image selection control for selecting the images to use. It is 

usually only necessary to predict on a few images in each scan. 
Clear All This is a short cut for clearing all the current image selection.  
Apply mask Selecting Apply Mask causes prediction to use the mask file specified in the 

Setup dialog (Detector tab) and ignore any reflections masked out by that file. 
If no mask file has been specified in the Setup dialog, it is as if the Apply 
Mask checkbox is unchecked 

Crystal mosaicity If not 0, the specified crystal mosaicity overrides the value found in the 
input header. Predict Spots uses this new value for subsequent 
calculations. 

Rotation Specifies a different rotation angle Begin and End in degrees. This 
overrides the values found in the input image header or in a previous 
option.  
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Parameter Description 
Resolution This is the standard resolution control which limits the resolution range 

for predicting reflections. 

Viewing the results of Predict Spots 
When Predict Spots has finished running, the results are displayed graphically in the Image Display 
view. This view displays the first image used by the step, and also shows the positions of the predicted 
reflections. The reflections are color-coded according to their type: 

• Blue circles – normal reflections 

• Red circles – reflections that were predicted, but are considered unusable (i.e., lie in a region that 
has been masked out, etc.). 

Estimating Mosaicity with Predict Spots 
Examining the predicted reflections displayed on an image can help determine if the mosaicity value used 
is correct or not. Although the refinement does a good job of estimating the mosaicity for sharp 
reflections, for weakly diffracting crystals or spots that have weak tails, it may be best to run the Predict 
step multiple times, each with a different mosaicity, in order to determine the best effective mosaicity. 

If there is a good match between visually observed reflections and predicted reflections, then the 
mosaicity is set correctly. If there are many predicted reflections that don’t match up with observed spots, 
then the mosaicity is probably set too large and the prediction should be run again using a smaller 
mosaicity. If there are many observed spots that are not predicted, then the mosaicity is set too small, and 
the prediction should be run again using a larger mosaicity. 

Using the results of a poor refinement can also artificially inflate the value of the mosaicity. If the crystal 
orientation refinement is poor, then a larger mosaicity is required to predict the observed reflections on an 
image. 

Troubleshooting Prediction Problems 
If you have predicted on multiple images, and the predictions look great on the first image, but are off on 
the second (and later) image, there are several possible causes for the problem. 

• It may be that the rotation range for the second image is not contiguous with the first image. Two 
images are contiguous if the starting angle for the second image is the same as the ending angle 
for the first image. If you are predicting on images that are not contiguous, or using a scan that 
has an image step that is different from the image width, make sure that they are specified as 
separate images in the To use field, rather than a sequence of images (i.e., 1,2,3 instead of 1-3). 

• It may be that the rotation axis direction is wrong.  

• If you predict on multiple scans and the first scans looks OK, but other scans with different 
goniometer axis settings do not match up well, you may have a problem with the goniometer 
vector information in your image headers. If you are processing data from a synchrotron beamline 
or a newly installed system, it is possible that the goniometer vectors in the header are wrong. 
Contact your beamline support people or Rigaku support staff if you suspect this is true. 

Strategy 
The strategy step uses the cell and orientation information to compute a data collection strategy that meets 
the completeness and redundancy conditions that you specify. You can only run strategy after you have 
successfully indexed your sample. By using strategy you can often greatly reduce the number of images 
that you need to collect and still have a complete data set. The output of strategy is a collection schedule 
which can then be selected in the Collect Images step described in Chapter 7. 
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The strategy algorithm predicts reflections for various settings of detector and goniometer axes and then 
selects ranges that meet the completeness, redundancy and other criteria and finally chooses the best 
combination as the suggested collection schedule. So this is essentially a search process and the 
parameters you enter control the settings that are searched.  

Strategy Main Tab 
It is usually possible to run strategy with just a few input parameters. Most of the complexity is hidden in 
the advanced tab and not normally needed. Unless you override these values in the advanced tab, the 
detector and goniometer settings for the data collection (distance, 2 Theta, etc) are taken from the screen 
images you collected. 

 
 

Parameter Description 
Search Resolution These are the standard resolution controls. 
Use redundancy If the Use redundancy box is checked, you need to specify the Minimum 

redundancy that is acceptable. 
Image rotation width 
(deg) 

This defaults to the image width that you used to collect the screen 
images, but if you want to collect with a different image width, you can 
specify it here. 

Completeness Strategy tries to reach the Target completeness you specify. The 
Tolerance is how close you must get to this target before Strategy is 
considered successful. So if your Target is 100% and the Tolerance is 
2% and Strategy can only get to 98.6%, this is still considered a success. 
However, 95.4% would be considered a failure. 

Automatically accept 
best possible 
completeness 

If you check this box then the best solution that Strategy can come up 
with is accepted. 

Anomalous If this box is checked then Strategy computes a strategy that optimizes 
the collection on Bijvoet pairs in order to maximize the anomalous signal. 
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Strategy Advanced Tab 
The advanced tab provides many more options to control Strategy. 

 
 

Parameter Description 
Distance The options for distance are: 
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Parameter Description 
• From current Sample. This is the default. The distance is taken from 

the distance used to collect screen images 
• Custom. If you select his, you can enter a different distances for the 

data collection 
• Automatic. Strategy calculates a suggested distance based on the 

Minimum Separation between neighboring reflections specified in 
pixels. This maximizes the resolution while maintaining the spot 
separation that you specify. You can restrict this distance either to the 
Hardware limits for your instrument or further Restricted limits that 
you specify by giving a Minimum and Maximum distance. 

2Theta The options for 2Theta are similar: 
• From current Sample. This is the default. The 2 Theta is taken from 

the distance used to collect screen images 
• Custom. If you select his, you can enter a different 2 Theta for the data 

collection 
• Automatic. For the first two options, Strategy produces a schedule at a 

single 2 Theta angle. Strategy calculates a set of scans which may have 
multiple 2 Theta settings. The Minimum detector overlap percentage 
that you specify controls this. You can select either Hardware or 
Restricted limits for the 2 Theta values that are produced. You can also 
check First 2Theta to specify the first 2 Theta setting to use. 

Computation 
speed/accuracy factor 

This factor ranges from 0.1 to 1.0 and controls how fast and how accurate the 
Strategy results are. The options are: 

• Very fast (0.3) 
• Fast (0.6) 
• Accurate (1.0) 
• Custom (enter a number between 0.1 and 1.0) 

Omega rotation For the scan axis (e.g., Omega), you have the choice of selecting either 
Hardware or Restricted Resolution limits. You can also check the Restrict 
rotation range per scan box which sets the maximum rotation that can be used 
for a single scan. If you set Fix scan rotation start, then all scans have a 
starting rotation angle value equal to the start of the allowed range specified. 
You can also check Zero omega using phi offset which counter rotates phi so 
that each scan starts at omega=0. 

Chi checks There is a drop down list with the most common chi (or kappa) angles to use in 
trying to generate a strategy. Each angle is separated by a comma, so 0,30 
means check at chi=0 and at chi=30. You can also enter your own values into 
this drop down list. 

Phi checks The most common phi angles are listed in the drop down, but you can also enter 
your own list. 

Calculate percentage 
overlapped reflections 

If this box is checked, the Current sample rotation width reports the rotation 
width from the main tab. In the Rotation width checks area you can specify a 
Minimum and Maximum rotation width to test. The Step parameter specifies 
the step size to use in testing. For example if you specify Minimum=0.5, Step 
=0.25 and Maximum=1.0, Strategy tests at 0.5, 0.75, and 1.0. 

Mosaicity Since the mosaicity plays a major role in spot size and overlaps, you have the 
choice of either using the mosaicity From current sample or specifying a 
Custom value. 

Use previous 
reflections 

If you have already collected data for this sample but would like to collect more 
data to increase the completeness and/or redundancy, you have the option of 
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Parameter Description 
using an existing reflection list by checking Use previous reflections. The 
reflection lists in the current sample appears in the drop down list. If the 
reflection list you need is in another sample or somewhere else on disk, you can 
click the Import Reflection File… button and import it to the sample and then 
select it. 

Output reflections If you check this box, Strategy creates a dtstrategy.ref file with the predicted 
reflections from the last run of Strategy. 

Strategy Results 
You can look at the results of the strategy calculation in dtstrategy.log, or you can go to the scan table in 
the Scan State Display or the Collect Images dialog. The latest strategy run should automatically be 
selected and you can review the settings for each scan. If you want to rerun strategy with a different set of 
parameters, both strategy collection schedules appear in the selection list, so that you can select each one 
in turn to compare them. 

Post Collection Steps 

Integrate Reflections 
The Integrate Reflections step integrates the reflections that appear on a range of images, producing 
intensity data. The step can be performed after the images have been accurately predicted. The operation 
may produce several reflection files that are merged as part of the integration. Although d*TREK can 
only integrate a single scan at a time, CrystalClear can integrate and merge data from scans with multiple 
goniometer angles in a single step by looping over each scan and performing integration on that scan and 
then merging the results. 

Before integrating reflections, you should create a mask file to define the shadow of the beam stop on the 
images (see the Image Display section in Chapter 4). Reflections intersecting with the shadow are 
excluded during data processing. Currently, CrystalClear can only use a mask file for images with a single 
2θ orientation. If you have multiple scans with different 2θ values and want to use a mask file, you need 
to run the Integrate step multiple times, integrating each scan separately, and then merge the results using 
the Processing>Reflection Lists>|Merge Reflections... menu to bring up the Merge Reflection Lists 
dialog. 

The amount of time required to integrate a data set depends on the number of images to be integrated, 
number of reflections per image, and computer memory and processing speed. With modern computers 
integration can normally keep up with image collection and so in d*TREK Integrate Reflections can be 
started before the Collect Images step has completed. The d*TREK code waits for each image file to 
show up in the image directory and then it integrates it as soon as the image file appears. This way the 
data integrated data is available very soon after the data has been collected. 

The integration in d*TREK is normally done with a 3D box that spans several images to include the 
whole reflection. 
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Integrate Reflections Main Dialog 
 

 
 

Parameter Description 
Scan Selection Table This is the standard image selection control for selecting the images to use. 

Usually you select all images. At the CrystalClear level you can integrate 
multiple scans at once. 
Right-clicking a field accesses the pop-up menu to select images using the 
Select Scan Images dialog. 

Select All This is a short cut for setting all the non screen images. This is what you 
normally use for integration. 

Clear All This is a short cut for clearing all image selection. 
Resolution These are the standard controls for setting limits on the resolution of the 

reflections which are to be integrated. Values of 0 for Min and Max are 
interpreted as meaning the whole screen. An option is provided in User 
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Parameter Description 
Preferences for switching the units from degrees to Angstroms. 

Images per batch Scaling and refinement are done in batches.  

• Scaling. In the Scaling: field, enter the number of images per batch to 
be used during scaling. 1 is a good number for macromolecular 
crystals, but if scaling and averaging fails you might want to increase 
this to something in the range of 2-5. 20 is a good number for small 
molecule crystals.  

• Refinement. In the Refinement: field, enter the number of images per 
refinement batch. 2 is a good value for viruses, 4 for most proteins and 
15 for small molecule crystals. After each refinement batch, integration 
does a refinement, re-prediction and integration. You may need to use a 
larger number of  images if 

o you are doing thin or fine slice data collection 

o your refinements are not stable 

o you have too few reflections per refinement 

 
Box A 3D box is used for integration. The Width and Height of this box are 

in millimeters. 0 means the d*TREK determines the box size 
automatically. If you do not set this to 0, you must specify the maximum 
width and height of the box in the Width and Height fields, respectively.  
 
A good estimate of the values to use can be obtained by examining the 
spots in the Image Viewer view to determine the size of the spots, and 
then multiplying that value by 3. When specifying an explicit box size, 
try not to choose a size that includes more than half of a neighboring 
spot. Also do not make the spot size too small; leave a border around the 
spot for background determination. Note that when you explicitly set a 
box size, you are setting a maximum box size, and that integration may 
adjust the box size used to be smaller. 

Padding In the Padding field, set the number of images to use for padding. Padding is 
the number of images added to the integration volume both before and after the 
predicted rotation width of a reflection. Padding allows for a shift of the 
predicted peak position or change in crystal mosaicity. For wide-sliced images, 
0 or 1 is a good value, and for fine-sliced images, use 2 or 3. If the crystal 
mosaicity is significantly smaller than the image width, you may want to set the 
padding to 0. In this case, 0 does not mean use the default since it is a valid 
value. 

Batch prefix In the Batch prefix field, set the prefix that you want to use for each scan. You 
only need to set this if you have multiple scans and are integrating each scan 
separately. If you are integrating multiple scans in a single run of the Integrate 
step, the prefix is automatically changed for each scan. 

Mask file This gives you the final chance to specify a Mask file for integration. 
Integration results are normally more accurate if you use a mask file so it 
is normally recommended. 
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Integrate Reflections Advanced Dialog 
The Advanced tab for Integrate offers a lot more control, but is recommended only for expert users. 

 
 

Parameter Description 
Perform profile 
analysis When this box is checked (the default), then profile analysis is performed 

during integration.  

• Number. In the Number field, enter the number of reflections to use 
when creating reflection profiles. 50 is a good number for most 
macromolecular crystals, and 20 or 10 for small molecule crystals. 

• Maximum Images. In the Maximum images field, enter the 
maximum number of images to use when creating reflection 
profiles. 7 is a good number for most macromolecular crystals, 
and 20 or 10 for small molecule crystals. 

Refinement macro Refinement is performed during integration. The refinement macro used for this 
refinement is in a drop down list. The default is Most. You should only change 
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Parameter Description 
this is there are special reasons why the Most refinement is not working. 

Find reflections and 
refine before 
integration 

Integration needs to know where to expect reflections. This is usually done by 
predicting the reflections based on the current cell parameters and orientation 
matrix. However, if you check this box it is possible to do Find and Refine 
steps on the images.  

• Images. This drop down has various options for how many 
images to use in the Find process. Note: The number of pre-
refinement images is calculated as the product of number of images per 
batch (for refinement, main tab) and number of batches. At the start of 
integration, if the software determines this is too few images, it 
increases the number automatically 

• I/Sigma. Specifies the minimum I/Sigma need for a pixel to be 
considered part of a spot. 

Predict reflections and 
refine before 
integration 

This is normally checked on. It uses the Predict function to predict the 
reflections that are on the image you are integrating. 

• Images. This is the number of batches that you want to use for 
prediction (i.e. Refinement batches). 

Ice rings This table allows you to define ice rings or other powder rings. If a reflection 
profile falls within these rings, it is not integrated. For each ring you define 

• Min Resln. The inner resolution boundary of the ring. 
• Max Resln. The outer resolution boundary of the ring. 
• Add. Add another resolution ring 
• Delete. Delete the current selected resolution ring 
• View. Display the resolution rings on the currently open image in 

the Image Display. 
Fixed Mosaicity The integration process normally refines the mosaicity as it is progressing. You 

can lock the mosaicity to a fixed value by checking this box. 
• Fixed value. If you know the mosaicity, you can fix it a specific 

value. 
• Use current value. This uses whatever the current value of the 

mosaicity is before you start integration. 
Mosaicity model In the Multiply and Add fields in the Mosaicity model section, enter the 

mosaicity model multiplier (MosMul) and addend (MosAdd). The mosaicity used 
during integration can be modified using the equation: 

MosUsed = MosRefined × MosMul + MosAdd 

where MosRefined is the mosaicity from refinement. When MosMul = 1 
and MosAdd = 0, the refined mosaicity is used during integration. When 
MosMul = 0, the value of MosAdd is used as the mosaicity during 
refinement and results in a fixed mosaicity. 

Check Overlaps Select the Check Overlaps option if you want integration to check spots for 
overlap with adjacent spots. When enabled, spots that significantly overlap 
neighboring spots are excluded from integration. 

• Maximum fraction. A spot is flagged as overlapped with the fraction 
of intensity shared with neighboring spots is greater than or equal to the 
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Parameter Description 
value specified. 

Wait limit d*TREK waits for images to show up during integration. This allows you to 
integrate as you are collecting data. However, there needs to be timeout in case 
collection stops prematurely for some reason. This specifies the maximum 
number of seconds to wait for the image to show up. 

Minimum valid pixel In the Minimum pixel value: field, enter the minimum pixel value that can 
appear in a spot. Spots that contain pixel values less than the value specified 
(even in their background) are excluded from integration. 

Display 
images/reflection lists 

When this is checked the images and the reflection lists are displayed as they 
are integrated. This gives a good visual feedback to insure that integration is 
proceeding as expected, but does slow down the process. 

Generate ellipsoid info Select the Generate ellipsoid info option if you want to turn on generating 
profiling ellipsoid information. Turning this one increases the processing time. 
The results are stored in a file ellipsoids.ref. 

Viewing the Results of Integration 
While images are being integrated, the results are displayed graphically in the Image Display if the View 
Image Processing Updates icon in the main toolbar is enabled. This slows down integration somewhat, 
but can be useful especially if you suspect that there might be problems. This view displays the current 
image being used by the step, and also shows the positions of the reflections being integrated. The 
reflections are color-coded according to their type: 

• Blue– normal reflections 

• Red– reflections that were predicted, but are considered unusable (i.e., lie in a region that has 
been masked out, etc.). 

• Green – excluded reflections (high Lorentz and polarization corrections, etc). 

If you have disabled filtering of reflections based on rotation range in the image viewer , the 
reflections are displayed as a mixture of circles and squares. Circles are reflections that should appear on 
the image based on the mosaicity (ignoring systematic absences), and squares are reflections that should 
not appear on the image. You should see spots in the circles, and no spots in the squares. 

Once integration has finished, you should examine the Summary table to determine if any problems 
occurred. If the parameters drift too much, you may need to fix them and run the Integrate step again. 

Scientific Description 
This section describes how integration works in d*TREK and discusses issues that help you understand 
the process so that you can set the parameters in the Integrate step to get the best results. The Integrate 
step process a collection of single-crystal, X-ray diffraction images, generating a list of intensities 
describing crystal diffraction data found on the images. 
 
More formally, a list of estimated intensities and standard deviations is calculated for each Bragg 
reflection appearing on the data images. The resulting data are stored as a list of reflections which can 
later be scaled, averaged, or manipulated using other CrystalClear tools, such as Scale and Average. 
After integration, the resulting diffraction data are encapsulated completely in a single reflection list file 
and may be processed without further reference to the original data images.  
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Basics 
The single most important algorithm in the entire d*TREK suite is integration. An understanding of its 
basic operation is essential for all users. Before attempting to run the program, become familiar with its 
overall operation (described below). The basic operation of d*TREK integration is performed by 
dtintegrate and dtprofit and is conceptually simple: 

1. dtintegrate uses the crystal lattice parameters (obtained from Index Spots) to predict the location 
of Bragg reflections on the images.  

2. dtingegrate then, grabs the reflections off the images by drawing a box around each predicted 
diffraction peak on each image.  

Depending upon the intensity of the diffraction spot found inside each box, a special algorithm is used to 
localize further the spots inside the small, two-dimensional ellipsoidal areas. Each ellipsoidal area is 
chosen to be the smallest possible region that still covers all statistically significant diffraction 
information. At the same time, diffuse X-ray background and/or detector-dependent background is 
subtracted from the summed intensity of each spot, and an estimate is made of the statistical variance. 
 
This process is repeated for all the images provided to dtintegrate. Because diffraction spots often 
straddle two or more images, dtintegrate merges the information from spots occurring on multiple 
images. The resulting data are collected in a reflection list that is indexed according to the Miller Index 
(hkl value). 
 
The dtprofit program is also used (optionally) to obtain estimates of the reflection profile shapes of spots 
collected with dtintegrate. A profile is a mathematical model of what a spot looks like on the detector 
plate and is a tool used to obtain better intensity estimates for weakly diffracting data. dtprofit calculates 
empirical profiles and uses them to adjust the intensities of weak data by fitting each spot to a profile 
shape. More generally, dtprofit fits weakly diffracting data to two-dimensional profiles generated from 
strongly diffracting data and uses the fitting parameters to estimate reflection intensities. 
 
The purpose of the following sections is to address the issues involved with integration and to familiarize 
the user with problems that may be encountered during an integration run. The documentation in this 
section has been arranged topically, so as to allow the reader the freedom to target specific integration 
issues. For each issue, helpful hints are provided.  

Refinement 
To integrate the intensities of Bragg reflections in a single crystal diffraction experiment, their positions 
in images must be predicted accurately. This may be done provided that information about the source, the 
crystal, the crystal goniometer, the detector, the detector goniometer, and the sample rotation is known. 
For the predictions to be accurate, the crystal, source, and detector properties must be refined by 
minimizing the differences between the observed and the predicted reflection positions. 
 
To predict accurately the reflections for images collected after the start of a scan, the properties of the 
crystal, the detector, and the source should be refined periodically throughout integration. Experience 
shows that the values for the detector and source may change during the course of an experiment, 
therefore it is best to refine these values as one would refine the crystal properties. Moreover, crystal 
properties may change as the result of radiation damage and of incorrectly mounted crystals (i.e., the 
crystal can dry out or slip, which would change the unit cell parameters and the crystal orientation). 
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When does refinement occur? 

To predict spot locations accurately (or just to be on the safe side), dtintegrate should be configured to 
refine spot positions periodically. dtintegrate allows the user to specify how often refinement is to take 
place and allows for an optional pre-refinement to take place before integration is started. The pre-
refinement makes sure that the spot centroid predictions are good before starting the integration. The user 
is highly encouraged to enable this feature (Predict reflections and refine before integration in the 
Advanced tab). 

Refinement Cycles 

During refinement, an algorithm is used to detect convergence automatically. If the calculated spot 
centroids are already close to the predicted spot centroids, refinement may need to execute only a few 
cycles before terminating. This should be the case for most of the refinements executed during 
integration, with the possible exception of the pre-refinement done at initialization. If for any reason, the 
number of cycles should increase greatly, it is wise to investigate the input images for possible problems.  

Mosaicity 

Perhaps the single, most important refinement parameter is mosaicity. Mosaicity (discussed below in its 
own section) is refined along with other parameters and is used to predict the width of reflection spots. 
Unlike the other refinement parameters though, it is not uncommon for mosaicity to vary widely (but 
smoothly) during an experiment. The user should track the mosaicity (summarized in a table at the end of 
the dtintegrate log file) and check for abnormalities, such as sudden dips or jumps in mosaicity values. 
This is often symptomatic of goniometer head problems, slipping crystals, or mis-refinement of spot 
centroids.  

Errors with refinement 

Refinement usually functions well and need not be of concern for most data sets. Nevertheless, if 
problems or abnormalities in the data do occur, these problems often become obvious in refinement. If, 
for example, hardware related problems are experienced, it is likely that the refinement begins to display 
abnormally high residuals. 
 
For this reason, a table summarizing the refinement parameters is printed at the end of dtintegrate to aid 
in troubleshooting. This table is helpful for spotting which images are beginning to manifest unusual 
refinement parameters and high root mean squared (RMS) residuals. It is highly unusual for refinement to 
fail after it has locked into a solution. If this should happen, it is likely that a problem occurred during 
data collection. 

How often does refinement happen? 

dtintegrate allows the user to specify how many images are processed between each refinement. The 
number of images selected should be to a small number (2-20 images) so refinement may take place 
frequently. This is specified in the Refinement parameter under Images per batch. If too many images 
are processed between refinements, it is possible that the detector parameters would change so much that 
refinement would be unable to lock in to a new solution. The most common instance of this occurs when 
the user fails to do a pre-refinement and, therefore, dtintegrate gets off to a bad start.  

NOTE:  Refinement requires a minimum of 50 reflections before it tries to execute. For smaller lattices, 
this might cause refinement to take longer than the specified number of images before 
executing a new refinement. Normally, this should not cause a problem, but may cause 
confusion if the user expects an integration to occur every few images and fails to get one. On 
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the other hand, an integration log file that completely lacks periodic refinement output tables is 
suspect and is a good indication that pre-refinement never locked in to a solution in the first 
place.  

Box Dimensions 
As mentioned in the general outline of dtintegrate, each spot is extracted from its data image by drawing 
a rectangle around the predicted two-dimensional (2D) centroid and placing all pixels inside the rectangle 
into memory. Therefore, be sure that the box is large enough to contain the entire spot, while 
simultaneously keeping the box small enough to avoid excessive memory usage (see section on Memory 
and disk).  

Importance of choosing a correct box size 

The Overview of this section (above) states that the 2D box is ideally the smallest box that covers most 
spots found in the images, with a little room to spare. Because of the wide range of images that d*TREK 
is designed to process, it is impossible to decide before hand (without looking at the spots on the images) 
how big this box should be. Probably a 40 x 40 pixel box would cover most cases, but this may be 
excessive. For this reason, dtintegrate makes an initial guess about the size of the box and dynamically 
refines its guess as it gathers a better idea of what spots look like on the detector.  

Initial determination of global box size 

An initial guess about a global box size (a box size that is appropriate for most spots) is determined by 
examining the average spot size found during the indexing stage of processing. If this information is not 
available, it is assumed that the average spot is 10 x 10 pixels. This average spot size is then multiplied by 
a spot multiplier, which takes a default value of 2.8. Thus, a default window is 28x28 pixels (provided 
that no information of spot size is passed to dtintegrate). This box size is used initially to start 
dtintegrate. 

Dynamic determination of local box sizes 

Once dtintegrate has a box size to work with, it can start collecting spots. As it collects more and more 
spots, it acquires a better idea of what the spots look like in different parts of the detector and can start 
choosing the box size of each spot as a function of its position on the detector. Each part of the detector is 
soon assigned a best box size on the basis of cumulative observations made as integration proceeds. This 
local method has advantages over using one global box size for the entire image. Experience has shown 
that spot sizes sometimes vary considerably over different parts of an image because of crystallographic 
and geometric factors. As with the initial global box size determination, the local box size is related to the 
local spot size by the window multiplier. 

Neighboring spots 

As a safeguard against box sizes that become too large, a method is used to limit box sizes so that they do 
not encroach too much on neighboring spots. In practice, a box should never be large enough to cover 
entirely a neighboring spot found on the same image. A box that becomes this large is too large and 
should be restricted to a reasonable size. To solve this problem, an algorithm is used to restrict each box 
size so that it does not grow to include more than one half of a neighboring spot. 

NOTE: This restriction never goes into effect unless the spots are nearly overlapped on the image. 

Errors with box dimensions 

Most box dimension errors occur when the box dimensions are systematically chosen too small. The tell-
tale sign of this is a high number of on-edge errors in the error tables at the end of dtintegrate. An on-
edge error occurs when the spot found in a box is too large to be covered entirely, thus causing the spot to 
butt up against the edges of the box or actually to jump outside of it. In addition, a box that is too small 
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might have background estimation problems. The background of a spot is determined by using the pixels 
that are inside the box, yet outside the spot ellipsoid (see section on Ellipsoidal localization). Even if the 
box manages to barely cover the spot, very few pixels may be left for background determination, thus 
creating problems. 

NOTE:  The box size is a very crucial parameter and can greatly affect the number of reflections 
rejected in the data set. Fortunately, the automatic box size determination is robust, therefore 
the user hardly ever needs to override the default operation. 

User specified box dimensions 

On the rare occasion in which the user might wish to override the default operation, a fixed box size may 
be specified. When choosing this feature, the user effectively disables all automatic box size 
determinations and forces every box to have exactly the same size. This feature should be used with care 
and only when the automatic box size determination fails. The parameters are in the Box section of the 
Main tab. 

Mosaicity and Reflection Widths 
Mosaicity is a number that relates the position of each reflection on the Ewald sphere (as it is diffracting) 
to its expected width in degrees (i.e., the number of images that it intersects). The function that computes 
this relationship is known as the mosaicity model. This function also accounts for a variety of other 
effects, such as the x-ray spectral dispersion, errors in Lorentz factors, and beam divergence positions of 
the reflections. Fortunately, these other variables are either known fixed values or may be computed 
easily during the integration. Mosaicity, on the other hand, is not fixed and may be expected to vary over 
the course of an experiment. 
 
As mentioned in the general overview, each reflection is actually the amalgamation of one or more spots 
collected on adjacent images. The number of images on which a reflection is found is a function of its 
mosaicity- dependent width. The larger the width, the more images the reflection lies on and the more 
spots that must be collected to obtain the entire reflection. Mosaicity is, therefore, the primary variable 
that determines how many 2D spots must be collected and processed for each reflection.  

Importance of choosing a correct mosaicity 

Mosaicity is important for two reasons: 

1. For strong spots, it provides a way of determining which spots go with which reflections. For 
example, two spots on two adjacent images might belong to distinct reflections (i.e., the 
reflections have different hkl values). Nevertheless, if the mosaicity is too large, the spots might 
become lumped into a single reflection with a large width. This would be incorrect. 

2. For weak spots (where the spots are perhaps only 2 sigma above background), it is important to 
know the mosaicity because the actual spots are not there to help us. When integrating weak 
spots, the calculated reflection width must be known. Fortunately, much of the weaker data 
spends less time in the diffracting condition and, thus, is likely to have a lower rotation width. 
This, in turn, helps to make the data less sensitive to the mosaicity value than one might expect.  

Safeguards against bad mosaicity values 

Even when the mosaicity value is unreliable, it should be noted that dtintegrate uses a variety of other 
techniques as safeguards against mosaicity values that predict incorrect or inaccurate rotation widths.  
First, dtintegrate allows the user to specify a padding value (Padding on the Main tab) that tells 
dtintegrate how many images beyond the current image it is allowed to search to find additional spots 
belonging to the reflection. This affects primarily the strong data containing spots that would otherwise be 
ignored because a reflection width was too small (i.e., the mosaicity was too small). 
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Second, dtintegrate makes sure that each spot is contributing to one reflection only. If for example, the 
mosaicity is too large, some spots lying half way between two reflection centroids might get included in 
both reflections. To solve this problem, a special algorithm, taking crystallographic considerations into 
account, assures that every spot is included in one reflection only. 
 
These safeguards keep the effects of bad mosaicity values down to a minimum. However, it should be 
noted that weak data are much more susceptible to bad mosaicity values and are still affected. 

Initial value of mosaicity in input to dtintegrate 

So what is a good initial value for mosaicity? Mosaicity may not be well determined prior to integration. 
During the prerefinement step of integration, a reasonable initial estimate of the mosaicity is made (see 
section on Refinement). It is also possible to visually refine the mosaicity by running the Predict Spots 
steps with different Mosaicity values until the prediction looks good. The determination of mosaicity is 
probably the best reason to always do a pre-refinement. Once the mosaicity is set, it should vary only 
gradually as the experiment progresses.  

Fluctuating mosaicity 

The degree to which mosaicity can fluctuate without significantly affecting data quality is dependent 
mostly on the image rocking width and the size of the crystal lattice. In general, smaller lattices and/or 
larger rocking widths tend to exhibit greater fluctuations of the refined mosaicity value than larger lattices 
and/or smaller rocking widths. For example, smaller lattices (on the order of 20 to 40 Å on an edge) can 
sometimes exhibit statistical mosaicity variations exceeding 50% of the average mosaicity value!  
 
This behavior should be regarded as being undesirable because it severely affects the integration of weak 
data, which must rely highly on the calculated rotation width. If this kind of randomly fluctuating 
mosaicity is exhibited during integration, it may be wise to disable the automatic mosaicity. 

Fixing the mosaicity 

Fixing the mosaicity is sometimes a necessary step for data sets that do not exhibit stable mosaicity 
profiles. Using the value from pre-refinement (or from a previous refinement done by Refine Cell) is 
often a wise choice that probably improves data quality. Ideally, however, one should rarely need to resort 
to this option.  

Image Issues 
d*TREK has been designed to accommodate a large range of detectors, image formats, and data 
collection techniques. A position-sensitive detector creates an image file from the photons that it has 
detected during an exposure of the sample. An image contains a 2D array of values that usually 
correspond to the number of counts detected at each pixel location on the detector. Images need to be 
corrected for deficiencies introduced by the detector and experiment. For example, electronic position-
sensitive detectors geometrically distort the detected signal, such as a diffraction pattern. Each component 
of these detectors—phosphor, fiber-optic tapers, lens, image intensifiers, SIT tubes, and CCDs—
introduces potential problems that are difficult to avoid when designing and building detectors. Software 
is used to correct for the deficiencies in images introduced by the hardware. 
 
The deficiencies in the images are spatial distortions, pixel inhomogeneity of response, saturated pixels, 
defective pixels, and pixels blocked by beamstops. To treat these problems effectively, additional 
information, such as a mask file, needs to be specified to the processing program. 

Defective pixels 
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Defective pixels arise for a number of reasons. A defective pixel is one that does not give a count 
that is proportional to the photons registered. Some pixels are dark, that is, they always yield 
zero or very low counts. Other pixels are always bright; they give high counts that are 
independent of the photons detected. Still, some other pixels can give random counts. Defective 
pixels must be flagged and not used by a data processing program. A mask file is used to flag 
defective pixels. 

Saturated pixels 

A saturated pixel is one for which the counts are beyond the range within which they are 
proportional to the detected photons. Each detector can exhibit both local and global saturations. 
The data processing software needs to detect and treat Bragg reflections with saturated pixels. 

Spatial distortions 

Spatial distortions need to be corrected so that pixels can be accurately mapped to millimeters 
and vice versa. These mapping functions predict where Bragg reflections fall on the detector and 
on the millimeter coordinates of peaks found in images. Most detectors (including all Rigaku 
detectors) produce corrected images, and a simple pixel size (e.g., 0.1 mm x 0.1 mm) may be 
used. For other images, d*TREK needs spatial distortion tables that d*TREK can create using 
the dtdistor or the dtcalibrate program.  

Inhomogeneity of response 

The inhomogeneity or nonuniformity of response needs correction so that counts in individual 
pixels may be correlated with the incoming signal (photons). Response may vary over the 
detector because of variations in phosphor thickness, fiber-optic taper properties, pixel area, 
fixed-pattern noise, and other electronic noise. Again, these corrections are usually made before 
an image is written to a file, but d*TREK can apply the corrections later if a nonuniformity of 
response file is available.  

NOTE: This nonuniformity of response file cannot be created by the users because they lack 
the needed specialized calibration setup. The file is created by Rigaku after performing 
careful experiments with the dtcalibrate program. This is done when the detector is 
being tested and released from the factory, so generally you do not need to worry 
about this. 

Varying beam intensity 

Laboratory X-ray sources are stable and generally produce a stable beam. By contrast, 
synchrotron sources produce a beam that varies in intensity because of changes in the number of 
particles and their orbit within the synchrotron. Sometimes, a beamline has an incident beam 
monitor. The counts from such a monitor may be applied by the dtintegrate program. 

Oblique incidence factors 

X-rays are absorbed by matter, which includes the air between the X-ray source and the crystal, 
the air between the crystal and the detector, the phosphor of the detector, and any covering of the 
detecting element (i.e., black paper, beryllium, etc.). Corrections depend on the thickness of the 
absorbing matter and are of two types: 

1. Type 1 reduces the number of counts seen in the detector, that is, X-rays are absorbed.  
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2. Type 2 increases the number of counts seen in the detector. This would occur if the travel 
path in a phosphor that converts X-ray photons to light photons is longer than a standard 
reference path.  

Spot Localization 
After a box has been drawn around each spot, it is the task of the ellipsoidal localization 
algorithm to find the smallest area that covers the diffracted spot. A smaller area is preferred 
because this reduces the contribution of background noise to the summed peak intensity. After 
each spot has been assigned an ellipse, another algorithm verifies that the spot has been mostly 
covered by the ellipse and that the covered peak shape is consistent with the expected profile of a 
diffraction peak (i.e., it is not a zinger or a streaked spot). 

Choosing an ellipsoidal area for strong spots 

For strong spots, the algorithm tries to draw an ellipse around the most intense pixels of the spot 
and, then, expand the ellipse to cover the less intense pixels in the spot. The resulting ellipse 
should be located well within the 2D box and should have its edges at or near the calculated 
background level (see section on Background Determination). At the same time, the ellipse 
should not violate crystallographic constraints by getting too near to other spots on the image 
plate. Given that all of these conditions hold, the spot intensity is calculated using all pixels 
falling inside the ellipse.  

Choosing an ellipsoidal area for weak spots 

Because the ellipse for strong peaks is fully determined by three numbers, it is possible to store 
and calculate the average of these three numbers and use the average to predict what an ellipsoid 
for the weak spots will be. Thus, for weak spots, the average ellipsoid shape of nearby strong 
spots is used to calculate an ellipse (because one cannot see what the weak spots look like, it is 
preferable to use the information from the strong spots, if they are available). At the same time, 
systematic differences between observed spot centroids and calculated spot centroids for nearby 
spots may be taken into account so that the weak spot centroid is shifted appropriately.  

On-edge errors 

On-edge errors occur when the spot ellipsoid jumps outside of the bounding box. This is caused 
either by badly refined detector parameters or by a box size that is too small (see section on Box 
Dimensions). If many on-edge errors occur, then these two things should be checked first. These 
errors have also been known to occur with very noisy images, when determining the ellipsoidal 
shape can become problematic.  

Crystallographic bounds 

Even for ellipsoids that lie well within the bounding box, problems can sometimes crop up when 
the ellipse covers pixels that should belong to the spots of other reflections. Whereas overlapped 
spots are eventually detected by the overlap detector (see the section on Overlaps under Merging 
reflections), one can still benefit by rejecting spots that seem to intrude into the space of other 
spots. Such spots might have large thermal diffuse scatter or streaks resulting from bad optics or 
detector problems. In either case, it is wise to reject them as soon as possible so that they do not 
affect spot shape calculations or centroid calculations. Any reflection containing spots that are 
rejected in this manner are flagged with an hkl error. 

Weird spot shapes 
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Sometimes, spots that are affected by zingers or twinned reflections have bizarre spot shapes. 
These reflections sometimes have a poor bounding ellipse that only partially covers all 
statistically significant pixels. If, for any reason, the ellipse fails to cover some of the spot, it is 
rejected. 

Fuzzy spot shapes 

On the other hand, spots that do not fit fully into their ellipse are not necessarily abnormal. A 
noisy detector or a detector with raster problems sometimes has fuzzy edges that might cause the 
ellipse to cover too few pixels. If this is the case, then the spot is flagged as being fuzzy but is 
still processed. Fuzzy spot errors are printed in the summary table at the end of dtintegrate.  

Merging Spots into Reflections 
Perhaps the single, most difficult task in integration is deciding which spots belong to which 
reflections. As mentioned in the mosaicity section, this task is accomplished by looking at the 
reflection widths calculated as a function of mosaicity. However, there are other finer points that 
must be considered when merging spots. In particular, one must ascertain that the spots merged 
actually represent significant data, and that the spots do not overlap other reflections. Checking 
these things when merging the spots can improve data quality.  

Integrating noise 

Reflections that are composed of three or more spots sometimes contain most of their intensity in 
the centermost spot and only a little bit of residual intensity in the endmost spots. If the 
integration routine used all of these data, there is a possibility that the variance of the data would 
actually go up as a result of the extra background noise that is inevitably added. For this reason, 
strong reflections (say 5 Sigma above background) do not include weak spots (say 2 Sigma 
above background). On the other hand, weak spots continue to use all the data available.  

Diffuse tails 

When merging the spots in a reflection, the spots that lie farthermost from the reflection’s 
rotation centroid are called the tails. The spots in the tails are often significantly weaker than 
spots located close to the rotation centroid, but are visible only on strong reflections. Sometimes, 
however, very strong reflections exhibit abnormally long diffuse tails that can drag on much 
farther than the actual width of the spot calculated from the mosaicity model.  
These diffuse tails may be caused by thermal diffuse scatter or by X-ray source problems that 
affect the Ewald sphere. Unfortunately, this phenomenon might mislead integration to think that 
the mosaicity is larger than it actually is. To correct for this, the rotation widths that are used to 
refine the mosaicity are trimmed so that they include only the strong spots in each reflection. 
This tends to result in a slight underestimation of the mosaicity, but this is corrected for when 
padding is used.  
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Detecting overlapping spots 

When spots are close together (perhaps as the result of a large crystal lattice), they sometimes 
intersect on the same image. On the other hand, if the reflections have large rotation widths, they 
might intersect with each other on different images. In either case, one can imagine that the 
overlapping pixels that are shared by any two reflections are, in fact, somewhere in the no man’s 
land between them. 
 
Reflections containing overlapping spots are called overlaps and are treated all at once 
immediately before profile fitting. A special algorithm traverses through the accumulated 
integration data and attempts to find pixels that are contributing to more than one reflection. For 
each pair of intersecting reflections, a sum is made of the total intersecting intensity. For each of 
the reflections, if this sum is larger than a user specified fraction (see section on -checkoverlaps 
option) of the reflection intensity, then the reflection is rejected as being overlapped. This may 
sometimes lead to the rejection of one of the intersecting reflections but not of the other. If for 
example, a weak reflection intersects a strong reflection, it might be that the weak reflection’s 
intensity is compromised more than the strong reflection, leading to the rejection of only the 
weak reflection. 

Large numbers of overlaps 

If the integration output should happen to report a large number of overlaps, it is recommended 
that the user investigate the spots in the image for overlaps. If overlaps are not immediately 
visible, it might be that the overlap checker has been configured to be too sensitive. Consult the 
Overlaps table to determine the best value for the overlap parameter.  

Background Determination 
This section gives a brief description of how background is calculated in dtintegrate and of 
possible problems that might arise during the computation of the background. 

Local background determination 

It is generally acknowledged that using a local background near a spot is preferable to using 
backgrounds calculated far away from the spot. Also, because of changes in beam intensity or in 
detector plane fluctuations, it is best to accommodate the possibility that background might 
change for the same pixel on different images. Thus, the best algorithm calculates backgrounds 
on a per-spot basis, using pixels near the spot. Assuming that all pixels in a spot’s bounding box 
are near, one can simply use pixels that are not on the spot (but in the bounding box) to calculate 
backgrounds. This is another reason why it is important to choose a sufficiently large spot 
multiplier (see section on Box Dimensions). 

Fitting to planes 

A two-step algorithm is used to compute backgrounds: 

1. An average and standard deviation is computed for all pixels in the bounding box. These 
numbers implicitly define a set of 3 sigma pixels that are marked as being significant and 
are not used in the background determination. 

2. All pixels adjacent to a significant pixel are flagged as border pixels. These pixels are 
also excluded from the background calculations. 
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Also a best fit plane is computed using all unflagged pixels in the bounding box. Deviations are 
computed from this plane to obtain a background variance to be used when calculating spot 
statistics. 

Compute time required for background calculations 

Background determination is the most time consuming process in dtintegrate requiring perhaps 
one third of the total execution time. Although computationally simple, the floating point 
calculations are time consuming and must be determined for each spot. The algorithms have 
been designed to reject any pixels that might affect the accuracy of the background. 

Failures to find background 

Most failures to find a background are reported when a spot butts up against the image edges or 
when the bounding box size has been fixed to a number that is too small. In dtintegrate, it is 
required that at least 10% of the pixels in each bounding box contribute to the background. Thus, 
background errors are reported when a very large spot occupies a very small box. Also, noisy 
images tend to produce faulty backgrounds because the noise is interpreted as being significant 
and, therefore, is not used in the background.  

Disk and Memory Requirements 
As dtintegrate processes the input data, it is doing three different tasks, each requiring memory and disk 
space: 

1. Read the input images one at a time.  

2. Copy pixel values from the image into a 3D array for each Bragg reflection 

3. Integrate and profit profile fit the reflections.  

Of these three tasks, the first one needs very little memory, but the second and third use quite a bit of 
memory. Fortunately, dtintegrate offers ways of minimizing the memory usage or the disk usage, 
depending upon which is the limited commodity (see sections below on How to save memory and How to 
save disk space).  

Memory for 3D reflection integration 

By far, most memory required by dtintegrate is used to store the pixel values around the predicted 
position of the Bragg reflection. Thus, all of the memory for reflections (including bounding boxes) must 
be queued in memory. This means that the amount of memory required by dtintegrate is a function of the 
average number of pixels in each reflection and of the average number of reflections per image. Images 
with many reflections and a high mosaicity require the most memory, whereas images with only a few 
reflections require less. Likewise, larger unit cells require more memory. 

Memory for profile fitting 

Profile fitting can also require a lot of memory. Most of this memory is used to load in and build 
reflection profiles, which must apply to overlapping images (see section on Profile Fitting). Because 
profile fitting is performed at the end of integration from data written periodically to scratch files during 
integration, the memory used can skyrocket until the profile fitting has terminated. 
 
Abnormal termination from lack of memory or disk space 
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Integration tries to exit gracefully when the disk drive is full or when it fails to allocate memory. 
Nevertheless, many operating systems have difficulty recovering when all available disk space has been 
used up, and some either hang or terminate applications when all available memory is exhausted.  

Profile Fitting 
After integration, a post-processing algorithm is used to profile the shape of each reflection. A profile is a 
mathematical model of what a spot looks like on the detector and is a tool used to obtain better intensity 
estimates for weakly diffracting data. The basic principle that underlies profile fitting is that reflections 
that are near each other on the detector have similar spot shapes and similar intensity distribution within 
those spot boundaries as they pass through the diffract condition. Thus, a weaker reflection (one that 
diffracts less) should be a less intense copy of some nearby strongly diffracting reflection.  
 
The assumptions of profile fitting are that reflection positions can be predicted accurately that accurate 
profiles can be obtained by averaging non-weak spot shapes and that the significant data in the weak spots 
cover several pixels, it follows that the estimated variance of a weak spot obtained from profile fitting is 
lower than the estimated variance obtained from summing up pixel counts. 

Laue Check 
The LaueCheck step analyzes the integrated data to determine the Laue symmetry for the crystal. The 
Laue symmetry determination is done by averaging the data for each Laue symmetry group, and then 
comparing the Rmerges to determine the correct Laue symmetry. 

Laue Check Dialog 

 
 

Parameter Description 
Reflection list The normal reflection list to use is dtprofit.ref. But it is possible to use other 

reflection files. 
Average Bijvoets Select the Average Bijvoets option if you want to force the check to average I+ 

and I- in Bijvoet pairs. If this option is not selected and the crystal has a 
significant anomalous signal, the check may select the incorrect Laue 
symmetry. 
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Parameter Description 
Batch scale using Laue 
class 

Select the Batch scale using Laue class option to enable batch scaling of 
reflection data during the check. If this option is selected, enter the number of 
reflections to use per batch in the Maximum reflections per batch field. If this 
option is not selected and there is a significant change in the scale factor for the 
data, resulting from decay or a poorly centered crystal, the check may select the 
incorrect Laue symmetry. 

Highest Laue 
symmetry 

This is a list of the Laue symmetry groups that are reported. You can set this to 
restrict the results to lower symmetry groups. 

Unit cell reduction In the Maximum least-squares residual field, enter the value for the largest 
least-square residual that a reduced cell is allowed to have for inclusion in the 
log file output. 

R-merge In the R-merge section, specify the values to use in the Rmerge test during the 
check. In the Ideal field, enter the largest Rmerge for which Laue symmetry is 
automatically included in the check. In the Poor field, enter the maximum 
Rmerge for which a Laue symmetry is conditionally included in the check. All 
Laue symmetries with an Rmerge greater than this value are always excluded 
from the check. In the Incremental increase ratio maximum field, enter the 
maximum ratio used for the conditional test. Laue symmetries with Rmerge 
greater than the ideal, but less than the maximum, are included in the check 
only if the ratio of their Rmerge to the Rmerge for the next lower symmetry is less 
than the maximum ratio specified. 

Laue Check Results Table 
After you have run the Laue Check step, the following table is displayed. You should select the Laue 
class that you want to use and then click OK. 
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Centricity Check 
After the Laue check you can then check the centricity. Macromolecular users may want to skip this step, 
since macromolecules always have an acentric space group. 

Centricity Check Dialog 

 
 

Parameter Description 
Reflection list The normal reflection list to use is dtprofit.ref. But it is possible to use other 

reflection files. 

Centricity Check Results Table 
Once you have run the Centricity Check step, the following table opens. Select centric or acentric and 
click OK. 

 

Space Group Check 
The Space Group Check step analyzes the integrated data to determine the space group for the crystal. 
The reflections are examined to determine any systematic absences consistent with the Laue symmetry 
and centricity specified. 
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Space Group Check Dialog 

 
 

Parameter Description 
Reflection list The normal reflection list to use is dtprofit.ref. But it is possible to use other 

reflection files. 
I/Sig tolerance In the I/Sig tolerance field, enter the maximum I/σ(I) for a reflection to be 

considered absent. 0 means use the d*TREK default 

Space Group Results Check Table 
Once the Space Group Check step has run, the following table opens. 
 

 
 

Double-clicking on any field displays outlier data supporting the absence condition. When the space 
group is not uniquely determined by systematic absences (either due to incomplete data or space groups 
having identical systematic absences), all possible space groups are displayed. The likelihood column 
relates the statistical representation of reported structures in the space groups (and should sum to 1). 
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Num. Abs. Correction 
For small molecule work, if you know the formula and shape of your crystal, you can do numerical 
absorption correction. The normal way to determine the shape of your crystal is to run RAXShape. 
RAXShape requires a video camera and a compatible video capture card. 

Numerical Absorption Correction Dialog 

 
 

Parameter Description 
Formula If you entered the molecular formula during Setup, it shows up here. If you did 

not or you need to modify it, you can enter the formula at this time. 
CrystalClear accepts the formula in a variety of formats. 

Unit cell volume This is just user information provided to make sure your formula is compatible. 
• Observed. The volume calculated from the unit cell obtained during 

indexing. 
• Expected (based on Z). This is the estimated volume estimated based 

entirely on the formula (and Z value) 
Z Value The Z value (number of molecules in the unit cell) based on the formula is 

reported here. 
• Suggested  The Z value based on the formula is reported here. If this is 

the value you want click Use. 
• Actual This is the actual Z value that is used. If you click Use the 

Suggested value updates the Actual field. Or you can just type in the 
value you want to use. 

Absorption This is the calculated absorption in cm-1.  
Density Density as calculated using the molecular formula, Z value, and observed unit 

cell volume. 
Reflection file This allows you select the reflection file to use for numerical absorption 

correction. The default file is dtprofit.ref. 
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Parameter Description 
Grids The numerical absorption uses a gridding method. By increasing the number of 

grids, the computation is made slower, but more accurate. 
RAXShape This starts up the RAXShape program that you can use to determine the shape 

of the crystal. In order for RAXShape to run you must have a video camera 
with a capture card and have RAXVideo installed. 

Running Numerical Absorption Correction 
The Run button starts the process; each reflection in the input reflection file is read and the absorption 
correction calculated based on the integrated path length of an incident and reflected beam for each grid 
point. The output reflection file is dtnumabs.ref; to use the results of the numerical absorption correction, 
be sure to use this new reflection file as the input for the next step. 

Scale and Absorption 
This is the small molecule version of the Scale and average step. The only difference is that this version 
does not allow the user to change the name and format of the output reflection file. See the Scale and 
Average description in the next section for details. 

Scale and Average 
The Scale and Average step: 

1.  Calculates and applies scale factors to different batches of reflections in a list of raw integrated 
data 

2. Averages symmetry-equivalent reflections 

3. Calculates merging and completeness statistics 

4. Creates a list of unique reflections 

There are three basic reasons why raw integrated data should be scaled: 

1. Correction of systematic errors 

2. Rejection of outliers 

3. Validation of the error model, or σs 

Corrections for systematic errors generally fall into one of three categories: 

1. Absorption correction – errors caused by the physical geometry of the crystal 

2. Decay correction – errors caused by prolonged exposure to X-rays 

3. Batch scaling – errors caused by effects not related to the other two types 

The Scale and Average step contains algorithms for addressing each of these types of systematic errors. 
The basic idea of outlier rejection is to reject measurements that differ significantly from the average 
obtained from redundant measurements. By removing outliers from the data, the observed reflections 
should more closely match the true diffraction from the crystal. 

Scaling uses an error model to adjust the σs of the raw integrated data, so that they match the observed 
deviations among theoretically equivalent measurement. In a valid model, the variance calculated for each 
reflection matches the observed variance obtained from multiple measurements of the reflection. In this 
case, the reduced chi squared (|χ2|) statistic has an expected value of 1.0. Because systematic errors affect 
the calculated σs, correction parameters Eadd and Emul are required to scale the calculated σs to obtain |χ2| 
= 1.0. Determining the correct error model is necessary to ensure that the data is properly averaged and 
properly weighted during scaling. 
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Scale and Average Main Tab 

 
 

Parameter Description 
Reflection lists This box contains all the .ref files in the sample. The last .ref files written (e.g., 

dtprofit.ref) are the default. 
Resolution You can use the standard resolution controls to limit the resolution for this 

operation. 
Scaling Model This section provides you with a variety of parameters to control the scaling 

and absorption correction. 

• Exclude reflections with I/Sigma . Enter the I/σ(I) value to be used 
for excluding reflections from being used in scale factor determination. 
Note, however, that these reflections are included in the final statistics 
tabulated after averaging. 

• Batch scale. You can scale on a variety of properties. Batch scale is 
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Parameter Description 
defaulted to on. 

• B-factor. Select the B-factor the option if you want to enable B factor, 
or decay correction, scaling. This should generally only be used if your 
data was collected at room temperature, or your shows signs of decay. 

• Scale |+ and |- separately. Select the Scale I+ and I- separately 
option if you do not want to average I+ and I- before scaling. Selecting 
this option also affects any absorption correction that is being applied. 

• Absorption Correction. If this is checked, one of two absorption 
correction programs is run. 

o FS_ABSCOR. This works well for small molecule data, but is 
quite slow for macromolecule. 

o Details… for FS_ABSCOR you get 

o  
 Number of refinement cycles. The default is 5. 
 Eigenvalue filtering. Threshold of small eigenvalues 

to be filtered. Any eigenvalue less than this is filtered. 
Default value is 1x10-6. 

 Convergence. For value t, when |Δp| < t.σ(p) for all 
parameters, the program assumes that the least-squares 
calculation has converged. Default value is 0.05. 

o For details, see the following references: D. Stuart & N. 
Walker (1979). Acta Cryst. A35, 925.  
N. Walker & D. Stuart (1983), Acta Cryst. A39, 158. 

o REQAB. Recommended for macromolecules. 
o Details… for REQAB you get 

o  
 Absorption correction method. Several alternative 
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Parameter Description 
methods are listed in this drop down. But Spherical 4,3 
is recommended nearly all the time. 

 Sphere. For the Alternate Spherical method this 
specifies the Diameter and absorption coefficient, µ, 
of the sphere completely enclosed by the crystal 
volume.  

Error Model Check the Auto box if you want to d*TREK to automatically determine the 
error model. If Auto is not checked, you must select the Weight multiplier and 
Weight addend. 

The error model adjusts the input sigmas. For a valid error model, the variance 
calculated for each reflection should match the observed variance obtained from 
multiple measurements of the reflection. When this holds, a reduced chi 
squared (|χ2|) statistic has an expected value of 1.0. Since calculated sigmas are 
affected by detector gain, correction parameters Eadd and Emul are required to 
scale the calculated sigmas to obtain |χ2| == 1.0. The parameters Eadd and Emul 
can be set manually, or determined automatically. 

In the dropdown list for the Weight multiplier field, select the option to use for 
the error model multiplier, Emul. Some options require you to set an additional 
parameter in the field next to the dropdown list. The options for the multiplier 
are: 

Auto – intelligent: Emul is calculated automatically 

Auto – redundancy: Emul is calculated automatically, using reflections 
with a minimum redundancy. You must specify the redundancy to use. 

Auto – fraction: Emul is calculated automatically, using a fraction of 
reflections. You must specify the fraction of reflections to use. 

Explicit: Emul is not calculated, but must be specified explicitly. Typical 
values range from 1.5 to 7 and relate to the gain of the detector. 

In the dropdown list for the Weight addend field, select the option to use for 
the error model addend, Eadd. Some options require you to set an additional 
parameter in the field next to the dropdown list. The options for the addend are: 

Auto – intelligent: Eadd is calculated automatically 

Auto – redundancy: Eadd is calculated automatically, using reflections 
with a minimum redundancy. You must specify the redundancy to use. 

Auto – fraction: Eadd is calculated automatically, using a fraction of 
reflection. You must specify the fraction of reflections to use. 

Explicit: Eadd is not calculated, but must be specified explicitly. Typical 
values start with the Rmerge of the data. 

Reject before scaling If you check Batch, then in the Batch IDs field enter the batch IDs of the 
batches that you want to reject from scaling. Batch IDs must be entered as 
individual batches (e.g., 101, 102, 103) or as a range or batches (e.g., 101-103). 
You can combine individual batches and ranges by separating them with 
commas (,) (e.g., 101,110-114,125). 

Batch numbers are listed in dtscaleaverage.log and usually have 5 or 6 digits. 

Select the Systematic absences option if you want to reject systematically 
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Parameter Description 
absent reflections from scaling. 

Reject after scaling This specifies the criteria for rejecting reflection after they have been scaled. 

Fraction of reflections based on worst Chi2 per prediction. Select this 
option if you want to reject reflections on the basis of their χ2 value. In the field 
next to the option, enter the maximum fraction of reflections to be rejected 
because of their χ2 value. 

Typical data uses 0.0075. When a crystal has evidence of pathological 
problems, consider increasing this value. Note: increasing this value with 
anomalous data may remove a weak anomalous signal. 

The following options reject entire batches. 

Select the Fraction of rejected reflections > option if you to reject batches 
based on the number of rejected reflections that they contain. In the field next to 
the option, enter the minimum number of rejected reflections value to use for 
rejection. 

Select the Rmerge > option if you want to reject batches on the basis of their 
Rmerge values. In the field next to the option, enter the minimum Rmerge value to 
use for rejection. 

Select the Chi^2 > option if you want to reject batches on the basis of their χ2 
values. In the field next to the option, enter the minimum χ2 value to use for 
rejection  

Normal Output This section is not included in Small Molecule modes where these values are 
fixed. 

• Scaled, averaged output file name. The default is ScaleAverage.ref 
and some programs expect that. This reflection files lists h, k, l, average 
I and average SigmaI. 

• No Header. The header may cause problems for some programs, so 
you can eliminate it. 

• Output anomalous. This allows you to output the anomalous 
information which can be used for SAD phasing. This reflection files 
lists h, k, l, average I and average SigmaI, I+, SigmaI+, I-, and SigmaI-. 

Optional Output If you need output for other programs (e.g., structure solution for small 
molecule) you can also specify an additional output file. These are all 
unaveraged reflections in one of the following formats 

• Corrected, unaveraged reflections. 
• Uncorrected, unaveraged reflections with correction factors 
• SHELX format: corrected, unaveraged reflections 
• Both corrected, unaveraged reflections with corrections factors 

(f2plus.dat) and SHELX format reflections (shelxl.hkl) 
• Output. For the first two options, the default is f2plus.dat, and for the 

third option it is shelxl.hkl. For the Both option, you don’t get to 
specify file names and both files are generated. 

Scale and Average Advanced Tab 
The Advanced tab offers a few more parameters which can control the Scale and Average process. 
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Parameter Description 
Rebatch Select the Standard option if you want the scaling to automatically rebatch 

scans that do not have a sufficient number of overlaps for scaling. If you select 
this option, you must also enter the average number of overlaps required for 
rebatching in the Average overlaps field. Rebatching groups batches together 
so that the specified number of average overlaps occurs between batches. If you 
select the Image boundary option, the batches are created so that they lie on 
image boundaries. 

Select the Bookends option if you want the scaling automatically rebatch scans 
that do not have a sufficient number of overlaps for scaling, constraining the 
rebatching to only use those batches that have a size of less than half the 
average batch size. 

Scaling Constraints If you check Fix batch then you can specify a batch number and a Scale 
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Parameter Description 
factor and B-factor for that batch. 

Restrain batches Select the Restrain batches option if you restrain the scale factors. If you select 
this option, you must also specify the weights to use for the restraint using the 
syntax explained in the dialog. Restraining the scale factors reduces the 
magnitude of their variation, but does not keep them from varying. Note that 
batches are not be restrained across scans. 

Once scaling and averaging has finished, you should examine the log file output to determine if any 
problems occurred.  

Improving Scaling and Averaging 
Batch scale factors should vary smoothly within a scan. You may want to reject batches that have 
unusually large or small scale factors, high |χ2|, high Rmerge, or a large number of rejected reflections. 
Batches are identified by a batch ID number, which is usually a number with four or more digits (e.g., 
0001, 20123). The last four digits of the batch ID are usually the image sequence number. The preceding 
digits are the batch prefix from integration. Rerun Scale and Average, listing the batch IDs to be rejected 
in the Batch IDs field. 

Sometimes the first or last scaling batch does not have enough overlaps during scaling, causing it not to 
scale well. In this case, either reject those batches or turn on rebatching (using the Rebatch or Bookends 
options). 

Reducing the resolution cutoff for the data may also improve scaling. The data are automatically divided 
into 10 resolution shells. If many of your resolution shells have weak data, this may adversely affect 
scaling. Check the |χ2| values for the resolution shells to make sure that they are near 1, otherwise the 
I/σ(I) values may not be reasonable. Cut the resolution off at the shell where the unaveraged I/σ(I) drops 
to 2. This is usually the point at which the Rmerge for the shell is between 0.30 and 0.40. Rerun Scale and 
Average, setting the resolution cutoff in the Resolution section and setting the Max value to be the 
maximum resolution of the shell selected. 

If you have a low redundancy in the data set, or all of the data are very weak, you may want to consider 
turning off all scaling. You may also want to consider turning off scaling if you have an unusually high or 
low Rmerge. In the former case, the existence of a few bad reflections may cause an invalid correction to be 
applied (potentially lowering the Rmerge). In the latter case, it may not be beneficial to apply empirical 
corrections, as they may increase the Rmerge. 

If the entire crystal is bathed in the X-ray beam, you may not want to use batch scale factors. This 
assumes that you have only used one crystal throughout the data collection and that the exposure time was 
constant for the entire data collection. 

Depending on the redundancy of the data, valid |χ2| values might lie between 0.8 and 1.8. For data sets 
with an average redundancy of less than 3, it is probably not worth trying to adjust the error model so that 
|χ2| is within a small tolerance of 1.0. 

If the crystal was only rotated though a small angular region during collection, you may want to turn off 
absorption correction, as there may not be enough of the absorption surface present in the data to 
accurately determine the absorption surface. 

If you are scaling data from more than one crystal, do an independent absorption correction on each 
crystal separately, and then use batch scaling only on the combined data. 

If the data contains only random errors and the σs are correct, |χ2| is 1.0. However, if the σs are correct 
but |χ2| is larger than 1, then this suggests the presence of systematic errors in the measurements. 
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Additional tips on scaling and averaging, as well as in-depth descriptions of the concept used in scaling 
can be found in the d*TREK documentation. 

REQAB Issues 
The REQAB option for absorption correction provides a number of parameters for the modeling of 
absorption, crystal decay and incident beam intensity drift. These are all modeled within the absorption 
correction algorithms provided in REQAB.  
 
The goal of the absorption correction algorithm is to deduce an absorption surface associated with a 
crystal by requiring that this surface minimize the difference in intensities between symmetry related 
reflections. In practice, this is done by minimizing the weighted differences between the right and left-
hand sides of the equation: 
(1)  

 
where I’s are the intensities and A’s are the absorbencies. The right hand side represents a sum over the k 
symmetry related intensities in a group of equivalent reflections, and the subscript i represents any 
member in the group. One seeks to find an absorbance A i to minimize this difference and A j

0 represents 
an initial estimate of the absorbance. As implemented in the program the initial A 0 values correspond to 
that of the spherical crystal; when a new absorption surface is obtained, these replace the original A 0 
values and the process is repeated until convergence is obtained.  
 
The absorbance A consists of a product of the absorbance of the primary beam and the absorbance of the 
scattered beam, i.e.  
(2)  

 
These absorbencies could also be expanded in a Taylor series,  
(3)  

 
If the usual approximation is made of assuming that the higher order contributions are negligible, then by 
a least squares approach, the  ∆pj  values can be calculated and the whole process repeated until 
convergence is obtained. We assume the absorption surface is smoothly varying in reciprocal space. In 
order to enforce this powerful constraint two sets of analytical functions are used.  
  
Spherical harmonics are one convenient set of analytic functions for As. The maximum order is limited to 
8, four even term and four odd terms: 
(4)  

 
  
where alm represents the coefficients to be determined by refinement and ylm are the corresponding 
spherical harmonics, and ϕ and υ  are the equatorial and azimuthal angles of the diffracted x-ray beam, 
respectively. 
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An alternate analytic function employs a Fourier series to represent absorbance:  
(5) 
   

 
Here the coefficients Pnm and Qnm are fit via a least squares procedure. The maximum values of n and m 
are 8 and 4, respectively. In the case of the Fourier method, both the primary (or incident) and scattered 
beams are modeled. 
 
In addition to absorption, the apparent intensity of the primary or incident beam may be affected by 
decay, beam in homogeneity and source instability. CrystalClear provides two methods for modeling 
these effects, simple batch scaling, which is applicable to either the spherical harmonics and Fourier 
methods, and circular harmonics, which applicable to only with only the spherical harmonics. 
 
In the batch scaling method the data are first scanned to find the batch with the greatest overlap. This 
batch becomes the reference batch and the absorbencies described in Equation 3 are allowed to vary with 
respect to the reference batch. That is, the derivatives of Apj are zero unless j corresponds to a batch and 
the reference batch.  
 
Alternatively, if the azimuthal angle in equation 4 is fixed at 0, the spherical harmonics collapse into the 
equatorial plane becoming circular harmonics and the resulting function A(φ,0) can be used to model 
incident beam absorption.  
 
The options are found in the REQAB Dialog and are described in below. The Spherical options seem to 
be best for small molecule data, but the Fourier method is often the best method for macromolecule data. 
But if one method does not provide the results you were expecting try one of the other methods.  

Absorption options  

Option Description 
Spherical 4,3  This option uses 4th order even and odd spherical harmonics 

to describe the diffracted beam absorption and 3rd order even 
and odd circular harmonics to model incident beam 
absorption. 

Spherical 3,2 This option uses 3rd order even and odd spherical harmonics 
to describe the diffracted beam absorption and 2nd order even 
and odd circular harmonics to model incident beam 
absorption  

Fourier  8,3 This option uses Fourier coefficients to model diffracted beam 
absorption and simple batch scaling to model incident beam 
absorption, decay, etc.  

Alternate Spherical  In this method the primary absorption surface is calculated 
using the ideal sphere then one of the other methods is used 
perturb the ideal correction. Furthermore this method puts the 
resultant transmission factors on an absolute scale. 

 
Fitting the absorption surface using spherical harmonic coefficients or Fourier coefficients via singular 
value decomposition is very robust and, in most cases, leads to a satisfactory result. However, there are 
some cases in which error messages are displayed.  
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Absorption correction trouble shooting guide 

Error Message  Cause and remedy  
Number of outliers exceeds 
2000   The assumed symmetry is too high. Use Data analysis -> Laue Group 

to automatically determine the Laue group and rerun.  

 The sample is a strong absorber, µR > 2. In the Advanced Menu set 
outer rejection criterion to 500 or 1000. This ensures that reflections 
that are strongly affected by absorption are used in the calculation of 
the surface, improving the overall correction.  

 The crystal is split and some reflections overlap and some do not. Try to 
find a better crystal.  

No convergence in SVDCMP   The redundancy is low. If the sample is triclinic try to collect at least one 
scan of 180º. If the sample is of higher symmetry collect more data in a 
different region of φ or χ.  

 The diffraction data are poor. The algorithm uses significant data to 
calculate the absorption surface reliably and there are not enough to do 
this. Recollect the data with longer exposure times.  

Spherical harmonics 
methods do not complete  
 S Del**2 > 106 

 Multiple scans have different exposure times. You may be able to 
recover by repeated runs of "Fourier".  

 The crystal died or fell off, the generator went down, etc. Inspect your 
images to determine if diffraction stopped at some definite point in 
time and reintegrate up to that point.  

 The assumed symmetry is too high. Change the putative space group.  

Fourier methods do not 
complete.  
 S Del**2 > 106 

 Multiple scans have different exposure times. Recovery unlikely.  

 The crystal died or fell off, the generator went down, etc. Inspect your 
images to determine if diffraction stopped at some definite point in 
time and reintegrate up to that point.  

 The assumed symmetry is too high. Change the putative space group.  

 

JDtplot for Displaying Scale and Average Results 
JDtplot is an auxiliary program for plotting the results of Scale and Average results. At the end of Scale 
and Average this program is automatically started if you have selected JDTPlot in the User Preferences 
(which is the default). You have the option to be prompted first that you can set in Preferences (see 
chapter 2). The older CrystalClear plotting option is now obsolete. You can also run JDtplot through the 
menu under Processing>Run JDtplot or View>>Scale/Average Plots>JDtplot. However, you must 
have run Scale and Average before this runs successfully.  
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JDtplot is a Java program and requires a compatible JRE (Java Runtime Environment). Normally the JRE 
you have installed by default in Windows should work fine. If you need to load a different JRE, you must 
also edit CrystalClear.configuration to specify the path to this JRE. 

JDtplot looks at the log file from Scale and Average and creates various plots. The figures below split 
the two columns that make up the normal display in order to fit them better on the page. 

JDtplot Display 
 



 

CrystalClear  

 

CrystalClear d*TREK Steps 8-55 
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Using JDtplot 
The default display is for all 6 graphs to be displayed in the JDtplot main window. If you want to examine 
just one plot in detail you can either click Max for that graph, or click the tab for that graph. Once the 
large graph is displayed you can click Min or go back to the All tables tab to get back to the combined 
display. 

When you mouse over the graphs, you get a display of the value under the mouse. 

If you click Avg +- Std. Dev, a semi-transparent box pops up with the average and standard deviation for 
each of the properties that is plotted. 
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The color code for each property is shown with the property name along the right side of the graphs. If 
you click these buttons, the display of the property is toggled off or back on. The Y axis might be rescaled 
to best display the remaining properties. 

Menu Operations 
There several functions that are accessible through the Processing menu, but do not have explicit steps in 
flow bars. These include: 

• Cell Tools 

o Transform 

• Reflection List 

o Merge Reflections. This combines reflection lists in separate files into a single file. 

o Reflection File Tools. This provides various options for filtering a reflection list. 

• Rank Crystal 

• Run d*TREK Interactive 

 

Cell Tools>Transform 
This tool allows you to re-index a cell under a given transformation. 
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Cell Transformation Dialog 

 
When Find transformation for lowest R-merge for two files is checked, there are additional fields. 
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Parameter Description 
Reflection lists This drop down list contains all the .ref files in the sample. This is normally 

done after all the integration and scaling, so you should normally use 
ScalAveraged.ref. 

Reference reflection 
file 

This is displayed only when the Find transformation… box is checked. It 
specifies the file that is to be used to minimize the R-merge assuming that this 
file and some transformation of the Reflection file were to be merged. 

Transformation Select the transformation you want to perform. This control is not displayed if 
you click Find transform for lowest R-merge for two files. 

Transformation matrix This is a read only display of the transformation matrix unless you choose 
Custom Matrix as your Transformation option. The Determinant and Right-
Handed or Left-Handed are displayed but not editable. 

Find Transformations Click this button to compute the transform that would result in the lowest R-
merge for the Reflection and the Reference reflection files. The results are 
show above this button and you can use the <> buttons to examine the ranked 
solutions. 

Find transformation 
for lowest R-merge for 
two files 

This check box activates the Reference reflection file and Find Transform 
controls so that you can use these tools to determine the transform you want to 
use. 

Current Cell This is a read only display of the current cell. 
New Cell Unless you select Custom Cell as the option for the Transformation, this is just 

a read only display of the new cell. If you do select Custom Cell, you can enter 
the basic cell parameters. 
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Re-indexing Using a Standard Cell Transformation 
The most basic kind of Cell Transformations involve permuting (flipping) axes, changing centering and 
changing monoclinic cell type. These operations are prevalent enough to have common names that should 
be recognizable by most crystallographers. The transformations provided are: 
 
Label Description Identity Transformation 
CAB 
BCA 
BAC 
ACB 
CBA 

Flips or permute cell lengths. For example, CAB takes (a,b,c) to (c,a,b). 

mI -> mC  
mC -> mI  

Moves between I centered and C centered monoclinic cells. 

hR -> hP  
hP -> hR  

Moves between primitive rhombohedral and triply-primitive cells. 
  

hP -> oC (C1)  
hP -> oC (C2)  
hP -> oC (C3)  
oC -> hP (C1)  
oC -> hP (C2)  
oC -> hP (C3) 

Moves between primitive hexagonal and C-centered orthohexagonal cells.  
  

 
The standard transformations can be used to flip cell axes, move from primitive to centered cells (or vice 
versa), and re-index into different orientations.  
 

• Select the desired transformation from the Transformation list. Be aware that not all 
transformations in the list are valid for every kind of lattice and centering. The special cells 
named Custom Matrix and Custom Cell are described in a separate section below. 

• Once a transformation is selected, the matrix appears in the Transformation Matrix item and the 
real space cell that would result from applying this transformation should appear in the New Cell 
item box. 

• Go to the Reflection List item and select a reflection list. This is optional, but must be specified 
if you wish to apply the transformation to previously collected data. Only one reflection file can 
be specified. 

• Click Re-index. 
• A message box inquires if the operation is satisfactory. Any reflections that map to a fractional 

HKL value (a real possibility when transforming from centered to uncentered cells) are displayed 
along with I/sig statistics for those reflections. To cancel the operation, click No. To proceed with 
the operation, click Yes.  

• If you specified a reflection list to index, then you are prompted with the reflection list to use. 
Enter the name of the Reflection List.  

• After the operation, the Current Cell and the New Cell match. The Transformation 
automatically resets itself to the identity transformation. 

 

Re-indexing Using a Custom Cell Transformation 
Uncommon Cell Transformations can be specified by providing an HKL transformation matrix. This 
matrix describes the transformation taking each HKL value to a new HKL value. Specify the 3x3 matrix 
[A] multiplying the column vector HKLOld from the left (i.e. HKLNew = [A] HKLOld). 
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Care should be taken when specifying transformation matrices. Be aware that left-handed transformations 
yield left-handed crystal orientation matrices, and those transformations that change volume can possibly 
corrupt reflection files. A custom Cell Transformation can be entered if none of the standard Cell 
Transformations are satisfactory. The procedure is similar to that used for standard Cell 
Transformations. 
 

• Go to Transformation control group and select Custom Matrix.  
• Enter the matrix elements. Allowable values consist of integers and small fractions.  
• Go to the Reflection List and select a reflection list. This is optional, but must be specified if you 

wish to apply the transformation to previously collected data. Only one reflection file can be 
specified. 

• Click Re-index. 
• A message box inquires if the operation is satisfactory. Any reflections that map to a fractional 

HKL value (a real possibility when transforming from uncentered to centered cells) are displayed 
along with I/σ statistics for those reflections. To cancel the operation, click No. To proceed with 
the operation, click Yes. 

• If you specified a reflection list to index, then you are prompted with the reflection list to use. 
Enter the name of the Reflection List.  

• After the operation, the Current Cell and the New Cell should match. The Transformation 
automatically resets itself to the identity transformation. 

 

Re-indexing Using a Specific Cell 
This feature automatically finds the transformation matrix that would transform the one cell to another. 
This can be useful for changing axis lengths or getting the CrystalClear cell to match the cell from some 
other source. 
 
NOTE: Use the Cell Reduction dialog if you only wish to change the cell orientation angles.  
 
This is a very powerful option that allows you re-index to any district cell (within reason). Instead of 
entering in a literal HKL transformation matrix, you specify a cell, and the program figures out the matrix 
that would produce a close match to that cell.  
 

• Go to Transformation and select Custom Cell. New Cell becomes active. Enter cell constants a, 
b, c, α, β or γ.  

• Once the cell has been specified, click Find Matrix. 
• A message queries to verify the operation. The proposed HKL transformation is specified along 

with the resulting cell and a residual error. At this time, you may cancel by clicking Cancel, 
otherwise click Use Matrix. 

• If you click Use Matrix in (c), then Transformation changes to Custom Matrix, and New Cell 
changes to the new target cell. Proceed as if you entered the Cell Transformation yourself, and 
follow the steps above. 

 

Re-indexing to Find the Lowest R-merge 
 
NOTE:  This is an advanced tool and should be used with caution. 
 
This tool attempts to solve this ambiguity by finding the relative transformation matrix that would have to 
be applied to one data set to get a low R-merge.  
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This feature compares two data sets collected with possibly different orientation angles. When two data 
sets from a crystal with a polar Space Group are combined, this can help make sure they have the same 
polarity (ie. P2, P3, P6, P321 vs. P312). This might not be the case if the data sets were collected on two 
different machines, or if the orientation angles of one of the data sets are unknown.  
 
This feature can be used to find the best transformation between two data sets having an anomalous signal 
and different crystal orientation angles. It can also be used to scale data that are collected at different 
exposure times. 
 

• Click Find Transformation for Lowest R-merge for Two Files. Several new dialog boxes 
appear when the box is checked. 

• Select reflection files to compare. The Reference reflection file is not re-indexed and issued as 
the benchmark. The transformation resulting from this operation is applied to the other reflection 
list, and to the CrystalClear cell. 

• Click Find Transformations. NOTE:  This operation takes some time to complete. 
• When the operation is done, use the Arrow keys to move between the different Cell 

Transformations. The R-merge and scale factor for each transformation is printed. 
• Click Re-index. 
• A message box inquires if the operation is satisfactory. Any reflections that map to a fractional 

HKL value (a real possibility when transforming from uncentered to centered cells) are displayed 
along with I/σ statistics for those reflections. To cancel the operation, click No. To proceed with 
the operation, click Yes.  

• If you specified a reflection list to index, then you are prompted with the reflection list to use. 
Enter the name of the Reflection List.  

• After the operation, the Current Cell and the New Cell should match. The Transformation 
automatically resets itself to the identity transformation. 

Reflection List>Merge Reflections 
If you have integrated reflections from separate scans into separate files or have multiple reflection files 
that need to be merged for any other reason, this step can be selected in the menu under  
Processing>Reflection Lists>>Merge Reflections…. 

Merge Reflections Dialog 
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Parameter Description 
Reflection lists These are the reflection lists that are currently in the sample directory. If you 

want to get reflection lists from another sample, use Import Reflection File… 
You can select multiple files from this list using standard Windows 
conventions. 

Output merged file You can give your merged file a name.  
Zone type If you want to restrict the reflections to certain zones of reciprocal space you 

can select the zone restriction from this drop down list. 
Restrict Resolution This does not use the global CrystalClear d*TREK resolution controls, but they 

are very similar and allow you set the Minimum and Maximum resolution. 
Import Reflection 
File… 

A file browser opens which allows you to import reflection files into the 
sample. Once they have been imported they show up in the Reflection lists. 

 

Reflection Lists>Reflection Tools 
This dialog allows you to specify various filters to be applied to a reflection file. 

Reflection File Tools Dialog 

 
 

Parameter Description 
Input reflection file These are the reflection files that are currently in the sample directory. You can 

only select a single file in this list. 

Output reflection file You can specify a file name within the current sample, or click the … button to 
browse to another location to write the file outside the sample. 

Resolution rejection If you select this option, the reflections are filtered to lie between the From and 
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Parameter Description 
To resolutions. 0 means no limit. 

I/Sig rejection This allows you to filter on I/Sigma. Again 0 means no limit 
Batch rejection If you need to remove one or more batches from the reflection file, you can 

check this box and provide the From and To bounds. 
Custom string This allows you to enter custom rejection criteria. See the d*TREK 

dtreflnmerge command for more details. 

 

Ranking 
The Ranking step allows you to determine a quantitative measure of the quality of a crystal sample. 
Ranking uses a series of pre-defined rules to determine the quality of a crystal. Depending on whether or 
not the rule’s criteria are met, a number of bonus or penalty points are included in the calculation of the 
rank. The rules used in ranking are: 

• Spot count in resolution shells 

• I/σ(I) in resolution shells 

• Spot sharpness 

• Spots in strong ice rings 

• Spots in diffuse ice rings 

• Percentage of spots indexed 

• RMS residuals after refinement 

• Mosaicity 

• Percentage of spots refined 

• Spot count (predicted and observed) in resolution shells after refinement 

• I/σ(I) (predicted and observed spots) in resolution shells after refinement 

• Strategy total rotation width 

The rank calculated for a crystal can be used to evaluate samples of the same crystal type to determine 
which sample is likely give the best data set.  

Ranking assigns a single integer rank to a crystal based on an analysis of the screen images. This is not 
normally very useful in manual work where you are sitting in front of CrystalClear. You can usually just 
look at your images and decide how good they are. But as soon as you automate the data collection 
process (e.g., by using Director with an ACTOR robot to drive CrystalClear), this becomes a vital step 
which allows the automatic determination of the best samples to collect and to prevents wasting time 
collecting samples that are unlikely to provide useful data. 

Ranking is most useful when you are comparing similar crystals. The various ranking rules add both 
positive and negative points to the rank. So for comparison purposes it is best to make sure the same 
ranking rules are used for all the samples in the set. For example if you have three crystals that are same, 
you might want to screen each one and then rank them to decide the best one to use for data collection. 
This is especially useful if you are using Director on an ACTOR system. 

Because Ranking is not used in normal interactive CrystalClear operation, it is only available through the 
menu by selecting Processing and then Rank Crystal. 
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Rank Crystal Dialog 

 
 

Parameter Description 
Scan table This is the standard scan table for selecting the images on which to rank. 

Ranking is normally done on screen images before data is collected. 

Ranking rules The ranking rules fall into groups. You can turn each group off by unchecking 
the box. The options are: 

• Peak Search. How many peaks are found, how are they distributed 
through resolution shells, how good are the peaks, etc. This is probably 
the most useful criterion, so it is unlikely to be useful to uncheck it. 

• Ice Rings. Negative points if ice rings are detected. 
• Index and Refinement. Can the crystal be indexed?  How good is the 

refinement? 
Show rules This displays a text viewer with the current ranking rules. An example is shown 
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Parameter Description 
below. 

Search resolution You can specify the resolution to use in searching for peaks. If you know the 
crystal does not diffract very far, you might want to limit the resolution so that 
it won’t be penalized for not having high resolution peaks. The standard 
CrystalClear resolution options are provided. 

Normalize Scores If you want to normalize your scores over a particular range you can specify a 
Maximum and Minimum score. This is only really useful if another program 
is looking at these scores and expects a fixed range. 

Rotational anisotropy 
penalty coefficient 

This is the weight applied to the penalty for rotational anisotropy. 

Strategy rotation 
width penalty 

If rank performs a Strategy step, then this specifies the penalty that is applied 
for samples that require more images to be collected. It is not currently used. 

Ranking processing 
steps 

Depending on the rules used and the steps that have already been performed, 
ranking performs several steps to determine the properties that go into the rank. 

• Find reflections. Necessary for the Peak search rules. 
• Index reflections. Necessary for the Index rules. 
• Refine parameters. Necessary for the Refine rules. 

Resolution bins For the Peak search rules, ranking sorts the peaks into resolution bins and then 
bases the score on the number of peaks in each bin. This section allows you to 
control this process. 

• Total number of resolution bins. 
• Number of high resolution bins. 
• Number of low resolution bins. Not all bins are either high or low, so 

the high and low does not need to add up to the total. Low defaults to 0. 
Reflection definition These specify what it takes for a peak to be considered a reflection. 

• Minimum signal/noise. This is the minimum I/Sigma that a peak must 
have to be included. 

• Minimum reflections per shell. A shell is a resolution bin. This is the 
cutoff below which the sample is penalized for not having sufficient 
reflections for a particular shell. 

View Previous Rank 
Results 

This is used primarily for testing ranking results, but can be useful for 
comparing samples. 

Clear Previous Rank 
Results 

Clears out the list used for comparison. 

Rank Crystal This performs the actual ranking. Depending on the Ranking processing steps 
checked this might run dtfind, dtindex, and dtrefine as well as dtranker. 

Rank Rules 
When you click Show Rules you get the following display. 
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Rank Results 
Once the ranking is done you get the following display. 
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If you have run rank several times, you see the results for all the samples. You can clear this table with 
Clear Previous Rank Results. 

Run d*TREK Interactive 
If you need to use a d*TREK option that is not supported by the CrystalClear, then you can use this tool 
to bring up a DOS window that allows you to type in d*TREK commands directly. The results of these 
commands are not used to update the state and the log files are just be shown in the DOS box, so this has 
limitations. It is an escape hatch for the brave who know a lot of d*TREK and is not recommended for 
mere mortals. 
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9. FS_PROCESS Steps 

Fine Slice PROCESS (FS_PROCESS) is based on Dr. Higashi’s PROCESS program. Dr. Higashi and 
other scientific staff members at Rigaku in Japan have reworked much of the old PROCESS program and 
added many new features and refinements for processing fine sliced images. FS_PROCESS continues to 
be very effective for wider images (> 2 degrees) and is the recommended package for processing wide 
RAPID and SPIDER images for small molecule work. 

Assign Unit Cell 
The three steps in the Assign Unit Cell group include: 

• Find Spots 

• Index Spots (includes refinement in FS_PROCESS) 

• Predict Spots 

Find Spots 
The first step after having collected screen images is to find spots to be used in indexing. These spots are 
written into a file called fsFind.ref. 

In order for subsequent Operations to function properly (i.e. Index Spots and Refine Cell), using 50-70 
reflection centroids in Find Spots is recommended. The exact number needed can vary depending on the 
centroid accuracy and location in reciprocal space.  

Find Spots Dialog 

 
 

Parameter Description 
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Parameter Description 
Scan Table This is the standard scan table for selecting images to be used for the Find 

Spots step. By default the _screen images are selected. 

Sigma cut One option for specifying the criterion for a pixel value to be considered a 
potential part of a spot is the I/Sigma of the pixel. 

Threshold The other option is a threshold number 

Index Spots 
FS_PROCESS index requires very few parameters. After the solution has been selected (either by the user 
or automatically) it is refined, so no separate refinement step is necessary. 

Index Spots Dialog 

 
 

Parameter Description 
Number of spots for 
indexing You can set a maximum number of spots to be used for indexing. Of course, if 

fsFind.ref has fewer spots, then the actual number of spots used may be smaller. 

User chooses solution If this is checked a table of candidate solutions is presented and you can select 
the solution that you think is right. If this box is not checked, then the most 
likely solution (the top line in the table if it had been displayed) is chosen. 
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Indexing Solution Candidate Table 

 
 

Look over the Candidate table to select the desired cell. The ACC(%)  parameter is the percentage of 
reflections that fit the unit cell. Higher is better.  

Predict Spots 
It is a good idea to predict spots to make sure that they match the spots on the images. If you have already 
collected data, it is best to predict on collected images. 

Predict Spots Dialog 
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Parameter Description 
Scan Table This is the standard CrystalClear scan table for selecting the images you want to 

predict on. 

Cell parameters FS_PROCESS reports the current cell parameters in this area. 
Candidate… If you did not check User chooses solution in Index Spots or you decide at this 

point that you do not like the cell, you can click Candidate and you get the 
Index Solution Candidate Table described in the last table which gives you a 
chance to change the selected cell. 

Integration and Scaling 
The last two steps in the FS_PROCESS flow are 

• Integrate Reflections 

• Scale and Average (includes multiple additional steps) 

Integrate Reflections 
FS_PROCESS integration works well for both fine sliced and wide sliced images. Note that for 
consistency with FS_PROCESS log files the interface uses Frames where d*TREK and most the 
collection dialogs use Images. FS_PROCESS also uses Process rather than batch. 

Integrate Reflections Main Tab 
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Parameter Description 
Scan Table This is the standard CrystalClear scan table for selecting the images you want to 

integrate. By default all the images without _screen in the name are chosen. 

Select All A short cut to select all images. 
Clear All A short cut to clear all image selection. 
Spot size This is the average spot size in millimeters. FS_PROESS judges overlapped 

reflections based on these two parameters. These values should be set 
based upon the size of reflections and unit cell. Values that are too small 
may not calculate the overlap properly. Values that are too large may 
reject too many reflections. 

Resolution This is the maximum resolution for integration. Usually 1Å is used for 
refinement and 0.77Å and 0.83 Å are used for integration for Mo and Cu, 
respectively. 

Laue class You can specify the Laue class at this stage which can improve the quality of 
the integration. 

 

 

Integrate Reflections Advanced Tab 

 
 

Parameter Description 
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Parameter Description 
Refinement parameter This table specifies the refinement procedure that is executed before integration 

starts and then before each process. Each row in the refinement specifies a 
different refinement step. You can edit this table by using the Add button to 
add a row or the Remove button to remove the selected row. For each step you 
specify: 

• Resolution  The resolution cutoff for that step 

• Cycle The maximum number of refinement cycles to run. 

• Cell  (ON/OFF) ON means refine cell parameters 

• rot (ON/OFF) ON means refine crystal mis-setting angles 
• cent (ON/OFF) ON means refine the direct beam position 
• dist (ON/OFF) ON means refine distance parameters 
• drot (ON/OFF) ON means refine the detector rotations 
• srot (ON/OFF) On means refine the source rotations 
• qmat (ON/OFF) On means refine the q matrix, which describes 

the nonunformity of the x and y pixels. 

Integration box size • Auto which is the normal default means the integration box size is 
determined automatically. 

• Fixed means that you specify a fixed box size in pixels. 
Mosaicity • Auto means that the mosaicity is estimated by FS_PROCESS as it is 

working. 
• Fixed means that you fix the mosaicity to the specified value. 

Frames per process • Auto means that FS_PROCESS automatically figures out when it 
needs to re-refine. 

• Fixed allows you to specify the number of frames (images) in each 
process (batch). 

 

Scale and Average 
In FS_PROCESS the Scale and Average Step runs a selected set of programs and thus replaces several 
steps in d*TREK. 
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Scale and Average Main Tab 

 
 

Parameter Description 
Reflection file table FS_PROCESS produces a reflection file for each frame (image). This table 

behaves much like the scan selection table and allows you to select which 
reflection files are included in the Scale and Average step. 

Select All A short cut to select all reflection files 
Remove All A short cut to remove all reflection files selection. 
Programs The Scale and Average step runs a list of program. You should check the 

programs you want to run. If a program is grayed out, it is not valid to run at 
this point. 

• Merge frames. Merges the individual reflection list associated with 
each frame into a single reflection list. 

• Numerical absorption correction. Calculates the absorption effect 
within the crystal and applies absorption correction based on the shape 
of the crystal obtained by the shape tracing software shape. This 
requires that you have used RAXShape to define the shape of the 
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Parameter Description 
crystal. 

• Scale. This is an initial scaling step. Scale can be repeated several times 
in this process. 

• Laue. Performs a Laue group check. 
• Scale.  
• Empirical absorption correction. This runs the FS_PROCESS 

absorption collection program. (Numerical absorption and empirical 
absorption are mutually exclusive). 

• Scale.  
• Cell refine. A final cell refinement. 
• Average. The final step is to average the reflections. 

Output format Several output file formats are available. Each format defaults to a different 
(and fixed) output file name. 

• Rigaku format – Standard output for CrystalStructure in f2plus.dat 
• HKL4 format – Legacy format in f2.dat 
• d*TREK – Compatible with dtscaleaverage.ref, but named dtrek.dat. 

Output file name This is a read only display of the file name that is used for output. It is based on 
the Output format and cannot be changed. 

Determine Crystal 
Shape… 

This button starts up RAXShape so that you interactively determine the crystal 
shape. This requires that you have a video camera and video capture card on 
your system and that you have RAXVideo installed. 
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Scale and Average Advanced Tab 

 
 

Parameter Description 
Scale The Scale program is often executed multiple times. These parameters apply to 

each time it is run. 

• Max number of cycles. 

• Sigma cut off. The I/Sigma value that each reflection must have to be 
considered in scaling. 

• Resolution. Reflections that have higher resolution than this are not 
considered for scaling. 

• Refine temperature factor. In this is not checked only the scale 
factor is refined, and if it is checked, the scale factor and temperature 
factors are refined. The temperature factor may be applied when 
intensities decay isotropically, such as protein crystals. 

Numerical absorption These parameters apply to the Numerical absorption correction program. 
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Parameter Description 
correction • Formula. You should enter the molecular formula and click the 

Update button to update the computed Z value and other computed 
values. 

• Mu/Density. Mass attenuation factors 
• Density 
• Z value. This is computed from the molecular formula, but you can edit 

it as needed. 
• Grid size 

 
Laue The parameters apply to the FS_PROCESS Laue check program. 

• Sigma cut off. Reflections with a lower I/Sigma value are not included 
in the Laue evaluation. 

• Rmerge. 
• Correlation. This is the deformation correlation lower-limit value for 

judging the symmetry. 
Empirical absorption 
correction 

FS_PROCESSS has its own empirical absorption correction program that works 
especially well for small molecules. The parameters for this include: 

• Max number of cycles. 
• Sigma cut off. Reflections with I/Sigma lower than this value are not 

used to calculate the absorption correction. 
• Resolution. Reflections with higher resolution than this are not used in 

absorption correction calculation. The resolution is in Angstroms. 
Average For the averaging program the parameters include: 

• Sigma cut off 
• Outlier cut 
• Resolution 
• Output anomalous. If this is Yes, the log file includes information about 

the anomalous differences for Bijvoet pairs (I+, I-). 

 

Scale and Average Step Description 
Merge frames 

Merges intensity data files from each image and generates a merged reflection file. Merge uses the 
intensity data selected at Reflection List. 

Cell Refine   

Cell Refine determines precise cell constants and the orientation matrix with the post refinement method.  

Scale 

Performs scaling of each image.  

Laue 

Examines the symmetry of intensity data and determines the Laue symmetry. If the program has failed to 
determine the Laue symmetry, the following reasons are possible.  

1. There are not enough pairs to judge the symmetry due to the limited measurement region within 
the reciprocal space.  
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2.  The merged file contains intensities obtained under different conditions but not well scaled. The 
intensities should be scaled prior to running Laue.  

3. The absorption effect on intensities is large. In this case, the intensities should be corrected for 
absorption before Laue. 

Numerical absorption correction 

Numerical absoprtion calculates the absorption effect within the crystal and applies absorption correction 
based on the shape of the crystal obtained by the shape tracing software shape. In order to run this you 
must have run RAXShape to get a shape description file. If you have not done this then this step is 
disabled. 

Empirical absorption correction 

Empirical absorption correction approximates the absorption surface by a Fourier series. The Fourier 
coefficients are determined by the least squares fitting assuming that the intensity differences among 
equivalent reflections are caused by absorption effect.  

Average 

Averages intensities of equivalent reflections and writes the averaged intensity to the output file. If the 
anomalous diffraction option is specified, the intensity difference originated from anomalous diffraction 
effect is determined and delivered to the output file.  

Menu Operations 
The operations included in this section are accessible through the menu, but do not have corresponding 
steps in the flow bars so they have not been documented elsewhere. 

Cell Tools>Transform 
The Transform Cell command is different for depending on the processing suite. For FS_PROCESS the 
options are somewhat different than they are for d*TREK or TwinSolve. 
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Cell Transform Dialog 

 
 

Parameter Description 
Current Cell The current cell information is taken from the sample state. This reports the cell 

parameters, Crystal system, Lattice type and Laue class. 

Cell If Cell is checked, then the selected transformation is applied and the sample re-
indexed. FS_PROCESS provides a set of standard transformations from which 
you can choose. 

Lattice type If you check this you are able to change the Lattice type in the transformation 
by selecting another Lattice type from the drop down list. 

Laue class This allows you to select a new Laue class for the transformation. 

Cell Tools>Reduce 
In the FS_PROCESS flow bars cell reduction is not a built in step. However there is a command available 
to reduce the cell to a conventional cell. 
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Cell Reduction Dialog 

 
 

Parameter Description 
Current Cell The current cell information is taken from the sample state. This reports the cell 

parameters, System and Centering. 

Estimate Click this button to generate a list of possible conventional cells based on the 
current cell.  

List of possible 
conventional cells. This list is filled out once Estimate has finished. 

Possible Laue class If the Laue class can be determined, there is drop down list of possible of Laue 
classes from which you can select. 

Translate This translates the current cell to the selected conventional cell. 
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10. TwinSolve Steps 

TwinSolve was developed by Dr. Christer Svensson. It is licensed separately from CrystalClear, but 
usually included for most small molecule customers. As its name implies, TwinSolve is especially well 
suited to dealing with twinned small molecule crystals.  

The CrystalClear interface allows the user to study the images from a twinned crystal. The twin 
relationships (twin laws) are generated for each pair of components. Reflections from each twin 
component are integrated, including the overlapped reflections. Absorption corrections for each 
component are applied using shape factors (based on measurements of equivalent reflections) expanded in 
terms of spherical harmonics (up to order 8).  
 
TwinSolve properly handles both fine- and wide-slide image data from either CCD or image-plate 
detectors. In addition to Rigaku image data, TwinSolve processes images from Bruker, MAR, ADSC, and 
Nonius detectors. 
 
TwinSolve is not limited to use with twinned crystals; it also produces high-quality integrated, absorption 
corrected data from single crystals. 

Assign Unit Cell 
TwinSolve has a separate step for cell refinement like d*TREK. The five steps for assigning the unit cell 
include: 

• Find Spots 

• Index Spots 

• Refine Cell 

• Get Twin Relations 

• Predict Spots 

Since TwinSolve is used primarily for twinned crystals, it is common to create a process only sample 
which refers to the image data from the original sample where it was created. TwinSolve Find Spots is 
normally performed using the collected images rather than the screen images. When you Index Spots 
with TwinSolve it picks out the spots which belongs to the major twin component to be used in indexing. 
It then removes them from the spot list. You should next Refine Cell on that component and then return 
to Index Spots for the next component. You should continue to loop through Index Spots and Refine 
Cell until no significant twin components are left. 

Find Spots 
Normally you select all collected images for the Find Spots step.  
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Find Spots Dialog 

 
 

Parameter Description 
Scan Table This is the standard scan table for selecting images to be used for the Find 

Spots step. By default the collected images are selected rather than the screen 
images. This is the normal and suggested practice for TwinSolve. 

Select Screen This is a short cut to select all the screen images. It is included for consistency 
with the other processing suites, but in TwinSolve it is often better to use the 
collected images. 

Clear All This short cut clears all image selections so that you can start over. 
Append spots to 
current spot list 

If you have done a Find Spots on a partial data set and want to add more 
images without starting over, you can check this box and then just select the 
new images. 

Background Images Number of images to use to calculate an average background image. 
Spot Size This is the number of pixels for an average spot. 
Neighbor distance  These are the X, Y, and Z average distances between neighboring spots 

measured in pixels. 
Peak threshold These are the criteria for choosing peaks. 

• Sigma. The I/Sigma above which pixels are considered as belonging to 
a peak. The I/Sigma is calculated after the non-uniformity correction 
has been applied. You can specify Sigma as 0, TwinSolve does not use 
this criterion which speeds up the process because it does not need to 
calculate an average background and standard deviation. However, a 
Sigma cutoff can often be useful, so generally you should set this to a 
reasonable value. 
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Parameter Description 
• Average Counts above the background average. 
• Minimum. This specifies the minimum count that a pixel must have to 

be considered part of a peak. A pixel must be above this minimum and 
have an I/Sigma higher than specified (if Sigma is not 0) in order to 
considered as part of a peak. 

Index Spots 
The TwinSolve Index Spots step indexes the major component, if any, from the remaining spot list. The 
indexed spots are then removed from the reflection file and this step is normally repeated (after doing a 
Refine Cell) until no major component is found. 

Index Spots Dialog 

 
 

Parameter Description 
Input reflection file The internal oriref.xor file should normally be selected. TwinSolve updates this 

file after indexing to mark the spots that have been used in the twin component 
indexed during the last run. 

Use first 200 available 
reflections 

The normal and recommended number of reflections to use is 200. 

Use reflections You can also specify a range of reflections to use (e.g., 100-500) if you don’t 
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Parameter Description 
want to use the first 200 for some reason. 

Max cell length If you enter 0, TwinSolve does not reject possible indexing because the cell is 
too big. It is usually best to specify a reasonable maximum cell dimension in Å. 

Min cell length If you want TwinSolve to reject cells that are two small enter a non 0 minimum 
cell dimension.  

Search mode There are two search modes available 
• Extensive. This takes longer but may find cells missed by the Quick 

mode. 
• Quick. This mode requires you to specify the percentage of reflections 

that must be indexed to cutoff the attempt to find a solution. 
Use Known Cell If you check this box, you must enter the cell parameters for the known cell. 

You should also specify: 
• Length tolerance. This specifies the deviation that is allowed from the 

specified lengths in Ångstroms. If you enter 0, a 3% error is used. 
• Angle tolerance. This specifies the deviation from the specified 

cell angles in degrees. If you enter 0, a 3% error is used. 
 

If there is a cell specified in the header it is first converted to a reduced 
primitive cell to provide defaults for the known cell. TwinSolve searches for a 
match to this reduced primitive cell. 

 

Index Spots Results Table 
The results of the TwinSolve indexing are displayed in a table. You are given the chance to accept this 
indexing scheme which updates the reflection list to mark the reflections that have been indexed by this 
solution. If you don’t accept this solution, then you can either return to change the index parameters or 
continue on with the components that you have found. 

 

Refine Cell 
After each component has been indexed, the cell should be refined by running the Refine Cell step. 
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Refine Cell Main Tab 

 
 

Parameter Description 
Reflection file The internal oriref.xor file should normally be selected. TwinSolve refines on 

reflection files rather than images. 

Active Component The twin components are numbered as they are created by Index Spots. 
Normally you refine the last component you created. 

hkl deviation This is the maximum allowed deviation that a reflection can have from the 
expected position and still be considered part of this component. When 
refining twins, it may be necessary to reduce this parameter to prevent 
overlapped reflections from biasing the refinement. 

Restrain using other 
components 

This causes the refinement to be restrained so that it is compatible with other 
twin components. This assumes that the twin components are just different 
orientations of the same unit cell. The components you want to use to restrain 
the refinement should go in a list separated by commas into the Include twin 
components edit box. The Reset All Twins buttons uses the refined cell for all 
twin components. 

Constrain unit cell 
according to symmetry 

Check this to force the refined cell to conform to the current symmetry class for 
this component. 

Refine Cell Advanced Tab 
This tab allows you to select the parameters to refine. If you need to refine only some of them at a time, 
you can start with a subset of these parameters checked and then add more checks and rerun for each step 
in the refinement process. 
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Parameter Description 
Detector displacements The detector options include 

• X center, Y center (Direct beam ) 

• Distance 

• Pitch, Roll, Yaw  

Crystal displacements The crystal displacement options include: 
• X, Y, Z  

Crystal goniometer The crystal goniometer options include: 
• Omega, Chi (Chi may be Kappa on your goniometer) 

Crystal orientation Rot1, Rot2, Rot3 
Unit cell This may have been constrained or restrained by the options on the main tab. 

Refine Cell Results 
After it runs Refine Cell displays an extensive table of results and gives you the option to accept or reject 
them. 
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If you accept these results, you are asked if you would like to transform this to a conventional cell. 
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If you click Yes you get an updated Index results table. 

 
 

Finally you are asked what you want to do next. 

 
 

Get Twin Relations 
If you have indexed more than one component, before you Predict Spots you are given the chance to 
review the twin relations in the Get Twin Relations step. When you click this step it runs immediately 
and shows you the results. 

 



 

CrystalClear  

 

CrystalClear TwinSolve Steps 10-9 

 
For each Twin Pair, this table reports a Twin Law and associated information. You are also given the 
chance to force all twin components to belong to the symmetry group of the first component. 

Predict Spots 
Once you have completed indexing and refining all the components, you can go on to Predict Spots to 
check the indexing. 

Predict Spots Dialog 

 
 

Parameter Description 
Scan Table This is the standard scan table for selecting images to be used for the Predict 
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Parameter Description 
Spots step. No images are selected by default, so you can choose the scans and 
images you want to predict for. 

Clear All This short cut clears all image selections so that you can start over. 
Box size The box size is used the starting point for the box size calculation for 

integration. 
Twin components You can either predict with All components or Specify components by listing 

them in the edit box separated by commas (e.g., 1,3,4) 
Predict alpha-2 spots If you are getting significant alpha-2 radiation onto your sample in your 

instrument you may want to predict the alpha-2 spots to make sure they are as 
expected. 

Integrate 

Integrate Reflections 
TwinSolve is able to integrate all components of a twinned crystal in a single run. 

Integrate Reflections Main Tab 
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Parameter Description 
Scan table This is the standard scan table for selecting images to be used for the Integrate 

Reflections step. Screen scans are not included in the Scan table. 

Select All This is a short cut to select all the images in the sample. 

Clear All This short cut clears all image selections so that you can start over. 
Integrate You can chose between All twin components and Only first twin component. 
Use TwinSolve 
proposed values 

Check this box is you want to use the values that TwinSolve proposes for the 
Box size and Full Width Half Maximum (FWHM). If you do not check this 
box, you should make sure that the values in the dialog below are as you intend. 

Box size This is the integration box size in X, Y,  and Z in pixels. 
FWHM This is the Full Width Half Maximum (FWHM) in pixels. 
Mask file You should usually select a mask file to mask out the shadow of the beam stop. 

The mask file can be created using the Image Display. The Set… button opens 
a file browser so that you can search for the mask file you would like to use. 

Integrate Reflections Advanced Tab 

 
 

Parameter Description 
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Parameter Description 
Explicit alpha2 
handling Check this box if you want to explicitly predict and integrate alpha 2 

reflections. You must specify the Alpha2 fraction. 

Save only non-
overlapped reflections Check this box if you only want to integrate reflections that do not overlap with 

other reflections. 

Profile model The two options are: 
• Automatic. The profile is adjusted automatically by TwinSolve. 
• Default Peak Shape. Use the default peak shape for all reflections. 

Number of images 
used for background 
and peak shape 
determination 

Background and automatic peak shapes are determined using multiple images. 
This parameter lets you adjust the number of images that are used. 

Batch prefix The prefix for the first batch. 
Check for 
reorientation 

If you check this box the orientation is refined periodically. When this happens 
is controlled by After every specified degreed of rotation. Note that this control 
is in degrees in the scan axis and not in number of images which might be 
different. 

Analyze Data 
Once the data have been integrated there are two steps in the Analyze Data group. 

• Laue Check 

• Space Group Check 

 

Laue Check 
The Laue Check step is used to determine the Laue group of the sample. 

Laue Check Dialog 
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Parameter Description 
Reflectin file input You can either Use orientation reflections (oriref.xor) or select one or more 

*.raw files from the list to use for the Laue Check step. 

Data to merge Reflection data is merged before the Laue Check is performed. The selection 
for Data to merge is either All data or Use only non-overlapped data for 
twin. If you choose this second option you must select a twin component. 

Laue Check Results 
The Laue Check results are shown in the Space Group Results table described in the next section. 

Space Group Check 
After the Laue Check, you should normally do a space group check. 

Space Group Check Dialog 

 
 

Parameter Description 
Reflection file input You can either Use orientation reflections (oriref.xor) or select one or more 

*.raw files from the list to use for the Space group step. 

Data to merge Reflection data is merged before the Laue Check is performed. The selection 
for Data to merge is either All data or Use only non-overlapped data for 
twin. If you chose this second option you must select a twin. 

I/Sig tolerance This is the minimum I/Sigma that a reflection must have to be included in the 
space group determination. 

Space Group Check Results 
After running the Space Group Check, you see the results in a table. 
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When you have reviewed the space group information click OK and this table is closed. 

Scale and Average 
The final steps in processing the data with TwinSolve through the CrystalClear interface include: 

• Num. Abs. Correction 

• Scale and Shape 

• Reject and Average 

• Final Cell Refine. 

The Final Cell Refine is just another instance of the Refine step described in the Refine Cell step, so it is 
not documented separately in this section. 

Num. Abs. Correction 
TwinSolve has its own numerical absorption correction program which is run by this step. 
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Num. Abs. Correction Dialog 

 
 

Parameter Description 
Input reflection file For this step you need to select an *.raw file for input. 

Formula You need to enter a molecular Formula here if you have not done so in Setup. 

Method You have three options for the method of absorption correction to be used: 

• No absorption correction 

• Gaussian integration 

• Spherical crystal 

Z value A Suggested Z value is calculated based on the Formula. You have the option 
of using this (click Use) or entering another Z value in Actual. 

Absorption You can specify the Absorption coefficient mu in inverse millimeters. 

Grid Points For Gaussian integration you can specify the size of the grid used in the 
calculation. 

Crystal description file For Gaussian integration there is also a list of crystal description files from 
which to choose. You can create a description file by running RAXShape. 

Radius The Radius is used for the Spherical crystal option. It is in mm. 

Scale and Shape 
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Scale calculates and applies scale factors to different batches of reflections in a reflection list, 
averages symmetry equivalent reflections, calculates merging and completeness statistics, and 
creates a reflection list of unique reflections.  
 
The data set as specified is divided into scale groups based on the scan/batch number and the 
rotation angle value. Scale factors are then determined such that the deviations between 
intensities for equivalent reflections are minimized. Then these scale factors are used, and in the 
same way Shape factors (absorption anisotropy) are determined based on the directions of the 
primary and diffracted beams through the crystal. First the shape factors are applied and new 
scale factors are determined. The shape factors are expanded in terms of Cartesian spherical 
harmonics up to the order 8. 

Scale and Shape Main Tab 

 
 

Parameter Description 
Input *.raw reflection 
file(s) For this step you need to select one or more *.raw files for input. 

Number of cycles The number of iterations in the scale and shape procedure. 

Equivalent reflections 
based on  Scaling is accomplished by looking at equivalent reflection. These can be 

selected by Laue group or Point group. 
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Parameter Description 
Twin correction 
functions You can specify the twin components that are used to calculate the scale and 

shape corrections. 0 means use all the available twins. Otherwise list them in a 
comma separated string (e.g., 1,3,4) 

Twin overlap 
combinations When comparing twin overlaps, the options are to: 

• Calculate for all twin combinations 

• No twin overlaps 

• Only specified twin combinations. The twin specification is taken 
from  the edit box under Twin correction functions. 

Spherical harmonics These are defaulted to Even = 4 and Odd =1. They seldom need to be changed. 

Weighting The weighting options are: 

• Use unit weights 

• Use actual weights 

Shape factor model There are several options for the Shape factor model: 

• Use diffracted beam direction 

• Use incident beam direction 

• Use vector perpendicular to scattering plan 

• Use scattering direction vector as reference direction 

• Average transmission for primary beam direction and diffracted 
beam direction 
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Scale and Shape Advanced Tab 

 
Parameter Description 
Scaling The parameters that control scaling include: 

• Exclude sigma. The I/Sigma value below which reflections are not 
used to determine scaling. 

• Rejection minimum.  

• Rejection maximum. 

Scale width Set the Scale Width (in degrees) for batch scale factors. 
Weight multiplier The variance of I is increased by (multiplier * I)**2 upon output of each 

reflection. 
Restraint sigma Sigma of the least-squares restraint that the absorption anisotropy should 

be close to zero, that is the absorption factors should be approximately = 
1.0. The default is 0.0001 (a value of 0.000 implies that the default is 
used). This restraint effectively constrains most of the correction to occur 
in the scaling rather than in the absorption correction. 

Smooth scale factors Constrains the scale factors to vary smoothly from group to group. 
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Reject and Average 
Reject and Average is the penultimate step in TwinSolve processing which does the final averaging and 
writes the reflection files for use in structure solution. 

Reject and Average Dialog 

 
Parameter Description 
Input *.raw reflection 
file(s) Choose one or more reflection files to Reject and Average. 

Output The output file formats supported include: 

• SHELX.hkl 

• d*TREK.ref 

• Saint.raw 

In addition you can specify a Scale factor which is applied to all reflections. 

Rejections There rejection options are: 
• None  No reflections are rejected at this stage. 
• Use Chauvenet criterion. For this option you need to specify a 

rejection limit. 
Twin Output This allows you to select which twin components to include in the output file. 0 

means all merged data, but you can also specify a list of twin components 
separated by commas. 
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Parameter Description 
Twin overlap 
combinations 

When averaging reflections the following options are provided for handling 
overlapped reflections between combinations of twins: 

• Calculate for all twin combinations 
• No twin overlaps 
• Only specified twin combinations (taken from the Twin output list). 

Add selected twin 
component intensities 

Under certain conditions you can add intensities from overlapping twin 
compoenents. 

Averaging The options are: 
• None 
• Use unit weights 
• Use 1.0/sigma(F2obs)**2 

• Use robust-resistant weights 

• Use robust-res.weights/sigma(F2obs)**2 
Average Limit This is the limit to the number of reflections that can be averaged. 

 

 

Menu Operations 
The operations included in this section are accessible through the menu, but do not have corresponding 
steps in the flow bars so they have not been documented elsewhere. 

Sample>Set Resolution 
TwinSolve resolution is normally specified in degrees. If you are in TwinSolve mode, this function brings 

up a different dialog than is used by d*TREK. This is also true if you click the  icon in the main 
CrystalClear toolbar. 

Set Two Theta Limits Dialog 

 
 

Parameter Description 
Minimum Minimum resolution in 2 Theta degrees. 
Maximum Maximum resolution in 2 Theta degrees. 
To Edge of Image Set the Maximum resolution to the edge of the current image. 
To Corner of Image Set the Maximum resolution to the corner of the current image. 
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Cell Tools|Transform 
The TwinSolve cell transformation has a very similar interface to the d*TREK command. 

Cell Transform Dialog 

 
 

Parameter Description 
Twin component Each twin component must be transformed separately. Select the component 

you want to transform. 
Transformation Select the transformation you want to perform from the drop down list. 
Transformation matrix This is a read only display of the transformation matrix unless you choose 

Custom Matrix as your Transformation option. The Determinant and Right-
Handed or Left-Handed are displayed but not editable. 

Find Transformations Click this button to compute the transform that would result in the lowest R-
merge for the Reflection and the Reference reflection files. The results are 
show above this button and you can use the <> buttons to examine the ranked 
solutions. 

Transform h,k,l in 
*raw file 

If you want to transform the hkl’s as well as the cell parameters, check this box 
and select the *.raw file that you would like to transform. 

Current Cell This is a read only display of the current cell. 
New Cell Unless you select Custom Cell as the option for the Transformation, this is just 

a read only display of the new cell. If you do select Custom Cell, you can enter 
the basic cell parameters. 

Reindex This applies the specified transformation to the cell and updates the reflection 
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Parameter Description 
(*.raw) file if that option was selected. 
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11. Reciprocal Lattice Viewer 

The Reciprocal Lattice Viewer can be used view reflections in reciprocal space. This can help you decide 
if the crystal is twinned, whether your coverage is complete, and whether the indexing looks reasonable. 
For small molecules with twinning, the Reciprocal Lattice Viewer can be used in conjunction with 
TwinSolve to display the indexing for the various twin components. It is possible to index manually with 
the Reciprocal Lattice Viewer if automatic indexing fails. 

Getting Started 

The Reciprocal Lattice Viewer is When activated via the CrystalClear main toolbar icon , you are 
immediately prompted to select a Reflection File Name (e.g., dtfine.ref). The Reciprocal Lattice 
Viewer uses the current cell parameters (including any twin information found by TWINSOLVE) when 
displaying lattices.  

NOTE:  Since Reciprocal Lattice Viewer uses d*TREK for its crystallographic functions, it is not able 
to process a reflection file that has more than one scan (e.g., from TWINSOLVE). However, 
it loads the reflection file you select and allows you the option of splitting it into a d*TREK 
compatible scans. 

Toolbar 
The Reciprocal Lattice Viewer functions are activated by clicking on the toolbar icons or by 
right clicking on a reflection. 
 
Icon Name Description 

 
Open Reflection File Read in a new reflection list. 

 
Display Options Modify the rendering of reflections. 

 
Color Options Set the color of reflections.  

 
Select Reflections Select the reflections you want to view and optionally update 

the reflection file 

 
Measure distances, angles, and 
volumes 

Measure distances angles, and volumes 

 

Define Cell Planes Selects reflections in parallel planes for manual indexing  

 
Cell Operations Modify the cell parameters. 

 
Twin Operations Selecting the current twin component, creating and delete twin 

components, and various other operations. 

 
Cell Display Toggle on or off for display and viewing control. (Default is 

on if cell definition is present). This button is for display and 
viewing control. 
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Icon Name Description 

 
Viewing Transformations Set the viewing transform to set the view to: 

 1. Look down an axis 
 2. Look perpendicular to a plane 
 3. Apply a fixed rotation around an axis. 

 

Rotate 90 degrees about screen 
X 

Rotate view 90 degrees in direction indicated by the arrow. 
This button is for display and viewing control. 

 
Rotate 90 degrees about screen 
Y 

Rotate view 90 degrees in direction indicated by the arrow. 
This button is for display and viewing control. 

 
Rotate 90 degrees about screen 
Z 

Rotate view 90 degrees in direction indicated by the arrow. 
This button is for display and viewing control. 

 

Reset View Restores the initial view. This button is for display and 
viewing control. 

 
Fine mode When this button is activated the screen controls have a finer 

resolution. This allows you to position the view that can be 
useful when trying to line up reflections. Clicking it again 
toggles to the off state. 

 
Pick mode This button changes the Rotation Cursors to a Pick Cursor so 

you can rotate the display or select a reflection to be centered 
in the rotation; or to display its properties. 

  

Cursor controls 

Use the  Control Button to toggle between Pick Mode and Rotation Mode. When a normal arrow 
cursor is displayed, you are in a Pick Mode. When a special arrow cursor is displayed, you are in a 
Rotation Mode. Each mode has several options. 

Pick Mode 
When a normal arrow cursor is displayed, it indicates you are in Pick Mode.  
 
Pick Mode Functions  
(Normal Cursor) 

Description 

Left-click reflection Select reflection and perform operation active in current dialog. 

NOTE:  Inactive unless a dialog is active. 

Right-click reflection Access menu with two options:   
Set Center of Rotation: Set reflection to be the center of rotation. 
Report Properties: Displays resolution, HKL, and other properties 
associated with the reflection. 

Right click / drag. Selects multiple reflections by dragging a selection rectangle over 
them (Only active when the interactive selection option is selected in 
an appropriate dialog.) 

Left click blank screen / drag. If you do not right click any object, the system reverts to 
transformation mode. All transformations active. Special cursors not 
displayed. 
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Rotation Mode 
The special arrow cursors indicate you are in Rotation Mode. Viewing operations are activated by 
clicking and dragging. The operation performed depends on the area of the screen in which you first click, 
as shown in the table below. 

NOTE:  Right-clicking in Rotation Mode has the same effect as Pick Mode. 

Special Cursors Screen Location 

 
XY Rotation - Comprises middle 80% of display.  

 
Zoom- Comprises left 10% of display. 

 
Y Translate - Comprises right 10% of display. 

 
Z Rotation- Comprises top 10% of display. 

 
X Translate- Comprises bottom 10% of display. 

  

How to Use the Reciprocal Lattice Viewer 
This section gives short instructions for using the Reciprocal Lattice Viewer for several common tasks 
including: 

 Edit a reflection file 
 Edit cell parameters 
 Manually indexing of a non-twinned sample 
 Manual indexing of a twinned sample 
 Examine HKL planes 
 Use as a reflection viewer 
 

NOTE:  If using d*TREK for Find Spots, usually a 3D Find is used for the Lattice Viewer. Perform 
Find on several images to provide enough three-dimensional information for automatic plane 
detection to be accurate. 

Edit a Reflection File 
Periodically indexing fails in the Index Spots operation of CrystalClear because of certain spots which 
appear on the image, but are not really valid reflections. While it is possible to edit reflections in the 
CrystalClear image viewer, it may be easier to see the problem in reciprocal space. Using the Lattice 
Viewer, you can edit a reflection file (i.e. dtfind.ref). This reflection file is created even when using 
TwinSolve. 
 

1. Start the Reciprocal Lattice Viewer. The Open Reflection List dialog appears.  
2. At the prompt to select a Reflection File Name, for this example select the dtfind.ref file. 

3. Access the Select Reflections dialog using the  icon.  
4. Edit the reflection list. The detailed instructions for doing this are found in the description of this 

dialog. It is often useful to Delete Excluded reflections as you go along. 
5. Use Write Selected to write an edited file. 

6. Exit Lattice Viewer by accessing the Twin Operations dialog using the  icon. 
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7. DO NOT SAVE when asked to save. Your reflection file has already been update and you do not 
want to pull any cell information from the Reciprocal Lattice Viewer. 

8. Now try to index using the edited reflection file. 
  

Edit Cell Parameters 
If you suspect the cell parameters are wrong (e.g., one axis is twice as long as it should be), you can 
examine the quality of the indexing and adjust the cell parameters as needed. 
 

1. Access the Twin Operations dialog with the  Control Button. 
2. Set the Indexing Tolerance (Remember to Index again). If there is more than one Component, 

select the Component you want to look at. 
3. Access the Cell Operations dialog with the  Control Button. 
4. Adjust the Cell parameters. The Reciprocal Lattice Viewer re-indexes at each update so you can 

see how well the current parameters index. 
5. Go back to the Twin Operations dialog.  
6. Click Save All to send the Current Component cell information back to CrystalClear. 
7. Continue working in CrystalClear with the new cell. 

 

Manual Indexing of a non-twinned sample 
If normal Index Spots with CrystalClear has failed, or has produced questionable results, you may try 
manual indexing using Reciprocal Lattice Viewer. If the crystal appears to be twinned, use the procedure 
for handling twinned crystals. If the crystal does not appear to be twinned, use the procedure as follows:  

1. Access the Define Cell Planes dialog by using the  Control Button. 
2. Click Best Views button. (This process may take some time.) 
3. Select planes by stepping through the Views in the drop-down list until you find one that has 

parallel planes that you think may bound the cell. 

NOTE:  Planes may be found through two different methods:  (1) Best View/Best Plane and (2) 
Interactive Select. You can use either method or mix methods. 

4. Click Best Planes button. (This process also takes some time.) 
5. Step through the Best Planes in the drop-down list. When you find the first plane that looks like 

it might bound the cell, click Set A.  
6. Continue stepping through the planes until you find another set that looks promising, click Set B. 

You may have to go to another view to find Set B, but often you can find A and B from a single 
view. 

7. Go back to Best View selection and continue stepping through the Best Views until you find 
another good view. 

8. Click Best Planes again for this view and step through the planes until you find the final set of 
bounding planes and then click Set C. 

9. Click Cell From Planes to do a Cell Reduction. Select the appropriate cell from the drop down 
list. 

10. Access the Twin Operations dialog by using the  Control Button. Click Save All and then 
click Exit. 

11. Continue working in CrystalClear with the new cell. 
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Manual Indexing of a twinned sample 
If you suspect twinning, you can use the following procedure to manually index the twin components. 
This procedure is basically the same as for the non-twinned case, but it is repeated for each twin. 

1. Access the Define Cell Planes dialog by using the  Control Button. 
2. Click Best Views button. (This process may take some time.) 
3. Select planes by stepping through the Views in the drop-down list until you find one which has 

apparent parallel planes. 

NOTE:  Planes may be found through two different methods:  (1) Best View/Best Plane and (2) 
Interactive Select. You can use either method or mix methods. 

4. Click Best Planes button. (This process may take some time.) 
5. Step through the Best Planes in the drop-down list. When you find the first plane that looks like 

it might bound the cell, click Set A.  
6. Continue stepping through the planes until you find another set that looks promising, click Set B. 

You may have to go to another view to find Set B, but often you can find A and B from a single 
view. 

7. Go back to Best View selection and continue stepping through the Best Views until you find 
another good view. 

8. Click Best Planes again for this view and step through the planes until you find the final set of 
bounding planes and then click Set C. 

9. Click Cell From Planes to do a Cell Reduction. Select the appropriate cell from the drop down 
list. 

10. Access the Twin Operations dialog by using the  Control Button.  
11. Click Remove to remove the reflections that are indexed by the current component.  
12. If there are still a significant number of reflections left, Click Create New to create a new 

component and go to step 3. Repeat for each twin component until there are no longer enough un-
indexed reflections left to justify continuing. 

13. When you are done, click Save All and then click Exit. 
14. Continue working in CrystalClear (using the TwinSolve processing suite) with the new twinned 

components. 

Examine HKL Planes 
You can use Lattice Viewer to examine the HKL planes in your integrated data. 

1. Access the Select Reflections dialog by using the  Control Button.  
2. At Property, select HKL. Select Include Only as the Property function. 
3. Enter the plane you want to view into the HKL parameters (eg. 0 * * for 0KL.)  Click Update 

Selection. 
4. Click Delete Excluded. This removes everything else so you can see the plane clearly. 
5. If you want to look at another plane, click Restore All. This brings the reflections back. Now go 

to step 5. 
6. When you are finished, click Cancel to exit Lattice Viewer without saving. 

  

Use as a Reflection Viewer 
The Reciprocal Lattice Viewer can be used as a diagnostic tool to view any reflection file (i.e. *.ref file) 
as long as there is some sample information (or a .head or image file) available. Sometimes it is just 
useful to look at a reflection file in reciprocal space to see what is going on. For example, you can look at 
dtintegrate.ref to determine your coverage of reciprocal space. Or you may look at a dtfind.ref to see if 
you can figure out why index is failing. 
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Operations 
The Reciprocal Lattice Viewer is run through a series of dialogs that are activated through the toolbar at 
the top of the display 

Open Reflection List 

 When you start up the Reciprocal Lattice Viewer you are prompted to select a reflection list. 
However, during the operation of the Reciprocal Lattice Viewer you can open a different reflection list 
and image file by clicking on this icon and selecting the files. 
 
When you use the Open Reflection List dialog, you are no longer be able to save the results back into 
CrystalClear since they may not be compatible with the current sample.  
 
The image file (you can, and usually should, use a header file) contains the current cell information for 
this sample. The Reciprocal Lattice Viewer displays this cell if there is crystal information the header. 
Otherwise the Reciprocal Lattice Viewer creates a default cell and turns the cell display off (10, 10, 10, 
90, 90, 90).  
 

Open Reflection List Dialog 
 

 
 
 
 
Parameters Description 
Reflection File Name 

The reflection list (*.ref) to be displayed. Click the file browser button  
to locate the file. This file need not be in the existing sample.  

Image File Name Specifies a file from which to extract header information (*.head, *.img, or 

*.osc)  Click the file browser button  to locate the file. This should be 
from the same sample as the reflection file, but need not be the current 
sample.  

OK Button Accept new file and close dialog.  
 
  

Display Options 

The Display Options dialog allows you to change the display style of the reflections. 
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The axes are not transformed by any detector or cell transformations. The cell positions are calculated by 
multiplying a unit cell by the orientation matrix and then drawing them at various offsets according to the 
spacing indicated in the dialog.  

Display Options Dialog 

 
 
 
 
Control Groups Description 
Style Control 
  Display Style  Controls display of reflections as dots or spheres.  

 Dots on update 
 Dot Always 
 Spheres always 

If there are fewer than 50 reflections, the default is Dots on Update. If 
there are more than 50 reflections, the default is Dots Always. 
If you are drawing lots of spheres with slow redraw times, it is possible to 
lose mouse events. If you can't rotate for a while, just wait and let all the 
redraws process and it re-activates. If you have a fast computer with a good 
graphics card, you may want to select Sphere always since it is easier to see 
the reflections as spheres. 

Dot Size  Draw bigger dots if single pixel dots are hard to see. Dots are drawn at the 
minimum size if Scale Reflection Size is unchecked.  

NOTE: Large dots are not centered because the lower-left corner of the 
dot is at reflection position. 

Sphere Size Sphere Sizes are in reciprocal space coordinates (i.e. small -- 0.005 is the 
default) 

Display Cell  Check to display cells, uncheck to remove cells. This can also be toggled by 
the Cell Display icon in the toolbar. 

Cell Spacing  Controls the spacing between the cells. There is an NxNxN lattice of cells.  
Cell Replicates  Controls the number of replicates (N above) for the cell display. 

Scaling Control 
  Reflection 

Property  
Scale the reflections on: 

 Intensity 
 I/Sigma 
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Control Groups Description 
Scaling Function  The color and size scaling can be: 

 Linear 
 Square Root 
 Log 10 

Scale Reflection 
Size  

Scale Reflection Size is useful for impressive pictures (in sphere mode), 
but sometimes makes alignments and other interactions more difficult. 

Scale Reflection 
Color  

Scale Reflection Color applies both to spheres and dots. Default is neither 
size nor color used. This makes it easier to see what has been indexed 
(blue). 

OK Button Accept the new values and close dialog. 
Apply Button Apply the current selection and redraw the picture. It is best to use Apply 

rather than OK to experiment with settings until you get something you 
want to work with. 

Cancel Button Close the dialog. Any changes that have not been “applied” are lost. 
  

Color Options 

The Color Options dialog allows you to change the colors in the Reciprocal Lattice Viewer. This is 
mostly used for presentation. The reflection colors carry meaning, so they should not normally be 
changed for day to day work. 

The Color Ramp is the color that is assigned to selected reflections. This color may be scaled by the 
intensity, so a ramp (with a low value and a high value) must be specified.  

Color Options Dialog 
 

 
 
 
Control Groups Description 
Property Selection 
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Control Groups Description 
  Property Select the Property that is changed. The drop-down menu 

choices are: 
 Color Ramp (blue for the first component) 

 Rejected (fuchsia)  
  Ignored (green) 

 Unselected (dull yellow) 

 Unindexed (pink) 

NOTE:  Color Ramp is used to show the select reflection 
property (e.g., I/Sigma) if Scale Reflection Color is 
the current display option. It only applies to the 
Current Component. When Scale Reflection Color is 
not checked, the Color Low value is used. 

Component This read-only-control shows current Component. The Color 
Ramp applies to this component.  

NOTE:   Color Ramp is used only for the Current 
Component. All other Components are drawn at their 
Color Low values. 

Color Selection 
  Color Low 

Color High 
RGB values (0-256 and comma separated) for the color.  

The browse button  brings up the Windows color dialog, 
which allows you to pick colors interactively. The display is 
redrawn when these values are changed. 

OK Button Accept the displayed values and close the dialog. 
Reset Button Restore the default values built into the program and redraw the 

display. 
Cancel Button Close the dialog with displayed values. 
  

Select Reflections 

 Many operations in the Reciprocal Lattice Viewer work on selected reflections. This dialog 
provides a very powerful set of tools for selecting reflections based on various criteria. This power is at 
the cost of some abstraction in the operations, so it is useful to read this description carefully and 
experiment with various selections to understand how this works. Unselected reflections are normally 
displayed in a dull yellow. Selected reflections are displayed depending on their status (indexed, rejected, 
etc.)  Since the reflection status is color coded, it possible to experiment without actually performing the 
operations just by looking at what has been selected visually.  
 
As an example if you want to exclude reflections within the resolution range from 2.5 to 2.4, you would: 

1. In Property drop-down list, select Resolution. 
2. Set Min to 2.5 and Max to 2.4. 
3. In Property function drop-down list, select Exclude. 
4. Click Update Selection. 
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Select Reflections Dialog 

 
 
 
Control Groups Description 
Property This specifies the property that is used to select the reflections to go into the 

selected reflections list. 
• Intensity. Absolute intensity of the reflection 
• I/Sigma. This allows you to remove weak reflections 
• Resolution. This allows you to remove high resolution reflections if 

they are causing problems. 
• Phi. This allows you remove a range of reflections based on the scan 

angle. 
• Interactive. When you select this option you should select the 

reflections you want by right clicking on the display and dragging out 
the reflections you want to select. You are dragging out a rectangular 
box, so it is best to orient the display so that the reflections you want 
to choose are in a horizontal or vertical line. 

• HKL. The most frequent use of this option is to view a plane in hkl 
space. 

Property function Each reflection has a status of selected or unselected. The unselected 
reflections are shown in dull yellow. The selected reflections are color coded 
depending on their status (indexed, rejected, etc). These functions specify 
how the currently selected reflections relate to the current status. When you 
start all reflections are selected. 

  Include Any reflections that meet the criterion are selected. Conversely, all those 
that do not match are unselected so they show up yellow. This does not 
change the state of any of the reflections which are not selected, so the effect 
is to add to currently selected reflections to the total list of selected 
reflections. 

Exclude Change the state of selected reflections to unselected. This removes 
reflections from the currently selected list by marking them as unselected so 
that they show up yellow. In some cases, it is useful to use Delete Excluded 
button to remove the excluded reflection. In you need to you restore them 
later with Restore All 

Include Only This first marks all reflections as unselected and then just selects those that 
meet this criterion. So this essentially starts from scratch.  
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Control Groups Description 
  Property Value 
  Mininum 

Maximum 
Set the Min and Max Property Value. These are defaulted to the actual Min 
and Max values found when reading in the reflection list. 

HKL (Use * for Variable) 
  H 

K 
L 

These edit boxes are only enabled if the Property is HKL. Each box should 
have a valid index or an * to indicate that it is variable. For example you can 
select a plate by using 0,*,*. 

Edited File 
  File Name The File Name for writing the edited reflections. This file is stored in the 

current sample directory. 
Update Selection  Updates the selection based on the value in the Property function drop-

down. This is normal button to use as you build up the selection list by 
selected reflection operations. 

Delete Unselected  Deletes unselected (dull yellow) reflections from the reflection list in 
memory. They are no longer displayed. If you need to restore them you can 
click the Restore All button. 

Select All  Select all reflections (i.e., marks all reflections as selected). 
Restore All  Return to original state of list when this dialog was opened. 

NOTE:  The original reflections are lost if you close dialog using OK, then 
re-enter it. 

Write Selected Button Write selected (displayed) reflections into a file. Edited File Name is used. It 
is stored in the current Sample directory.  

NOTE:  If the primary purpose is to edit the reflection list using Lattice 
Viewer, be sure to use Write Selected button to write the edited 
list. 

Cancel Button The Cancel  button performs a Restore All before closing the dialog. 
OK Button OK keeps the current selection status of the reflections. 

NOTE: The original reflection list is lost if you close the dialog using OK, 
and then re-enter it. 

   

Measure Reflections 

The dialog that pops up when you click Measure Reflections provides various tools for measuring 
distance, angle, and volume. The reflections used in the measurement are picked from the display by click 
them with the mouse. The distance and volume measurements are in real space in Angstroms. The angle 
measurements are in real space degrees. 
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Measure Reflections Dialog 

 
 

 
Control Groups Description 
Measurement Property The selected property is automatically calculated when all the reflections are 

defined. 
 Distance 
 Angle 
 Volume 

Pick Reflections 
Reflection 1 
Reflection 2 
Reflection 3 
Reflection 4 

These values are the current indices of the reflections in the reflection list. 
They are useful as a visual feedback that a reflection has actually been picked. 

Results of Last Measurement 
Distance 
Angle 
Volume 

Results of Last Measurement of Distance, Angle and Volume are displayed 
here. The Distance and Volume are in real space Angstroms and the Angle is 
in real space degrees. The results are also displayed on the screen. 

Function Buttons 
OK Close the dialog. 
Clear Clears the values. Allows you to clean up the clutter from measurements. 
Cancel Close the dialog. 

 

Define Cell Planes 

Visual or manual indexing is a process of finding bounding planes in reciprocal space. This is a two 
stage process: 

1. Find a view where the reflections line up. Since the selection mechanism is a bounding 
box, the reflections should line up horizontally or vertically rather than at an angle. 

2. Select reflections that form a bounding plane. 
 
The Reciprocal Lattice Viewer provides two methods for manual indexing. 

Method (1) - Best View / Best Plane 
The first method for defining planes is a two step process. The first step is started by clicking on 
Best Views. This runs an algorithm which attempts to align reflections so that parallel planes are 
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clearly visible (i.e. perpendicular to the view). This process may take a few minutes for large 
reflection lists.  
 
Select one of these views from the drop down list and, if the view looks promising, click Best 
Planes. This attempts to find sets of parallel planes in the selected best view. This process may 
also take a few seconds to run.  
 
Then you can go through the Best Planes in the drop down list. They show up as red lines on the 
screen. If one of these planes appears to be a good candidate for a cell boundary, click Set A for 
the first set, Set B for the next set, etc. The current planes are drawn as green planes if only one 
set is defined (they look like lines straight on) or a parallelpiped which is either extend for two 
planes defined or the shape of the cell if all three planes are defined.  

NOTE:  You have to use at least two best views in order to get all three planes and not all views 
nor all planes are good candidates for indexing. 

Method (2) -Interactive Select 
The second method for defining planes is to select them interactively by dragging the right button 
of the mouse over a set of reflections that you think form a plane. Note that you don't have to 
select the whole plane all at once. You can select a few reflection and then add a few more. The 
selection accumulates until a Set button or the Clear Selection button is used.  
Once a Set button is used, the Reciprocal Lattice Viewer attempts to find a plane that fits the 
selected reflections and a plane which is parallel to it.  

NOTE:  If only one or two images are selected for indexing, there is very little 3D information 
for finding these planes. As a result, the fit is sometimes not very good. 

Mixing Methods for Defining Planes 
The two methods for defining planes can be mixed. For example you may define planes A and B 
with the Best View / Best Plane, and define C with Interactive Select. 
 

Click the Cell From Planes button once the three planes are defined (green box on the display screen and 
distances between the planes are listed in the A, B, and C parameters for the cell). This runs a Cell 
Reduction algorithm and puts a list of possible cells into the drop down list. You can enter a different 
residual for the cell reduction if desired. 
 
Once the desired cell has been selected, go to the Twin Operations dialog (rotated boxes) to either  

 Create a new twin component, or  
 Save your results 

 

Define Cell Planes Dialog 
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Control Groups Description 
Best View Selection 
  Best Views Best View Selection attempts to compute ten Best Views for recognizing 

parallel planes in the reflection list. When these views have been calculated 
they appear in the drop-down list. The selected Best View from this list 
appears in the display. 

Best Plane Selection 
  Best Planes Best Plane Selection attempts to find ten Best Planes in the current view. 

The selected Best Plane appears in the display as red lines. 
Set A 
Set B 
Set C 

Used to Set A, B, and C planes (respectively) from the current Best Plane. 

NOTE:  You must define all three planes before using Cell From Planes. 

Cell Reduction 
  Cell From Planes Cell From Planes produces a list in a drop-down menu similar to the 

following: 
 Unreduced (blank) 
 Triclinic 1 
 Monoclinic 2 
 Orthorhombic 4 
 Orthorhombic 5 
 Orthorhombic 6 
 Trigonal 7 
 Tetragonal 8 
 Tetragonal 9 
 Trigonal 10 
 Monoclinic 11 

The selected Cell Reduction appears in the display as green lines. 
Unreduced displays blank.  

Residual The Residual value is displayed. 
Select Plane Interactively 
  Select Reflections in 

a Plane 
Set A 
Set B 
Set C 

Used to Set A, B, and C planes (respectively) to define the selected plane. 

Component 
  Component Displays the current Component being indexed  

NOTE:  This field is Read-Only. Refer to Lattice Viewer Twin Operations 
dialog to change to a new component. 

Current Cell 
  A 

B 
C 
  
Alpha 
Beta 
Gamma 
  
Rot1 

NOTE:  These parameters are Read-Only. Go to the Cell Operations 
dialog to change controls. 

These controls show: 
 the Current Cell,  
  the A, B, and C values are the distances between the parallel 

planes if you are indexing 
 Orientation Angles 
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Control Groups Description 
Rot2 
Rot3 

Clear Selection Button Clears the reflections that have been selected interactively. 
Delete All Planes Button Deletes the current planes so that you can start over again. 
OK Button Close the dialog. 
Cancel Button Close the dialog. Cancel does not undo the cell definition.  
 

Cell Operations 

 The main purpose of the Cell Operations dialog is to review and make adjustments to the cell 
parameters. If you know cell parameters from other sources, you can just enter them directly. Or you can 
make minor changes to various parameters through interactive controls. For most manual indexing the 
Define Cell Planes dialog is much more powerful and easier to use. 

Cell Operations Dialog 

 
 
 

Control Groups Description 
Current Cell 
  A 

B 
C 
  
Alpha 
Beta 
Gamma 
  
Rot1 
Rot2 
Rot3 

Current Cell values can be adjusted with the interactive controls or you 
can enter these values.  
  
 
In Windows fashion, these edits only "take" when the focus moves to 
some other control (e.g., Tab, but not just Enter.). 
  
  
 
Orientation Angles 

Component 
  Component Displays the current Component being indexed  
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Control Groups Description 

NOTE:  This field is Read-Only. Go to the Twin Operations dialog to 
change to a new component. 

Interactive Controls 
  Cell Lengths 

Cell Angles 
Rotation 

Adjust the selected property values with sliders: 
Each adjustment has a Medium, Coarse, or Fine mode. Fine mode 
always centers each slider. Medium and Coarse modes use a constant 
scale for all three controls. 

Restore Cell Button Return to the cell which was defined when you opened this dialog. 
Default Cell Button Resets a 10, 10, 10, 90, 90, 90 cell. 
OK Button Close the dialog and update the cell with any changes that have been 

made. 
Cancel Button Close the dialog and do not update. 
  

Twin Operations 

 The Twin Operations dialog is used for selecting the Current Twin Component, creating and 
deleting twin components, and various other operations.  
  
Twin Operations and Cell Planes are usually used in conjunction to index a set of twin components. The 
normal flow of interaction is: 
 

1. Start up the Lattice Viewer from CrystalClear Toolbar. 
2. Use the Cell Planes dialog to index some of the reflections. 
3. Use the Twin Components dialog to remove the reflections that have been indexed. 
4. If there are still significant numbers of un-indexed reflections, create a new component with 

Create New and go back to step 2 for the new component. 
5. Otherwise use Save All to save the twin components definitions and refection lists back into 

CrystalClear and Exit. 

Twin Operations Dialog 
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Control Groups Description 
Current Component 
  Current Component  Select the desired Component from the drop down list. The cells for the 

selected Component are displayed as soon as the Component is 
selected. 

Create New Create a new Component. 
Delete Delete the current Component. This may result in the renumbering of 

other Components. 
Reference 
  Reference The cell is displayed if it is different from the Current Component and 

the Display box is checked. For example you can use this to see the 
relationship between the current component and the first component. 

Display Display check-box is used to display a different Current Component. 
Indexing 
  Tolerance Sets the Tolerance for indexing. Each reflection is Indexed to a 

floating point number. If the number is within an integer of this 
Tolerance, the reflection is considered to be Indexed. This value is 
global for all Components. 

Re-Index This Re-indexes the reflections for the Current Component using the 
new Tolerance. This is done using d*TREK indexing. 

Update Components 
  Save All Send the Current Component cell information back to CrystalClear 

and write a full reflection file with all reflections marked with the 
component which indexes them. The reflection file is called TwinAll.ref 
and is stored in the open sample. 
 
If you have used the Open Reflection List dialog to look at a different 
reflection file, you should not attempt to do a Save All to CrystalClear 
since this may not match the current sample. 

Exit Exit Lattice Viewer. You can also exit by clicking on the X in the 
corner of the view. 
.  
If Lattice Viewer detects changes that may have been made, you are 
asked if you would like to Save. Only reply "Yes" if you have made 
changes to the Twin Component cells that you would like saved into 
the CrystalClear state for the current sample. 

Indexed Reflections 
  Exclude The Indexed reflection is drawn in the unselected color (yellow by 

default). This is useful if the current color selections are such that it is 
hard to see what has been Indexed. This is simply a display function 
and does not update any files.  

Remove  Currently, d*TREK algorithms work on the whole reflection list that is 
displayed (selected or not). Before you go on to the next Component, 
you should remove the reflections indexed by the Current Component. 
This gradually diminishes your reflection list, but when you update 
CrystalClear with the Save All button, the full reflection list with all 
components is sent back to CrystalClear. 

Restore All Restore any reflections that have been removed, but only if the Twin 
Operations dialog has not been closed and re-opened. Once the dialog 
is closed, the reflections cannot be restored, but they are saved. 

Reflection File Displays the Reflection File into which the indexed reflections are 
written. 



 

CrystalClear  

 

CrystalClear Reciprocal Lattice Viewer 11-19 

Control Groups Description 
Write Indexed Write a reflection file with only those reflections that are indexed by the 

Current Component. The file name is given by Reflection File and it 
is stored in the currently open sample. It is not usually necessary to do 
this since the full reflection file is normally written by Save All, but it 
may be useful in some circumstances. 

OK Button Close the dialog with displayed values. 
Cancel Button Close the dialog. 

 

Viewing Transform 

 It is often useful to be able to view reciprocal space along an axis or perpendicular to a plane. This 
dialog gives you tools for setting the view. This just sets the current view to the orientation chosen. The 
view can still be manipulated interactively. 

Viewing Transform Dialog 

 
 
Control Groups Description 
Look Down Axis 
  a* 

b* 
c* 

Orients the view looking down the selected axis. 

Perpendicular to Plane 
  a*b* 

b*c* 
c*a* 

Orients the view looking perpendicular to the plane. 

Fixed Angle Rotation 
  Axis Rotates the view a specified amount about the selected axis. 

•  a* 
•  b* 
•  c* 

Degrees 
  
Apply Rotation 

Enter the desired value in Degrees, then click Apply Rotation. The display 
refreshes. 

OK Button Closes the dialog. 
Cancel Button Closes the dialog. 
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12. Tools 

The tools described in this section are accessed through the menu. For this reason the descriptions of these 
tools are organized by their location in the menus. Functions and dialogs that have already been described 
previously (e.g., in the chapters on Data Collection, d*TREK Processing, etc) are not included in this 
section. The tools that are included in this chapter include: 

• File Menu 

• Purge Files 

• Utilities 

 Write Sample 

 Write d*TREK header 

 Read d*TREK header 

 Write PROCESS Resource 

 Read PROCESS Resource 

 Change Image Directory 

 Prepare Bug Report 

 Write CIF 

 Determine Structure 

 Move User Data Directories… 

 Prepare Structure Determination Area 

• Info 

• Print 

• Edit Menu 

• Header/Database editor 

• Sample Menu 

• Search NIST database 

• Search Cambridge Structural Database 

• Instrument Menu 

• Compute Axial Photographs 

• RAXVideo Version 

• Tools 

• Preferences 
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File Menu 

File>Purge Files 
Various files kept in the CrystalClear sample directory are versioned either with a *.1, *.2, etc or with an 
*_1.*, *_2.* etc. For example if you have run index 3 times, you have dtindex.log, dtindex.log.1 and 
dtindex.log.2. The most recent file is dtindex.log. The second most recent is dtindex.log.1, etc. If you do a 
lot of work in a sample, these files can mount up. This function helps you purge them. This applies only 
to the currently open sample. 

Purge Files Dialog 

 
 

Parameter Description 
Select files to delete The files in this list is all the files that can be deleted without losing any current 

information. If Select all purgeable files is checked then all the files are 
selected. Otherwise you can select the file(s) to be deleted using standard 
Windows file selection methods. 

Select all purgeable 
files 

If this is checked all files in the above table are selected. 

File>Utilities>Write Sample 
The sample database files (e.g., <sample>_20.ho and <sample>_20.xml) are updated after each step, but 
certain information (e.g., any updates to the current dialog) are kept in memory. You are asked if you 
want to save the sample whenever you exit CrystalClear or start a new sample. You can also save the 
sample information by using the Save Sample icon or through the Write Sample function in the Utilities 
sub menu. 
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The sample information is written in a <sample>_version.ho file and a <sample>_version.xml file. 
Version is the CrystalClear version (e.g., 14, 20, etc). For example if your sample were MyTest, the file 
names would be MyTest_20.ho and MyTest_20.xml. If at some time you upgrade to version 2.1 of CC, 
then the first time you write a new sample it would be MyTest_21.ho and MyTest_21.xml. Since the 
format of these files is dependent on the CrystalClear version, this allows you to revert to an earlier 
version of CrystalClear without losing all the sample information. You will, however, lose any changes 
made in the new version if you revert to a previous version. 

File>Utilities>Write d*TREK Header 
d*TREK keeps a good deal of state information (e.g., the current cell) in header files. These are normally 
updated automatically as needed by CrystalClear, however, you can write the current header information 
into an *.head file with this function. You are provided a full file browser dialog, so this file can be stored 
anywhere. 

File>Utilities>Read d*TREK Header 
It is also possible to read a header file and update the state information from its contents. This is primarily 
used for diagnosing problems and is only recommended if you know a lot about both d*TREK headers 
and CrystalClear. 

File>Utilities>Write PROCESS Resource 
Fine Slice PROCESS (FS_PROCESS) keeps its state information in a file called resource.dat. Again 
CrystalClear normally creates, updates, and reads this file as needed, but you can store the file explicitly 
using this function. 

File>Utilities>Read PROCESS Resource 
Reading an external resource.dat updates the state information and is recommended only if you are in 
expert in FS_PROCESS and CrystalClear. 

File>Utilities>Change Image Directory 
The sample keeps an absolute link to the directory where the images are stored. This is by default 
./Images, but can be anywhere else. If you need to move the images for some reason, you can either create 
an entirely new sample (usually the best option) or change the image directory in the sample that 
references these images. Changing the image directory removes all the state information, so you have to 
reprocess (Find, Index, Refine, etc) the sample once you have made the change. 

File>Utilities>Prepare Bug Report 
This function gathers up the log files that are needed for diagnosing a bug so that you can email it to your 
Rigaku support person. Many organizations prevent you sending emails outside the firewall with an smpt 
based email server like the RMailer server that CrystalClear uses, so you may have email this information 
to yourself and then forward it to Rigaku from your account. 

File>Utilities>Write CIF 
The flow bars for small molecule processing automatically write CIF files, but it may be useful to write it 
explicitly at some other stage. CrystalClear first checks to see that it has all the information it needs to 
write the CIF file. 
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File>Utilities>Determine Structure 
This is a small molecule feature only. It starts up CrystalStructure and passes it information from the 
current sample. It is the equivalent of the Solve button in the small molecule flow bars. Once 
CrystalStructure has been started, you should switch to that interface to continue your processing. 

File>Utilities>Move User Data Directory 
This is documented in Chapter 2 under User Administration. 

File>Utilities>Prepare Structure Determination Area 
For small molecule work, the flow bars normally create a .\Structure directory where the CIF and other 
necessary files are stored. The same files are created in this Structure directory regardless of the 
processing suite used to process the data. This function allows you to create the Structure directory and 
copy the files into it manual. This is not normally needed, but could be useful at times. 

File>Info 
This creates a table which shows the current sample name and the directories where information is kept. 

 

FilePrint 
This prints the current image from the Image Display.  

Edit Menu 

Edit>Header/Database Editor 
This function creates a new input.head based on values extracted from the images and from the existing 
input.head. It is normally used to fix problems found in the image headers or other processing problems. 
It does not update the images themselves, but by updating these values in input.head it can override the 
values in the image headers and thus correct a problem that would prevent processing the data. This is 
only used in d*TREK mode and is intended for expert users. 
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Header Editor Dialog 

 
 

Parameter Description 
Scan The first image from the scan is used to populate the fields of the header that 

come from the images. 
Header Table A d*TREK header is made up of Keyword Value pairs. Some of these 

describe the instrument, the data collection conditions, and other properties of 
the image itself. But this header is also used to pass state information from one 
process to the next within d*TREK. For example the CRYSTAL_UNIT_CELL 
might be added by Index Spots (dtIndex) and used by Refine Cell (dtrefine). 
You can double click a value to edit it. You cannot edit Keywords, but you can 
Add a new Keyword and then give it a Value. Extreme care should be taken in 
editing headers and you should only attempt it if you an expert in both d*TREK 
and CrystalClear. 

Add Add a new Keyword Value pair. This brings up a simple dialog to allow you to 
enter these text strings. The Keyword should be in all capitals with connecting 
underscores. The value can be any space separated string. 
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Parameter Description 
Save This writes the current file to input.head. 
Close If changes have not been saved, you are reminded to do this before you close. 

File>Edit Dongle ID 
CrystalClear is currently licensed through a dongle. You normally enter the dongle ID the first time you 
run CrystalClear after it has been installed. But if you change dongles, or need to convert a demo version 
to a licensed version, you can use this function to enter the new dongle number. 

Enter Dongle ID Dialog 

 
 

Parameter Description 
Enter dongle ID The dongle ID is usually printed on the dongle or in documentation sent to you 

with the dongle. 

 

Sample Menu 
Most of the items in the sample menu have been dealt with elsewhere since they appear in the flow bars. 
However, there are two commands for searching small molecule databases that have not been covered. 

Sample>Search NIST Database 
This function displays the NIST dialog, which allows you to search the database. This is sensitive only 
when the database is available (i.e. mounted in the CD ROM drive.)  The NIST environment variable 
must also be set to the directory in which the database files are contained. You must also have the 
nbsreduc.exe which is distributed with CrystalClear, but is not useful without the database itself. 

NIST Database Search Dialog 
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Parameter Description 
Crystal component For d*TREK and FS_PROCESS, this is always 1, but for TwinSolve may be 

something else. 
{Cell Parameters} The current cell parameters are taken from the sample. You can modify them if 

you need to. 
Lattice This defaults to the current lattice from the sample, but other selections are 

possible. 
Search tolerance This is how close to the cell in the database you need to get before a match is 

declared. It is a fraction of 1.0 and should normally be close to 1.0. The default 
is 0.98. 

OK When you click OK this starts up nbsreduce.exe and performs the search, but 
only if you have the NIST database properly installed. 

Sample>Search Cambridge Structural Database  
This function brings up a dialog to allow you to enter parameters for a search of the Cambridge Structural 
database. The sample must have at least been indexed before you can run this command. 
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Search Cambridge Structural Database Dialog 

 
 

Parameter Description 
Tolerance This is the percentage that you are allowed to deviate from the cell parameters 

and still be considered a match. It is relative to the longest cell dimension. 
Unit Cell This is automatically filled in from the current cell parameters, but you can 

modify these values if you need to. 
Crystal system This is the current Crystal system for this sample. You can select a different 

crystal system to search for. 
Lattice The current Lattice which can also be changed. 
Search. When you click search, CrystalClear starts up an application from the 

Cambridge Crystallographic Structural Database group called ConQuest. 
Conquest must be installed on your computer. The ConQuest is not included in 
CrystalClear and must be obtained from the CCSD group.  

Instrument Menu 
The more common functions in this menu have icons in the main toolbar and have been described in 
chapter 4. The remaining functions are used less often and accessible only through the Instrument menu.  

Instrument>Evaluate Exposure Time 
This feature is still under development and should not be used at this time. 

Instrument>Compute Axial Photograph 
Once the cell constants for a crystal are known, the Compute Axial Photograph menu function should 
be used to collect an axial photograph to (1) confirm lattice spacing and cell centering, (2) help determine 
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the Laue group and (3) provide visual indication of crystal quality. A typical axial photo is shown 
below. 
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Compute Axial Photograph Dialog 

 
 

Parameter Description 
Scan table This is a standard scan table to allow you to select the images that you want to 

use for generating the axial photograph. 
Rotation axis The photograph is computed to view down the Rotation axis that you choose. (a 

,b, or c in reciprocal space) 
Standard deviation 
above background 

Reflections with a lower I/Sigma are not shown in the axial photograph. 

Use hkl zone 
restriction 

If you check this box, you can select a specific Zone and Zone width (in hkl 
space) for selecting reflections. 

Goniometer rotation 
range 

You can limit the rotation range so that only reflections within the specified 
range are included. The range is in degrees and refers to the scan axis for the 
scans (e.g., omega). 

Resolution You can limit the resolution of the reflections to be included. 
Compute This generates the image which is stored in the sample directory (not the image 

directory) as dtaxial_x.img where x is the rotation axis. This computation can 
take a while for a full data set. 
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Analyzing the Axial Photograph 

Lattice spacing 
Confirmation of lattice spacing is especially helpful when perhaps one "satellite" reflection has caused the 
doubling of an axis, or when a weak super-lattice exists.  
 
Confirmation of cell centering also may be useful in some cases. For example, a C-centered cell could be 
confirmed with a photo of [110], which (due to the equivalent point in the face center) would indicate a 
spacing equal to half of the length of the face diagonal. 
 
Calculation 
    d = (nλ)/{sin(tan-1[Y/R])} 
 
where d is the lattice spacing, n is the number of the layer line (center line is 0), λ2 is the wavelength, Y is 
the distance from layer line n to layer line zero, and R is the crystal-to-detector distance 

Symmetry: 
An X-ray image contains all of the symmetry elements that the incoming X-ray beam has traversed. So, if 
there is a mirror plane perpendicular to the axis being photographed, the photo contains mirror symmetry. 
This can be used to verify the Laue group, which is especially useful for tetragonal, trigonal, hexagonal 
and cubic groups (for which there are two possible Laue symmetries). 
 
Systems which, by accident, appear to have higher symmetry (monoclinic with beta = 90°, orthorhombic 
with a=b, etc.) are easily detected by this method. 
 
Furthermore, observation of "impossible" combinations of mirrors -- e.g., monoclinic or orthorhombic 
with two mirrors -- probably indicates a twin. 
 
NOTE:  Axial Photographs only indicate symmetry elements that the beam has traveled along --- so you 

see the mirror if the beam goes along a mirror. If the axis being photographed is, say, a four-
fold axis, you don't see four-fold symmetry in the photo because the x-ray is traveling 
perpendicular to, rather than along, the axis. 

Crystal quality 
This is always useful for determining whether to remove a crystal on the grounds of "bad crystal quality."  
When crystallographers used diffractometers with point detectors, the observation of splitting and 
elongation of spots was useful for guiding the operator in the choice of scan parameters or special 
geometry. Today, in the age of two-dimensional detectors, this sort of visual indicator gives the user an 
idea of whether to expect some problem from the mosaic-determining routine and/or the integration of the 
data. And yes, it might lead one to get rid of a crystal on the grounds of poor quality. 

RAXVideo Version 
RAXVideo is an auxiliary program for displaying a video capture of the crystal. It requires a video 
camera and a supported video capture card. Since not all video capture cards support the same software, 
there are two versions of this program. Your system should normally be setup with the right version, but 
if you are not able to run RAXVideo, you can try another version. The options are: 

• DirectX. This is the most advanced version and should be selected if you hardware supports it. 
Try it first and then if it doesn’t work, revert to Video For Windows. 

• Video For Windows. For some capture cards you need to revert to this version. 
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RAXShape, the auxiliary program for interactively outlining the shape of the crystal, depends on 
RAXVideo. 

Tools Menu 

Tools>Administration 
The Administration tool is mainly used to add and edit users. It is described in Chapter 2. 

Tools>Preferences 
Preferences are used to set display, processing and other user preferences. Each user has their own set of 
preferences which is store in their User Data Directory in a binary file called UserPrefs_20.ho and an xml 
version called UserPrefs_20.xml. These preferences are set by going to the Tools menu and selecting 
Preferences. 

User Preferences General Tab 
 

 
 

Parameter Description 
View You can turn off parts of the standard display if you don’t want to see them. 

This is not recommended. Simply uncheck the view that you do not want to see. 
Default English is the only supported language for CrystalClear at this time. 

 

User Preferences Directories Tab 
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Parameter Description 
Directory Table This is an alternate way for changing the User Data Directory. However, it is 

recommended that you do this through the Administration dialog on the User 
tab. The Script directory is not currently used. 

User Preferences Server Tab 
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Parameter Description 
Run as simulator If this box is checked CrystalClear runs an xxx_Simulator version of the 

instrument servers. This is mainly used for testing, but can also be useful if you 
are running CrystalClear off line on a computer intended primarily for 
processing data.  

XXX-simulator base 
filename 

For each class of instruments you can specify a base filename to be used if you 
do a simulated data collection. This is only really useful for testing 
CrystalClear. 

Allow connection to 
JXG Server 

At some sites the X-Ray generator is controlled by a program called JXG which 
acts as a server to CrystalClear. If you have the hardware and software setup to 
run JXG, you should check this box. You may also check Automatically 
connect to JXG on CrystalClear startup if you want to do this. 
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User Preferences Miscellaneous Tab 

 
 

Parameter Description 
Resolution Limits Some small molecule crystallographers prefer to work in Degrees. Protein 

crystallographers tend to work in Angstroms.  
Exposure time units If you have an R-AXIS instrument with a low power X-Ray generator you may 

prefer to specify exposure time in Minutes. 
Display Orientation The recommended practice is to take the display orientation from the image 

header, but you prefer you can specify an explicit orientation by selecting it in 
this drop down list. 

Start RAXShape 
automatically when 
mounting crytsal 

If you have RAXVideo and RAXShape installed you can have RAXShape start 
up automatically when you mount the crystal so that you can interactively 
outline the crystal shape. This allows you to do numerical absorption correction 
later in the process. 

Numerical Absorption 
Correction flow bar 
step 

If nothing is checked, this step never appears in the flow bar. If Include step 
according to instrument default is checked, then the decision is made based 
on whether your instrument type is most often used for small molecule or 
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Parameter Description 
macromolecule work. 

Log File Viewer font You can select the character font for the log files. Columns line up better if you 
choose a fixed spacing font. But care must be taken if you are not using an 
English version of Windows. The same fonts may not be fixed spacing in 
another language version of Windows. 

Image Viewer font This is more a matter of personal preferences. 
Enable 2 theta and 
crystal-to-detector… 

The Rapid normally has a fixed 2 theta and crystal-to-detector distance setting. 
Checking this allows you to enter your own values. 

Initialize the file open 
dialog… 

If you want the file open dialog to remember the last path each time it opens, 
check this box. 

Auto mode default 
settings. 

These settings only apply in Small molecule Auto mode. 
• Stop after screening to display cell information. Check this if 

you want to review the cell information or the screen images 
before you go on to data collection 

• Stop after Scale and Average to display information. This stops 
before an attempt is made to solve the structure so that you can 
look at the results of integration. 

• Display AutoSolve dialog in CrystalStructure. In CrystalClear 2.0 
the Solve step starts up CrystalStructure and passes it information 
about the sample. If you do not check this box, CrystalStructure 
immediate runs AutoSolve on the sample. However, there are 
some options for AutoSolve, so if you would like to set them in 
the AutoSolve dialog you should check this box. 
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User Preferences Miscellaneous Tab 

 
 

Parameter Description 
Show distance/2-theta 
check dialog before 
starting collection 

This activates a reminder dialog that is brought up before each data collection to 
remind you to make sure that the distance and 2 theta specified do not cause a 
collision. CrystalClear does its own collision check that is normally very 
reliable, but for a new installation this might be wise.  

Include screen scans in 
collect dialog… 

This is mostly for informational purposes. The screens scans are marked as 
already collected, so you would not normally recollect them. However, they can 
remind you what the collection parameters were for screening. 

After changing image 
width 

The scan angle range, image width, and number of images are all inter-
dependent. When you change the image width, you could either Adjust the end 
angle or Adjust the number of images to keep them consistent. 

Force image step equal 
to image width 

If you never want to use a different step (angular distance between images) and 
image width, then you should check this. This automatically updates image step 
when you update image width. But you can always go back in an override with 
a different step size. 



11.  Tools 
 

 

12-18 CrystalClear User Manual 

Parameter Description 
Show image step/width 
inequality warning 
dialog 

The goal of this option is to prevent you from accidentally creating a scan with 
a different image step and width by warning you whenever they are different. It 
applies only to the Collect dialog and not the Initial Images. 

Dezinger exposure 
time 

The two options here are to use the specified Dezinger exposure time (only 
available for certain instruments) as  

• Use as time per image 
• User as total exposure time 

User Preferences Miscellaneous Tab 

 
 

Parameter Description 
HTML log file In order to support viewing CrystalClear status through a web browser, you may 

specify a path for the HTML version of the log file. This allows you to store and 
update this file in a location accessible to your web server, but requires that 
your IT group has configured a web server to link to this location.  

 

User Preferences Scale/Average Plots Tab 
Scale and Average generates a lot of statistics that you should examine to determine the quality of the 
data. You can look at the tables in the log files or use JDTPlot to show various graphs with this 
information displayed in a convenient form. 
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Parameter Description 
Plot package The CrystalClear plotting package option is no longer fully supported in version 

2.0. So we recommend you select either JDTPlot or None.  
Prompt before 
displaying plots 

If you don’t always want CrystalClear to start up JDTPlot (which is a separate 
program) check this box and a prompt is displayed before displaying the plot. 

Graphs to display This only applied to CrystalClear plots so is not longer relevant. 

 

User Preferences Email Tab 
CrystalClear uses an email server called RMailer to send emails at various times. This can be useful. For 
example if you start a data collection before you leave the lab on Friday night and there is a problem with 
the X-Ray generator at 8:00 PM that night, you might want to go in an fix it so you don’t lose the whole 
weekend to data collection. Using this tab you can configure RMailer to send you an email when some 
event happens that you want to know about. 

 
 

Parameter Description 
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Parameter Description 
Enable e-mail 
notifications 

In order to activate emails you should check this box. But you should also make 
sure that RMailer is installed and working. This is part of a Utilities package 
that contains RMailer and JXG which must be downloaded and installed 
separately from CrystalClear. It also requires that your control PC has network 
access to an email server.  

Outgoing mail server See your IT department to get access to an email smtp server that can be used to 
send emails from a program. 

Reply-to Address Some systems require a real user here and for others you can just use a fake 
address that tells you that it came from your instrument. 

Alarms and other 
hardware failures 

If you check this box, an email is sent to the addressed in the E-mail list 
whenever there is an alarm such as an X-Ray generator failure. 

Normal completion of 
collection/processing 
tasks 

This sends an email with a data collection step has finished. Many smtp servers 
are restricted so that they cannot send an email outside the firewall. So you may 
be able to use your email from the organization that owns the instrument, but 
not your private email account in this E-mail list. 

Software bug 
reporting 

If you have this checked when you select Files>Untilities>Prepare bug 
report, the report is automatically emailed to the E-mail list.  
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13. FAQs 

This chapter has a list of Frequently Asked Questions (FAQs) and short answers. These answers often 
refer you to other chapters in this manual. 

Installation and Administration 
Why don't I see a full CrystalClear window at startup?  
CrystalClear was probably closed while it was minimized. After logging into CrystalClear and selecting 
the project / sample, right-click CrystalClear on the task bar and select Maximize. Close CrystalClear 
while it is maximized. Open CrystalClear and log in. You should be able to size the CrystalClear window.  
 
Why does CrystalClear take a long time to respond, then an error message occurs saying that it cannot get 
a response from the R-AXIS? 
If you are not actually connected to an X-ray detector, you should make sure CrystalClear is set in 
Simulator mode. Click Tools > Preferences, then click the Server tab. Check the detector in the list to 
force CrystalClear to run in Simulator mode. If you are connected to a real instrument make sure it is 
powered up before you boot the Control PC on which CrystalClear is running. 
 
Why does CrystalClear "hang" when it tries to communicate with the CCD Camera? 
If the MSCServDetCCD.exe program starts up but cannot connect to the Camera Server 
(MSCServCCDCamera.exe) open CrystalClear.configuration, which is found in the C:\Rigaku\Config 
directory. Change the value of "DaemonIP" to be the IP address of the computer on which the Rigaku 
Daemon is running. Make sure the Daemon is actually running. The instrument server starts up the 
camera server which is often on another FrameGrabber computer though the Daemon. So if it can’t find 
this Daemon or can’t start the server, it fails. 
 
What should I do if my user list is empty after I installed a newer version of CrystalClear over an older 
version? 
When updating CrystalClear you should almost always do a Repair. If you need to remove CrystalClear 
entirely, you should copy the CrystalClear (not CrystalClear140 etc) directory to a save location so that 
if it is removed when you remove CrystalClear you can replace it after installing the new version. The 
CrystalClear Directory contains the Administration directory which contains the list of users and 
sometimes the Administrator directory. 
 
What does the Crypto-Box Error mean? 
The software key or "dongle" is not recognized or is not properly installed. Remove the dongle. Run  
CBSetup.exe and then install the dongle on a different USB port. If you need to use the same port, you 
may have to go into the Device Manager and remove the device, unplug it, run CBSetup, and then plug it 
back in. 

Crypto-Box Error 8: no dongle found. 

The CrystalClear Crypto-Box dongle was not found. Install the Crypto-Box Dongle and try again.  

Crypto-Box Error 30: Error, the attached Crypto-Box did not come from Rigaku. 
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A Crypto-Box was found but it did not have the Rigaku identifier. Install the Crypto-Box Dongle that 
came with CrystalClear on the PC where CrystalClear is installed and try again. If you continue to have 
problems contact your support person to get a replacement dongle. 

Crypto-Box Error 31: Error, registration key in the registry and registration key in the Crypto-Box do not 
match. 

Normally this is caused when CrystalClear was installed with an incorrect Dongle ID, or the user changed 
the Crypto-Box dongle ID. In this case, reinstall CrystalClear and input the correct license number during 
installation. If you still have demo time left, you can also use Edit|Set Dongle ID. 
 
This error may also occur if a non-CrystalClear Crypto-Box dongle is installed on the PC, but the 
CrystalClear dongle was not. In this case, install the CrystalClear Crypto-Box Dongle and CBSetup 
software which came with CrystalClear on the PC where CrystalClear is installed and try again. 
 
How can I change the font on the Log File Viewer?  The table columns do not align properly in the log 
file? 
This often occurs with CrystalClear installations on Japanese Windows systems. When table columns do 
not align properly, the font setting in the log file view is not a fixed width. Change the font using 
Preferences dialog using the following procedure. On the CrystalClear Menu Bar, click Tools > 
Preferences > Miscellaneous tab > Log file viewer font...button. Select the desired font. NOTE:  We 
recommend Courier New for English versions of Windows, and MS Gothic for Japanese Windows. 
 
When I save the Setup dialog to the Site-Level Defaults, Wavelength, Polarization values and 
Collimation type (among other settings) are not being saved. Why don't these values appear in new 
collection samples? 
To save these in newer versions of CrystalClear click Save to Config in the X-Ray Source tab. This 
updates the configuration file that controls these values. 
 
RAXShape and RAXVideo start everytime I click Mount Crystal. How can I turn off this feature? 
Turn off RAXShape and/or RAXVideo using the Preferences dialog as follows:  On the CrystalClear 
Menu Bar, click Tools > Preferences > Miscellaneous tab > Uncheck Start RAXShape automatically 
when mounting crystal. If RAXVideo doesn't function properly, try clicking Instrument > RAXVideo > 
DirectX. If this doesn't work, then click Instrument > RAXVideo > VideoForWindows version. 
 
How can I add a user? 
Only users with administrative privileges may add new CrystalClear users. On the CrystalClear menu 
bar, click Tools > Administration. The Administration dialog appears Click the Users tab, then click 
Add. Refer to the Chapter 2, User Management for additional information.  
NOTE:  If the Administration option is grayed-out, exit CrystalClear and log on using an account that 
has administrator privileges. 
 

Crystallographic Questions 

RAXVideo doesn't start up. An error message says it is not able to initialize the video capture device. 
If RAXVideo doesn't function properly, click Instrument > RAXVideo  Version> DirectX on the 
CrystalClear menu bar. If this doesn't work, then click Instrument > RAXVideo 
Version>VideoForWindows. 
 

Why does Crystal to Detector Distance show "Per Scan?” 
In this sample there are images with different crystal to detector distances. Look in the Scan State 
Display for information relative to each scan.  
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How can I hide the columns on the Scan State Display which contain information in which I am not 
interested? 
Right-click any column heading in the Scan Table. An All Columns menu appears. Check (select) all the 
columns you wish to display and uncheck those you want to hide. 
 
Why is the TWINSOLVE button now grayed out? 
CrystalClear requires a license file to run the TwinSolve processing software. Contact Rigaku/MSC 
technical support for information about obtaining a license file. Note that TwinSolve is most effective for 
work with small molecules. 
 
If I aborted a collection before it was complete, should I modify the Collect Images dialog to resume 
collection? 
CrystalClear tracks the progress of data collection and can normally be restarted and it just finishes the 
collection. To resume the collection, access the Collect Images dialog and click the "Run" button. You 
can visually confirm the collection by looking in the "Scheduled" column which displays the images 
scheduled for collection.  
 
How do I take axial photos? 
Select Instrument>Axial Photo on the menu bar. The Axial Photo dialog appears. This is documented 
in Chapter 12 
 
How do I perform Cell Transformation? 
Access the Cell Transformation dialog by clicking Processing > Cell Tools > Transformation on the 
CrystalClear Menu Bar. The Cell Transformation dialog appears. This dialog varies depending on the 
processing suite (d*TREK, FS_PROCESS, or TwinSolve). The version for each processing suite is 
described in the suite’s chapter. 
 
How can I do a Cell Reduction? 
Access the Cell Reduction dialog by clicking Processing > Cell Tools > Reduction on the CrystalClear 
Menu Bar. This operation is defined for d*TREK in Chapter 8 and FS_PROCESS in Chapter 9. It is not 
available for TwinSolve. 
 
Why doesn't the Flow Bar include the processing options I want? 
You may have selected a Collection task. All the other options in the Tasks drop down list include 
processing steps. 
 
Why have my dialog settings reverted back to the system defaults, instead of to settings I specified in a 
previous session? 
Your settings are saved during a session, but are not saved between sessions unless you click the Save 
button on the dialog. Read about Defaults in Chapter 3. 
 
Why can't I select a processing suite? (i.e. d*TREK , TwinSolve or FS_PROCESS.) 
You must have a sample open before you can select a processing suite. Click File > Open Sample from 
the menu to select a sample, or File > New Sample to create a new sample. You must specify the 
processing suite when you open this sample. Note that the processing suite is associated with the sample, 
so you are not automatically in that processing suite if you open an old sample that had a different 
processing suite. 
 
Why does the Crystal-to-Detector Distance show "0" when I start a Sample as a Process task? 
You may have collected the data without setting the Crystal-to-Detector Distance in the software for 
addition into the header or be using images from a 3rd party detector that do not carry this information.  
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• If you know the Crystal-to-Detector Distance, go the the Setup dialog, edit the Crystal-to-
Detector Distance; then continue.  

• If you do not know the true Crystal-to-Detector Distance, try the following:  

o In an image display window, turn on the arcs tool and play with the crystal to detector 
distance in the image information area. The arcs change size and shape relative to this 
(and the 2-theta angle). See if you can line up a ring (ice, salt, etc.). Then take these 
numbers to the Setup dialog and edit the fields.  

o Set a best guess in the crystal to detector distance field in Setup and try to index. The 
closer you are to the crystal-to-detector distance (or any geometric parameter), the lower 
the residual of the correct lattice. This may be quite a bit of work. If no solutions appear 
after many attempts, Find Peaks off two (or more) images in the same scan separated by 
nearly 90 degrees and use difference vectors in indexing.  

o If the lattice is uncertain, but the detector parameters are remembered vaguely, try 
indexing and using the triclinic cell for refinement then re-index to see if the higher 
symmetry cell is determined.  

How do I change the Resolution ranges for all steps in processing? 
Anywhere there are Resolution Limits fields and a "Set" box, select the box and choose the processing 

steps to use the resolution limits currently in the edit fields and press "OK". You can also click the  
icon in the main toolbar or Sample>Set Resolution… 
 
How can I get Cell Lengths? (I have no idea what the Cell Lengths may be.)  
In an image display window zoom in on an area where spots are regularly spaced. Turn on the measure 
tool by selecting the ruler icon. Left-click one spot and drag to an adjacent spot. The inter-spot distance is 
displayed as you drag.  
 
Why doesn't the red plus sign appear in the Beam Stop shadow? 
You are collecting images with an improper direct beam position and should contact your administrator to 
redo direct beam shots  
 
Why did I get a "Find Spots Failed" message and the log file shows "...reading image lys0001.osc... Error 
opening file lys0001.osc Error is: -2"? 
The image is not there or is corrupted. You may have to wait for the image read to finish, especially if 
you are running on an R-AXIS. 
 

• Decrease the I/sigma 
How can I increase the number of reflections found in Find Spots? 

• Widen the resolution range 
• Decrease the minimum pixel value 
• Decrease the peak filter 
• Increase the number of images used 
• Use the Add Spots button to manually pick spots 

 

• Slide the number of spots slide in the image information window to the left.  
How can I decrease the number of reflections found in Find Spots? 

• Use the delete spots icon to delete spots.  
• Set the I/sigma higher in Find Spots dialog. 
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• Increase Min Pixel Value. 
• Increase the Peak Filter.  

 
After running Predict Spots, why don't I see predictions on my second screening image? 
Prediction cannot be run on non-contiguous images. If you wish to predict on a second screening image, 
run Predict Spots again on the second image.  
 
How can I increase my spot-spot separation? 
Move the detector back so the crystal-to-detector distance increases.  
 

• Ensure that the crystal to detector distance, X and Y beam positions, wavelength, and 2-theta 
angle are correct. If these values are wrong, the Measure Tool values are wrong too. 

How can I get the correct indexing based on the Measure Tool distances? 

• Indexing may be correct if there is additional symmetry. Continue to Predict Spots for 
verification.  

• If the peak shapes are poor, then try raising the I/sigma level to avoid the weaker peaks.  
• If the cells are all much too large, including the triclinic, set the maximum cell in the indexing to 

a smaller value (about 2x that of the closest spot separation for starters).  
 
How can I see all the crystal lattices in the table of indexed lattices? 
Set the maximum residual in the advanced tab of index to 100.  
 
How can I choose the correct lattice in indexing?   
In the Index Spots dialog, select the "User Chooses Solution" option. Upon completion, choose the lattice 
from the list. If all the lattices are not displayed, increase the maximum residual.  
 
How can I increase the reflections included during Refine Spots? 
Adjust the resolution limits, I/sigma, and rejection limits.  
 
Why is "test mosaicity" grayed out? 
A range of images must be used for this refinement. You are using "Refine on" "Reflection List."   Set 
"Refine on" to "Images," then select images in the "To Use" field.  
 
Why is there is no reflection file list in the Refine dialog? 
You are using "Refine on" "Images."  Set "Refine on" to "Reflection List"  
 
Why are all of the option boxes greyed out in the Refine dialog? 
Select "Single Step Refine" under Macro to toggle on/off individual parameters, instead of using the 
preset macro. 
 
Why are there more/less spots than prediction circles on my predicted image? 
In the Predict Spots dialog increase/decrease the mosaicity and predict again. Or, you may have the 
wrong cell and need to re-index.  
 
If the predictions are terribly wrong, how can I start from scratch with the images? 
Open the Processing State Display, go to the State History, click the down arrow, scroll to the bottom, 
select one of the earlier states (like "1. Setup" or "2. Find Run") and "Set as current". Alternately you can 
just go back to Find Spots and reprocess the sample. 
 
Why does refinement seem to stop during integration? 
Try increasing the number of images per batch.  
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How can I integrate without refining mosaicity? 
Set Fix mosaicity and enter a value in the Advanced tab of Integrate Reflections. 
 
How can I get rid of ice rings during integration? 
Go to Integrate Reflections Advanced tab and Add/Delete rings to the list (avoided area in integration).  
 
How can I keep integration from stopping when it finishes all the images on disk so it waits for the 
images yet to be collected to appear? 
Adjust the wait limit in the Integrate Reflections Advanced tab. If an image is not on disk when 
integration gets to that image, it queries the disk every 15 seconds until it finds the image (integrates and 
looks for the next image) or reaches the end of the wait limit (completes integration with the reflections it 
has to that point).  
 
What should I do if Laue shows that I integrated the data in the wrong crystal system? 
Here you need to think about what it is showing you. In general, if the symmetry using the lower 
symmetry unit cell during integration is higher than merited by Laue, then you should consider 
reintegrating. If the symmetry is higher than that for integration, it is recommended that you reintegrate, 
but you may still have good data which is usable for a first reflection file.  
 
How can I get a different format for my reflection file? 
In the CCP4 suite there is a conversion program to convert to mtz format from the d*TREK format.  
 

Trouble Shooting 

Where do I look in order to use the d*TREK interactive mode? 
From the CrystalClear menu bar, click Processing >d*TREK Interactive. Then click the DOS box in the 
task bar and enter your d*TREK command (or any DOS command.) 

How can I troubleshoot problems which occur during processing? 
CrystalClear creates log files that help you see what settings were used during processing. The results of 
the log files can help in troubleshooting problems. To track the progress of an operation, you may view a 
log file during the execution of an operation. You may also view a log file as a text file following the 
operation. 
 
How can I view log files? 
To view a log file during a processing step, click Windows > View Log File on the CrystalClear menu 
bar. The selected log file is displayed on the screen as the operation is processed.  
To view a log file or another file in text mode, use the Tool Bar menu and click the View Log File 

button. The Open Text File dialog appears. Select the file to view. Click Open. 
Alternatively, click File > Open Log File on the CrystalClear menu bar. 
 
What is the name of the log file? 
The name for a specific log file is based on two things:  1) the processing suite selected, and 2) the 
operation being processed. For d*TREK, they tend to correspond to step names. Find Spots writes 
dtfind.log, Index Spots writes dtindex.log etc. 
 
How can I print a log file? 

On the CrystalClear Menubar, click File > Open Log File. The Open Text File dialog appears, allowing 
access to all available log files. Select a log file, click Open. If you wish to print this Log File, select 
Print once the Log File is Open in the Log File Viewer. 
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